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1Welcome to 
Elektroson GEAR

This chapter welcomes you to Elektroson’s GEAR ™ and introduces important 
concepts that will help you understand CD recordable and its application for data 
storage, premaster testing, archiving, and so on. In this chapter, you can read about 
the following:

o CD formats

o CD concepts

o How to use this manual

If you’re already familiar with CD recordable and its concepts, skip to chapter 2, 
Installing GEAR, to get started.

What is a CD?

A CD (compact disc) is a non-magnetic, polished metal disc with a protective plas-
tic coating. This disc is used to store digital information which can be read by an 
optical scanning device that uses a high-intensity light source—a laser—and mir-
rors.

CD-R (CD recordable) is an outgrowth of CD-ROM technology. A CD-recordable 
drive can write one disc or hundreds of discs for a very low cost. You can even use 
CD-Rs to create a premaster that can be used for the traditional pressing of high-
volume runs of CDs.
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What is GEAR?

Elektroson’s GEAR is a premastering/mastering software package that supports all 
phases of compact disc authoring and production. GEAR lets you do the following:

o Format data files into a CD-ROM image that conforms to the ISO-9660 standard. 
Versions are also available for SGI, Apple Macintosh, Sun, DEC, HP, OS/2 and 
other platforms.

o Write a compact disc on any of the available CD recorders, including Sony, Philips, 
Kodak, Pioneer, RICOH, JVC, Yamaha, Pinnacle, Smart and Friendly, Playwrite, 
and virtually all OEM recorder versions. The CD-R discs you produce with GEAR 
are fully compatible with normally mastered CDs. Additional supported models 
are listed in the GEAR ReadMe file. Double-click the ReadMe icon in the GEAR 
program group for information.

o Create a master tape in DDP format on 8mm Exabyte, 9 track tape, or 4mm DAT 
for CD reproduction.

GEAR supports the following formatting engines:

o CD-ROM, ISO-9660

o CD-ROM Mixed Mode

o CD-ROM XA

o CD Plus (Blue Book)

o Mac hybrid

o ISO-9660 with Rockridge extension

o Multi-session

o CD Digital Audio

o MMCD

o HFS (Hierarchical File System)

If you choose CD-ROM or any of its derived products as the distribution and storage 
medium for your information, you need GEAR to produce it. GEAR bridges the gap 
between your application on hard disk and your application on CD-ROM.

In addition, GEAR supports recording the following authored file formats:

o CD-I (Compact Disc Interactive)

o CDTV

o EB (XA)

o Photo CD
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o Proprietary video game authoring (3DO, Nintendo, Sega, CD Karaoke, and other 
game titles)

o VideoCD

o Compressed and encrypted file formats

o Custom-generated images

What You Should Know About CDs

Before you begin production, you should understand the following CD and CD-R con-
cepts. In this section, you’ll read about:

o Single-session discs

o Multi-session discs

o Multi-volume discs

o CD-R tracks

o Incremental write functionality

o CD recorders

Single-Session

A session is a recorded segment of a compact disc that contains one or more tracks (data 
or audio) surrounded by a lead-in and lead-out. When you record a session, information 
about the recorded data is stored within the table of contents. The recorded disc will 
have the lead-in, the track contents, and the lead-out.

Single-session refers to discs that contain data written during one session. Once you fix-
ate a single-session disc, you can add no more data to the disc. The following illustrates 
a single session CD.

Multi-Session 

Multi-session refers to discs on which data is recorded in several different sessions and 
can be done the same or different recorders. You can add, update, or delete files on a 
recordable CD. Each session can contain information according to one of the CD stan-
dards—ISO, XA, DA, for example. You can link data in different sessions, for example, 
data in a newer session can refer to data in previously-recorded sessions. When you read 

Lead
in

Track
1

Track
2

… Track 
N-1

Track 
N

Lead
out
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a multi-session disc using a multi-session capable CD-ROM drive and multi-session 
driver, all data is seen as a whole, regardless of the number of sessions in which it was 
recorded. Each session introduces a data overhead—lead in and lead out—of about 
15MB. This limits the number of sessions on a 650MB disc to about 40. The following 
illustrates a multi-session CD. 

Multi-session is good for activities like document archiving and updating catalogs of 
information on a regular basis.

In most cases, only a multi-session CD-ROM drive can play an audio track on a multi-
session disc. You need a multi-session CD-ROM drive to play audio tracks recorded in 
the second and following sessions. Each session always contains at least one track. A 
true multi-session CD-ROM reader automatically goes to the last session and presents 
all linked sessions as one. You are never aware of the number of sessions on the disc

GEAR fully supports the creation of multi-session discs. If you want to append a session 
to a CD-R disc, GEAR reads back the last session and creates a virtual image of it. This 
image is then used like any other image to add, delete, and update information. If you 
delete information from a session, the reference to the data is deleted, however, the 
actual data remains on the session. When you write the new session to a disc, only the 
changes are written.

Multi-Volume Discs

Multi-volume discs use the same principal as multi-session discs with one exception. 
When you write a multi-volume disc, each session or volume on the disc is independent 
and has no reference to other volumes on the disc. You can read each volume as a sep-
arate CD. In order to read a multi-volume disc, you need a device driver that allows you 
to select a volume on the CD-R as a separate drive letter or partition. 

GEAR fully supports the creation of multi-volume discs. If you want to add a volume to 
a disc, you can create the volume as you do any other volume. When the image is ready, 
you put the CD-R disc you want to add the volume to in the recorder and write the new 
volume.
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CD-R Tracks

A track is a section of the disc that contains data. A CD-R can contain up to 99 tracks, 
regardless of the number of sessions or the type of tracks on the disc. GEAR lets you cre-
ate up to 99 tracks on a CD.

The following table shows the possible track structures for a session or virtual image:

You can use structures 1 and 2 for each session of a multi-volume or multi-session disc. 
However, the maximum number of tracks for the session is 99. Another structure, called 
CD Enhanced or CD Plus, enables the combination of audio-track and multi-session. 
This type of CD-R has multiple audio tracks in the first session and uses the second ses-
sion for data. This means that an audio player sees only the first session (that is, audio 
tracks), whereas a multi-session player sees both the DA tracks and data track.

Incremental Write 

Incremental write, as described in the Orange Book, is the ability to write in packets to 
a CD-R disc. Each packet contains a small amount of data and is linked to the previous 
packet. A link consists of seven link blocks. You can use incremental write in a variety 
of ways: you can use a fixed or variable packet size and you can incrementally write 
with or without ISO-9660 compatibility.

Following are two requirements for incremental writing:

o The CD recorder and software must support incremental write. For 
information, refer to your CD recorder documentation. While most 
CD recorders do not support incremental write, GEAR does.

o The ISO-9660 file system standard has to be extended because it 
doesn’t support incremental write. A new European standard, ECMA 
168, is an extension of the ISO-9660 standard and describes the neces-
sary enhancements required for the support of incremental write. 
Support for the new ECMA 168 standard will be available in future 
releases of GEAR.

Number of Tracks

Structure ISO XA DA

 1 1 0 Up to 98

 2 0 1 Up to 98

 3 0 0 From 1 to 99
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The packet size determines the amount of overhead. For a 64KB packet size, the over-
head is about 15%. A special driver is required to read incrementally-written discs. Cur-
rently, most CD-ROM readers on the market can’t read an incrementally-written disc.

CD Recorders

A CD recorder is a piece of computer equipment you use to write data to a CD disc. 
When a recorder is writing data to a disc, it can’t wait for the data like a tape unit can, 
for example. The data buffer of the recorder must always contain data.

You can stop data transfer at specific points only. These points are determined by the 
way you write the disc—disc at once, track at once, or incrementally. At these points—
end of disc, end of track, or end of packet—the recorder finalizes the writing of data and 
you can resume writing at a later time.

Warning! If the recorder can’t finalize the disc because it runs out of data unexpectedly, the 
CD-R disc is wasted and can’t be reused. This is referred to as a data underrun. The data 
transfer rate to a CD recorder is very important.

GEAR lets you estimate the transfer rate for your system before you write data. GEAR 
also supports a CD recorder’s test mode. In this mode, all data is transferred but the disc 
isn’t actually written. This lets you check your system performance for writing discs. 
When you start recording CDs, we recommend you use this test option for the first few 
discs. This lets you get to know the software and hardware, and prevents you from wast-
ing CD-R discs.

Disc at Once vs. Track at Once

Currently, there are two types of CD recorders on the market: disc at once and track at 
once.

When you use a track-at-once recorder, the recorder first writes the track data, then 
finalizes the disc by writing a lead in and lead out. Track at once is particularly useful 
for multi-session writing. Only track-at-once recorders can write multi-session discs. 
Some track-at-once recorders can write disc at once and track at once.

Type Brand

Disc at once Sony CDW E1/W1, Sony CDW 900, and Yamaha 
YPR301

Track at once All others

Both Yamaha CD-100, Philips CDD-522, and Sony CDW-
920
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When you use a disc-at-once recorder, the recorder starts by writing the lead in, then the 
track data, then the lead out. Link blocks are not inserted. Disc at once is useful for 
audio-only discs and discs that should be an exact copy of the image.

How to Use This Manual

This manual is separated into four sections: installation instructions, GEAR forWin-
dows and OS/2, GEAR for Mac O/S, and appendixes.

Installation Instructions

Chapter 2, Installing GEAR, explains the required system configuration and the instal-
lation of the GEAR software for the Windows, O/S 2, and Macintosh platform.

GEAR for Windows 95

Chapter 3 includes a tutorial to help you start and learn to use GEAR under Windows 95.

Chapters 4 through 10 include information for creating virtual images, CD-ROM XA, 
and audio CDs, as well as how to work with virtual images, foreign images and how to 
premaster and write CD images.

GEAR for Windows and OS/2

Chapter 11 includes a tutorial to help you start and learn to use GEAR under Windows.

Chapters 12 through 19 include information for creating virtual images, CD-ROM XA, 
and audio CDs, as well as how to work with virtual images, foreign images, log and 
batch files, and how to premaster and write CD images.

GEAR for Mac OS

Chapter 20 includes a tutorial to help you start and learn to use GEAR under Mac OS.

Chapters 21 through 28 include information for creating ISO and CD-ROM XA 
images, audio CDs, and HFS, hybrid, or SCSI CD-ROMs. Information about how to 
work with multi-session discs, virtual and foreign images, and how to premaster and 
write CD images are included, as well.



Elektroson GEAR

8 n Welcome to Elektroson GEAR

Appendixes

Appendix A contains a glossary.

Appendix B describes each of the GEAR formatting commands.

Appendix C contains detailed information about the gear.ini file.

Appendix D is a list of error codes reported by CD recorders.

Appendix E describes information about ISO-9660 file and directory naming.

Appendix F describes how to use GEAR to develop your CD-BRIDGE and Electronic 
Book applications.

Appendix G is a troubleshooting guide for GEAR.

Conventions In This Manual

Special information is denoted as a Note, Tip, or Warning.

Buttons you should click on the toolbar to perform a function appear in the margin next 
to their corresponding text.

New terms you may not be familiar with appear in italics.

Values you should enter as they appear in the manual are in boldface.
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2Installing GEAR

This chapter provides information about installing GEAR for Windows, OS/2, and 
Mac OS. In this chapter, you can read about the following:

o Viewing the online user’s manual (Acrobat Reader)

o System requirements

o Configuring your hardware

o Installing the software for Windows 95

o Installing the software for Windows NT

o Installing the software for Windows 3.1 and Windows for Workgroups

o Installing the software for OS/2

o Installing the software for Mac OS

Viewing the Online User Manual (Acrobat Reader)

In addition to the printed documentation we have provided the complete user man-
ual in several languages on the installation CD. The documentation has been for-
matted under the Adobe Acrobat Portable Document Format (PDF), and includes 
a copy of Adobe Acrobat Reader v2.1 to search, view, retrieve, and print the online 
user manual.
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Installing the Acrobat Reader

Windows 95/NT/3.1

To install Acrobat Reader v2.1 on your hard disk drive:

o From the Windows Program Manager, choose Run from the File menu

o Type: [CD ROM drive]:\acroread.exe. Depending on which version of the GEAR 
Install CD that you have, the acroread.exe may either be located in the root direc-
tory or operating system subdirectory. Please make sure to choose the correct lan-
guage version. 

o Follow the instructions on your screen.

Mac OS

To install Acrobat Reader v2.1 on your hard disk drive: 

o Double click on the file called “AcroRead. mac” and follow the instructions on 
your screen. Depending on which version of the GEAR Install CD that you have, 
the acroread.exe may either be located in the root directory or operating system 
subdirectory. Please make sure to choose the correct language version. 

OS/2

Currently there is no Adobe Acrobat Reader support under OS/2.

Note: If you have problems locating or installing the Adobe Acrobat Reader file please contact 
Elektroson Technical support or reseller. To update or get additional information about the Ac-
robat Reader, please contact Adobe directly. 

System Requirements

The following sections list the system requirements for the following platforms:

o Windows 95/NT

o Windows 3.1 and Windows for Workgroups

o OS/2 

o Mac OS

Windows 95/NT

To run GEAR under Windows 95, you need the following:
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o A 486 IBM-AT or compatible with 8MB of RAM 

o Windows 95 or Windows NT 3.51

o Any WinASPI32- or miniport-compatible SCSI card

o A minimum of 25MB free disk space for image management

o 12ms or less HDD (non-thermal recalibration)

Windows 3.1 and Windows for Workgroups

To run GEAR under Windows 3.1 or Windows for Workgroups, you need the follow-
ing:

o A 486 IBM-AT or compatible with 8MB of RAM 

o 500KB of conventional memory for Windows 3.1 only

o MS-DOS 5.0 or later and Windows 3.1 or Windows for Workgroups

o Any ASPI, WinASPI or CAM compatlble card.

o A minimum of 25MB free disk space for image management

o 12ms or less HDD (non-thermal recalibration)

OS/2 Warp

To run GEAR under OS/2 Warp, you need the following:

o A 486 IBM-AT or compatible with 8MB of RAM 

o OS/2 Warp

o Any SCSI card supported by OS/2 Warp

o A minimum of 25MB free disk space for image management

o 12ms or less HDD (non-thermal recalibration)

Mac OS

To run GEAR, you need the following:

o Macintosh Quadra or better with 8 MB of RAM

o System 7.0 or later 

o A minimum of 25 MB free disk space for image management

o 12ms or less HDD (non-thermal recalibrating)

Important: We recommend a fast hard drive with a fast controller (12 msec average access 
time or less). Use only hard drives that don’t require thermal recalibration. These drives are 
sometimes referred to as AV drives. If thermal recalibration occurs during CD-R writing, the 
data stream stops and the disc is wasted. 
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Configuring Your Hardware and Installing GEAR

This section includes information for configuring the necessary hardware for connect-
ing a CD recorder or tape unit. Separate sections are included for Windows 95, Win-
dows NT, Windows 3.1 and Windows for Workgroups, OS/2 Warp, and Mac OS.

Important: Always read the manufacturer’s instructions before installing hardware. Problems 
you may encounter during the installation of GEAR are usually due to hardware-related instal-
lation problems.

Windows 95

Since Windows 95 is supplied with an integrated SCSI I/O driver, no additional third 
party adapter driver is required in most cases. This version of GEAR supports the 
WinASPI32 device driver.

Note: You can verify the proper installation of your SCSI adapter by choosing Settings from the 
Control Panel. Double-click the system icon. Select the Device Manager. If a host adapter is 
installed, the SCSI Controllers item should be included in the list of available drivers. Click this 
item to display the supported host adapter. Select the device and click the Properties button 
to view the current status of the host adapter.

Connecting Your Recorder

Installing a Non- Plug & Play-Compatible Recorder (Device Type 4, WORM)

Due to incompatibilities with device type 4 CD recorders and Windows 95 SCSI driv-
ers, type 4 recorders currently cannot be mounted as CD readers. However, Windows 
95 will automatically want to associate a driver with the recorder. When you are asked 
which driver to use, you must choose for the CD-R to be an ‘Unsupported’ device. Sev-
eral third party utilities are currently under development. Please call Elektroson or your 
SCSI card manufacturer for updated information.

Note: If you have purchased a type 4 recorder and don’t have a CD-ROM drive to install GEAR, 
you can purchase a 3.5 floppy upgrade pak for Windows 95 and NT for a nominal shipping 
and handling charge. Contact Elektroson Technical Support. For a list of device type 4 record-
ers, see the CD Recorder Compatibility List at the end of this chapter.
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Installing a Plug & Play-Compatible Recorder (Device Type 5, CD-ROM)

If your recorder is a device type 5 recorder, Windows 95 installs a CD-ROM driver 
automatically. Windows 95 recognizes device type 5 recorders as CD-ROM drives. 
You should, however, turn off the Auto Insert Notification option to prevent Windows 
95 from trying to access the CD-R while the system is recording. Choose Settings from 
the Control Panel. Double-click the system icon. Select the Device Manager and turn 
off the Auto Insert Notification check box.For a list of device type 5 recorders, see the 
CD Recorder Compatibility List at the end of this chapter.

1. To connect your CD recorder, shut down your system and connect your recorder 
to your SCSI host adapter.

Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are suscep-
tible to signal degradation, which can cause a loss in data integrity or the reporting of strange 
errors.

2. Restart Windows 95 with your recorder turned on.

o If your recorder is a device type 4 recorder, Windows 95 prompts you to 
install a device driver.

Since Windows 95 doesn’t provide drivers to mount type 4 recorders 
as readers, choose Unsupported in the window that appears. (See 
Installing a Non-Plug & Play-Compatible Recorder, above.)

o If your recorder is a device type 5 recorder, Windows 95 installs it automati-
cally and doesn’t prompt you. (Make sure the Auto Insert Notification option 
is disabled. See installing Plug & Play-Compatible Recorder, above.)

Note: To verify whether the installation was successful, reboot your machine and check the 
system properties. If Windows doesn’t find the CD recorder, run a system scan by choosing 
Add Hardware in the Control Panel. Be sure WinASPI32 is installed properly. If the recorder 
is still not recognized, contact Elektroson Technical Support.

Installing GEAR

1. Insert the GEAR CD into your CD drive or recorder.

2. Open the Win95NT folder.

3. Open the English, French, or German folder, depending on the version you want 
to install.

4. Double-click the setup.exe icon.



Elektroson GEAR

14 n Installing GEAR

5. In the GEAR for Windows 95 Setup window, click the OK button.

6. The Setup icon appears. Click it to begin the installation.

7. In the dialogs that appear, indicate whether you want to install premaster tape and 
jukebox support.

8. Continue to follow the dialogs as they prompt you for additional information.

When the installation is complete, a dialog appears to indicate the installation was 
successful.

9. Click OK to exit the installation program.
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We recommend you read the ReadMe file. It welcomes you to Elektroson’s GEAR 
and includes last-minute information that couldn’t be included in the manual.

10. To open the ReadMe file, click the Start menu icon, locate GEAR in the Pro-
grams menu and double-click the ReadMe icon in the GEAR program menu.

Windows NT

Since Windows NT is supplied with an integrated SCSI IO driver, no additional third 
party adapter driver will be required. We successfully tested GEAR with the Adaptec, 
Buslogic, Future Domain, and Bustek adapters. In all cases, we tested the adapter with 
the integrated NT SCSI IO driver.

For information about setting up your hardware, see your hardware documentation.

Connecting Your Recorder

Installing a Non- Plug & Play-Compatible Recorder (Device Type 4, WORM)

Due to incompatibilities with device type 4 CD recorders and Windows NT SCSI driv-
ers, type 4 recorders currently cannot be mounted as CD readers. Several third party 
utilities are currently under development. Please call Elektroson or your SCSI card 
manufacturer for updated information.

Note: If you have purchased a type 4 recorder and don’t have a CD-ROM drive to install GEAR, 
you can purchase a 3.5 floppy upgrade pak for Windows 95 and NT for a nominal shipping 
and handling charge. Contact Elektroson Technical Support. For a list of device type 4 record-
ers, see the CD Recorder Compatibility List at the end of this chapter.

Installing a Plug & Play-Compatible Recorder (Device Type 5, CD-ROM)

If your recorder is a device type 5 recorder, Windows NT installs a CD-ROM driver 
automatically since Windows NT recognizes device type 5 recorders as CD-ROM 
drives. When using a device type 5 recorder to record CD’s with GEAR, you should 
always set the device to Manual mode and reboot the computer after installation. This 
will disable the driver conflicting with GEAR.
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To disable the CD reader driver, please go to the Control Panel and select Devices:

o Change Startup to Disabled (disable SCSI CD ROM driver)

o Reboot your computer

Note: At this time once the CD reader driver is disabled under Windows NT you will no longer 
be able to use or mount any CD ROM drive when using GEAR with your CD recorder. You must 
re-enable the CD ROM driver after the recording process to mount CD’s.

If you use a device type 5 recorder to install GEAR from the installation CD, do not set 
the device to Manual mode until the installation is complete. For a list of device type 5 
recorders, see the CD Recorder Compatibility List at the end of this chapter.

1. To connect your CD recorder, shut down your system and connect your recorder 
to your SCSI host adapter.

Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are suscep-
tible to signal degradation, which can cause a loss in data integrity or the reporting of strange 
errors.

2. Restart Windows NT with your recorder turned on.

o If your recorder is a device type 4 recorder, Windows NT does not install or 
prompt you to install a device driver.(See Installing a Non-Plug & Play-
Compatible Recorder, above.)

o If your recorder is a device type 5 recorder, Windows NT installs it automat-
ically and doesn’t prompt you.(Please make sure to disable the NT driver for 
CD-ROM support when using GEAR to record CD’s. See installing Plug & 
Play-Compatible Recorder, above.)

Note: Be sure to follow the manufacturer’s instructions when you set up the SCSI host adapt-
er. Be sure to terminate both ends of the SCSI chain properly! All units are susceptible to sig-
nal degradation, which can cause a loss in data integrity or the reporting of strange errors.

Installing GEAR

1. Insert the GEAR CD into your CD drive or recorder.

2. Open the Win95NT directory to install GEAR for Windows NT.

3. Open the English, French, or German directory, depending on the version you 
want to install.

4. Double-click the setup.exe file.

The GEAR setup screen appears.



Elektroson GEAR

Installing GEAR n 17

5. Click Continue.

6. Enter your name, company name, and registration number in the dialog that 
appears, then click Continue.

7. As the installation proceeds, you are prompted to enter additional information, 
such as where to install the program, what SCSI adapter to use, and whether to 
install tape or jukebox support.

Warning! If you don’t have a SCSI tape unit connected to your computer, don’t install the tape 
support. You can install this later without reinstalling GEAR.

Select the options you want to use and click Continue in each dialog that appears.

8. When the installation is complete, click OK in the dialog that appears.

The GEAR program group appears on your screen.

We recommend you read the ReadMe file. It welcomes you to Elektroson’s GEAR 
and includes last-minute information that couldn’t be included in the manual.

9. To open the ReadMe file, double-click its icon in the GEAR program group.
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Windows 3.1 and Windows for Workgroups

Under Windows 3.1 only, your config.sys file should contain the following settings:

o Files = 20

o Buffers = 40

o The driver for the SCSI controller should match your SCSI card— for example, 
Device = aspi4dos.sys /d. (Refer to your card installation documentation for addi-
tional information.)

For information about editing your config.sys file, refer to your MS-DOS documenta-
tion.

Connecting Your Recorder

1. To connect your CD recorder, shut down your system and connect your recorder 
to your SCSI host adapter.

o Since Windows 3.1 does not include intergrated SCSI or CD reader drivers, 
device type 4 and device type 5 recorders will require a third party driver for 
reader support. GEAR includes an optional CD Driver Utility disk with CD 
reader drivers that can be installed for most CD recorders, both device type 4 
(WORM) and device type 5 (CD-ROM). 

Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are suscep-
tible to signal degradation, which can cause a loss in data integrity or the reporting of strange 
errors.

2. Restart Windows with your recorder turned on.

Note: If your recorder isn’t seen when you start your computer, you won’t be able to use your 
CD recorder as a CD-ROM drive. Verify that your hardware connections and device driver in-
stallation are correct.

Important: It’s preferable but not necessary to use a separate host adapter board to control 
the CD recorder. If the data transfer rate is too slow, try placing your recorder on a separate 
controller. We also advise you not to use different types of adapters in the same computer.

Installing GEAR

1. Insert the GEAR CD into your CD drive or recorder.

Note: If your recorder isn’t seen when you start your computer, you won’t see the driver for 
the software installation. Check all hardware connections and try to install the optional GEAR 
CD Driver Utility. See appendix H. If you can’t load your CD, contact Technical Support.
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2. Open the Windows directory to install GEAR for Windows 3.1 or Windows for 
Workgroups.

3. Open the English, French, or German directory, depending on the version you 
want to install.

4. Double-click the setup.exe file.

The GEAR setup screen appears.

5. Click Continue.

6. Enter your name, company name, and registration number in the dialog that 
appears, then click Continue.

7. As the installation proceeds, you are prompted to enter additional information, 
such as where to install the program, what SCSI adapter to use, and whether to 
install tape support.

You must enter the registration number that appears 
on the registration label in your package

Enter your name and 
company name
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Warning! If you don’t have a SCSI tape unit connected to your computer, don’t install the tape 
support. You can install this later without reinstalling GEAR.

Select the options you want to use and click Continue in each dialog that appears.

8. When the installation is complete, click OK in the dialog that appears.

The GEAR program group appears on your screen.

We recommend you read the ReadMe file. It welcomes you to Elektroson’s GEAR 
and includes last-minute information that couldn’t be included in the manual.

9. To open the ReadMe file, double-click its icon in the GEAR program group.

Choose a driver for your SCSI controller, then 
click Continue

Double-click this icon to 
read late-breaking news 
about GEAR

Double-click this icon to 
start GEAR
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What is ASPI?

Advanced SCSI Programming Interface (ASPI) is an interface specification developed 
by Adaptec for sending commands to SCSI host adapters. This interface eliminates the 
need for a program such as GEAR to include device-dependent information.

Software drivers can be broken into two components: low-level ASPI manager and the 
ASPI module.

The low-level ASPI manager is OS- and hardware-dependent. It accepts ASPI com-
mands and performs the necessary steps to send the SCSI command to the target.

The ASPI module is tailored to the command set of a particular peripheral, such as a 
CD-ROM. An ASPI-based CD-ROM driver must handle only the differences between 
different CD-ROM drivers, not the host adapter differences.

DOS ASPI Driver Support

If you’re using an ASPI manager as the device interface for multiple controllers and 
your CD-R unit is recognized by ASPI but not by GEAR, you probably have to change 
the AspiHostAdapterNumber in the gear.ini file.

If ASPI is installed for more than one adapter, the ASPI manager numbers each adapter 
starting with 0. The gear.ini file defines which adapter GEAR should use to search for 
the CD-R unit.

Windows ASPI Driver Support

Windows ASPI (WinASPI) is a device driver that provides an easy access method for 
Windows applications requiring SCSI IO. This is provided in a dynamic link library 
called winaspi.dll. When you launch an application that requires a DLL, it’s loaded into 
memory automatically. When it’s not required, it’s released from memory.

In addition to the WinASPI device driver, a virtual device driver (VxD) called 
vaspid.386 handles the locking and unlocking of the data buffers for virtual DMA 
requests during SCSI IO.

The winaspi.dll and vaspid.386 files must be loaded in your Windows directory in order 
to use the WinASPI layer.

CAM SCSI Driver Support

Common Access Method (CAM) is a software-oriented interface designed to simplify 
writing device drivers for SCSI peripherals attached to SCSI host bus adapters. Future/
CAM allows all Future Domain SCSI host but adapters to be accessed in the same man-
ner, allowing a single device driver to be written for all of the host adapters.



Elektroson GEAR

22 n Installing GEAR

OS/2 Warp

The following sections include information about configuring your recorder and 
installing GEAR for OS/2 Warp.

Connecting Your Recorder

Installing a Non-Plug & Play-Compatible Recorder (Device Type 4, WORM)

Due to incompatibilities with device type 4 CD recorders and OS/2 SCSI drivers, type 
4 recorders currently cannot be mounted as CD readers. Several third party utilities are 
currently under development. Please call Elektroson or your SCSI card manufacturer 
for updated information.

Note: If you have purchased a type 4 recorder and don’t have a CD-ROM drive to install GEAR, 
you can purchase a 3.5 floppy upgrade pak for OS/2 for a nominal shipping and handling 
charge. Contact Elektroson Technical Support. For a list of device type 4 recorders, see the 
CD Recorder Compatibility List at the end of this chapter.

Installing a Plug & Play-Compatible Recorder (Device Type 5, CD-ROM)

If your recorder is a device type 5 recorder, OS/2 installs a CD-ROM driver automat-
ically since OS/2 recognizes device type 5 recorders as CD-ROM drives. When using 
a device type 5 recorder to record CD’s with GEAR, you should always disable the OS/
2 CD-ROM device driver from the SCSI ID that the recorder occupies, and reboot the 
computer after installation. This will disable the CD reader driver from conflicting with 
GEAR during the recording process.

To disable the CD reader driver, please edit the OS/2 configuration file as follows:

o REM out the line containg the following driver statement; OS2 CDROM.DMD

o Reboot your computer

Note: At this time once the CD reader driver is disabled under OS/2 you will no longer be able 
to use or mount any CD ROM drive when using GEAR with your CD recorder. You must re-
enable the CD ROM driver after the recording process to mount CD’s.

If you use a device type 5 recorder to install GEAR from the installation CD, do not dis-
able the OS/2 CD-ROM driver from the recorder ID until the installation is complete. 
For a list of device type 5 recorders, see the CD Recorder Compatibility List at the end 
of this chapter.

1. To connect your CD recorder, shut down your system and connect your recorder 
to your SCSI host adapter.
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Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are suscep-
tible to signal degradation, which can cause a loss in data integrity or the reporting of strange 
errors.

2. Restart OS/2 with your recorder turned on.

o If your recorder is a device type 4 recorder, OS/2 does not install or prompt 
you to install a device driver. (See Installing a Non-Plug & Play-Compatible 
Recorder, above.)

o If your recorder is a device type 5 recorder, OS/2 installs it automatically and 
doesn’t prompt you. (Please make sure to disable the OS/2 driver for CD-
ROM support when using GEAR to record CD’s. See installing Plug & Play-
Compatible Recorder, above.)

Note: Be sure to follow the manufacturer’s instructions when you set up the SCSI host adapt-
er. Be sure to terminate both ends of the SCSI chain properly! All units are susceptible to sig-
nal degradation, which can cause a loss in data integrity or the reporting of strange errors.

Installing GEAR

1. Insert the GEAR CD into your CD drive or recorder.

2. Open the OS2 directory to install GEAR for OS/2 Warp.

3. Open the English directory.

4. Double-click the setup.exe file.

The GEAR setup screen appears.

5. Click Continue.

6. Enter your name, company name, and registration number in the dialog that 
appears, then click Continue.
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7. As the installation proceeds, you are prompted to enter additional information, 
such as where to install the program, and whether to install jukebox and tape sup-
port.

Select the options you want to use and click Continue in each dialog that appears.

8. The installation then prompts you to create a workplace shell and to update the 
config.sys file. In each dialog, click Yes or No.
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9. When the installation is complete, click OK in the dialog that appears.

The GEAR program group appears on your screen.

We recommend you read the ReadMe file. It welcomes you to Elektroson’s GEAR 
and includes last-minute information that couldn’t be included in the manual.

10. To open the ReadMe file, double-click it’s icon in the GEAR program group.

Mac OS

The following sections include information about configuring your recorder and 
installing GEAR for Mac OS.

Connecting Your Recorder

1. To connect your CD recorder, shut down your system and connect your recorder 
to your SCSI connector.

o Since Mac OS does not include intergrated CD recorder reader drivers, 
device type 4 and device type 5 recorders will require a third party driver 
for reader support. GEAR includes an optional FWB CD ROM Toolkit with 
CD reader drivers that can be installed for most CD recorders, both device 
type 4 (WORM) and device type 5 (CD-ROM). Please see Appendix I for 
installation and operation of the driver utility. 

Note: Follow the manufacturer’s instructions when you set up your CD recorder. Be sure to 
terminate both ends of the SCSI chain properly! All units are susceptible to signal degradation, 
which can cause a loss in data integrity or the reporting of strange errors.

2. Restart your Mac with your recorder turned on.

Installing GEAR

1. Insert the GEAR CD into your CD drive or recorder.

2. Open the MacOS folder.
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Note: IIf you want to use your CD recorder as a CD-ROM drive, install the optional FWB CD-
ROM ToolKit. See appendix I. If you can’t load your CD, contact Technical Support.

3. Open the English, French, or German folder, depending on the version you want 
to install.

4. Double-click the installer icon.

5. Select standard or custom installation. 

Warning! New users should always select standard to ensure all the required files are in-
stalled.

6. Enter your name, company name and registration number after the installation of 
the files.

The software is now installed and ready for use.

We recommend you read the ReadMe file. It welcomes you to Elektroson’s GEAR 
and includes last-minute information that couldn’t be included in the manual.

CD Recorder Compatibility List

This section includes important information specific to each of the CD recorders GEAR 
supports. See your hardware documentation for specific information about setting up 
your CD recorder.

We recommend you connect the recorder close to the SCSI Controller. The SCSI cable 
should be no longer than 1 meter (or 3 feet), but the shorter the cable, the better.

Be sure to terminate both ends of the SCSI chain properly! All units are susceptible to 
signal degradation, which can cause a loss in data integrity or the reporting of strange 
errors.

It’s not necessary to connect the recorder on the fastest controller. In some cases, the 
faster controllers cause miscompares with the recordable and your original files making 
the CD-R unusable. 
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Device Type 4 CD
Recorder

The following are examples of device type 4 (WORM) recorders:

o JVC XR-W2001

o Kodak PCD200, PCD225, PCD600

o Olympus Deltis 615

o Philips CDD521, CDD522

o Pinnacle Micro RCD 1000

o Pioneer DW-S114, DRM-5004X

o Plasmon RF4100, RF4102

o Ricoh RS1060, RS9200C

o Yamaha CD-R100, CD-R102

Contact your CD recorder manufacturer or Elektroson for an up-to-date list of type 4 
CD recorders.

Device Type 5 CD
Recorders

The following are examples of device type 5 (CD-ROM) recorders:

o Grundig CDR1001

o HP 4324/4325

o Kodak PCD240

o Philips CDD2000

o Sony CDU-920S

Contact your CD recorder manufacturer or Elektroson for an up-to-date list of type 5 
CD recorders.

Detailed CD-Recorder Profiles (Partial List)

HP 4020i o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.08

High Tech CDR2000 o Connector Type: 2x50 pin

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: No

o Firmware (at printing): v1.28
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High Tech CDR1002 o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Caddy

o Recording Speed: 21x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.2

Grundig
CDR100IPW

o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: yes

o Firmware (at printing): v1.20

JVC XR-W1001 o Connector Type: n/a (built-in type)

o Buffer Size: 64 KB

o Disc Loading: Caddy

o Recording Speed: 1x

o Read CDDA through SCSI: No

o Firmware (at printing): v1.24

JVC XR-W2001 o Connector Type: n/a (built-in type)

o Buffer Size: 1 MB

o Disc Loading: Caddy

o Recording Speed: 1x, 2x

o Read CD-DA through SCSI: Yes

o Firmware (at printing): v2.35

JVC XR-W2010 o Connector Type: 2x50 pin

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.26
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Kodak Disc
Transporter

o Connector Type: SCSI-2 (2 x 50 HD)

o Buffer Size: n/a

o Disc Loading: n/a

o Recording Speed: n/a

o Firmware (at printing): n/a

Kodak CDR-240 o Connector Type: SCSI-2 2x50HD

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.20

Kodak PCD200 o Connector Type: 2 x 50 pin SCSI-2

o Buffer Size: 512 KB

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CD-DA through SCSI: No

o Firmware (at printing): v2.07

Kodak PCD225 o Connector Type: 2 x 50 pin SCSI-2

o Buffer Size: 1MB to 32 MB

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.05

Kodak PCD600 o Connector Type: 2 x 50 pin

o Buffer Size: 2 MB standard, upgradable to 4 or 8 MB

o Disc Loading: Motorized Tray

o Recording Speed: 2x, 6x

o Firmware (at printing): v3.3

Mashushita
CW70501

o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v0.90
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Microboards
Playwrite 2002

o Connector Type: 2x50 pin

o Buffer Size: 2 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: No

o Firmware (at printing): v1.28

Mitsumi CDR2000 o Connector Type: internal ribbon

o Buffer Size: 2 Mb

o Disc Loading: Caddy

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v5046

Olympus Deltis
CD-R2

o Connector Type: Centronics (2 x 50 pins)

o Buffer Size: 1 MB

o Disc Loading: Caddy

o Recording Speed: 2x

o Firmware (at printing): v0.93

Olympus/Deltis
CDS 615

o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Caddy

o Recording Speed: 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v2.0

Philips CDD521 o Connector Type: 2 x 50 pin SCSI-2

o Buffer Size: 512 KB

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CD-DA through SCSI: No

o Firmware (at printing): v2.07

Philips CDD522 o Connector Type: 2 x 50 pin SCSI-2

o Buffer Size: 1MB to 32 MB

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.06
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Philips CD2000 o Buffer Size: 1 MB

o Connector Type: 2 x 50 pins

o Disc Loading: Caddy

o Recording Speed: 1x, 2x or (4x reader)

o Firmware (at printing): v0.16

Pinnacle Micro
RCD1000

o Connector Type: Centronics (2 x 50 pins)

o Buffer Size: 1MB

o Disc Loading: Caddy

o Recording Speed: 1x, 2x

o Read CD-DA through SCSI: No

o Firmware (at printing): v1.32

Pinnacle Micro
RCD 202

o Connector Type:  Centronics (2 x 50 pins)

o Buffer Size: 64KB

o Disc Loading: Caddy

o Recording Speed: 1x

o Read CDDA through SCSI: No

o Firmware (at printing): v1.24

Pinnacle RCD 1000 o Connector: 2 x 50 pin Centronics

o Buffer Size: 1 MB

o Disc Loading: Caddy

o Recording Speed: 1x, 2x

o Read CD-DA through SCSI: No

o Firmware (at printing): 1.28

Pinnacle RCD 5020 o Connector Type: 2x50 pin

o Buffer Size: 1 Mb

o Disc Loading: Caddy

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v2.35

Pinnacle RCD 5040 o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.18
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Pioneer
DRM-5004X,

DR 504X,
DW-S114X

o Connector Type: n/a (Jukebox)

o Buffer Size: 1 MB

o Disc Loading: Robotics

o Recording Speed: 2x, 4x

o Read CD-DA through SCSI: Yes

o Firmware (at printing): v0.101

Pioneer
DW-S114X

o Connector Type: n/a (Jukebox)

o Buffer Size: 1 MB

o Disc Loading: Tray

o Recording Speed: 2x, 4x

o Read CD-DA through SCSI: Yes

o Firmware (at printing): v0.101

Plasmon RF4100,
RF4102

o Connector Type: Centronics (2 x 50 pins)

o Buffer Size: 1MB and 2MB, respectively, up to 32 MB

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: No

o Firmware (at printing): v1.28

Plasmon CDR4220 o Connector Type: internal ribbon

o Buffer Size: 1 Mb

o Disc Loading: Tray

o Recording Speed: 1x, 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v1.20

RICOH 1420 o Connector Type: internal ribbon

o Buffer Size: 512KB

o Disc Loading: Caddy

o Recording Speed: 2x

o Read CDDA through SCSI: Yes

o Firmware (at printing): v0.80
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RICOH RS-1060C o Connector Type: Centronics (2 x 50 pins)

o Buffer Size: 512KB

o Disc Loading: Caddy

o Recording Speed: 2x

o Read CDDA through SCSI: No

o Firmware (at printing): v0.92

RICOH RS-9200C o Connector Type: Centronics (2 x 50 pins)

o Buffer Size: 1 MB

o Disc Loading: Caddy

o Recording Speed: 1x

o Read CDDA through SCSI: No

o Firmware (at printing): v0.167 

Sony CDU-920S,
CDU-921S

o Connector Type: n/a (built-in type), Centronics (2 x 50 pins), respectively

o Buffer Size: 1MB

o Disc Loading: Caddy

o Recording Speed: 2x

o Read CDDA through SCSI: Yes (CDU-920S)

o Firmware (at printing): v2.0b

Sony CDW-E1/W1,
CDW900E

o Connector Type:  SCSI-2 (2 x 50 HD)

o Buffer Size: 1MB

o Disc Loading: Tray

o Recording Speed: 1x only (E1/W1), 1x, 2x (900E)

o Read CDDA through SCSI: No

o Firmware (at printing): n/a, v1.32, respectively

Yamaha CDR100/
CDE100

o Connector Type: 2 x 50 SCSI-2

o Buffer Size: 512 KB 

o Disc Loading: Caddy

o Recording Speed: 1x, 2x, or 4x

o Read CD-DA through SCSI: Yes

o Firmware (at printing): v1.10
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Yamaha CDR102 o Connector Type: 2 x 50 SCSI-2

o Buffer Size: 512 KB 

o Disc Loading: Caddy

o Recording Speed: 2x

o Read CD-DA through SCSI: Yes

o Firmware (at printing): v1.10

Other Recorders GEAR also supports the following OEM recorders based on the mechanism listed 
under the section CD Recorder Compatibility List:

o DataDisc

o Dynatek

o FWB

o MicroNet

o Playwrite

o Smart & Friendly

o Trace

o Most SCSI-controlled jukeboxes, including ASM and K & S

For an up-to-date list of supported recorders, contact Elektroson at the following:

o CompuServe: GO GEAR

o Internet: support@elektroson.com
gear.support@elektroson.nl

o Registration: register@elektroson.com

For Asia and South and North America:

Elektroson, Inc.
2105 South Bascom Avenue, Suite 160
Campbell, CA 95008
Tel: 1.408.371.4800
Fax: 1.408.371.4895

For Europe, Africa, and the Middle East:

Elektroson, BV.
Schootsestraat 14,5616 RD
5616 RD Eindhoven
The Netherlands
Phone: 31 40 2515 065
Fax: 31 40 2514 920



n 35

Chapter 3 Getting Started With GEAR helps you start and learn to use GEAR.

Chapter 4 Creating a CD-ROM shows you how to create and record a CD-ROM

Chapter 5 Creating a CD-ROM XA shows you how to create an extended architecture project.

Chapter 6 Creating an Audio CD shows you how to create and record a digital audio CD.

Chapter 7 Working With Virtual Images explains how to edit the contents of a project.

Chapter 8 Working With Multi-Session Discs explains how to append data to a disc.

Chapter 9 Working With External Files explains what an external image is and how to edit it, 
and discusses different formats.

Chapter 10 Testing and Writing a CD Project File shows you how to prepare for writing discs, 
test system performance, and write CD-R discs and premaster tapes.

GEAR for Windows 95 
Introduction
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3Getting Started With 
GEAR for Windows 95

This chapter helps you create your first CD in just minutes. You can read about the 
following:

o Starting GEAR

o Loading data

o Choosing CD-Recorder settings

o Writing a CD-R

o Writing a master tape

o Using the on-line help

Starting GEAR

Before you start GEAR, make sure your recorder is turned on and recognized when 
you boot your system. The setup program of GEAR has added the GEAR folder to 
the Programs item in the Start menu.

1. Click Start in the Taskbar, and then locate the GEAR for Windows 95 folder.

2. Click the GEAR program icon.

The Workbench appears where you can create a new project. The new project 
is saved in a virtual image file. A virtual image file is a file that contains all the 
information you need to create a CD.

click to start GEAR
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Create your CD in three steps

When creating a compact disc, there are three steps to follow:

1. Select the type of disc to be created and set the appropriate parameters.

2. Select the data you want to write to disc.

3. Select the correct recording media and device and write the project.

You will find a detailed description of these steps below, in the sections ‘Creating 
a New CD Project’ (steps 1&2) and ‘Writing to a CD-R’ (step 3).

The GEAR Toolbar

GEAR displays the function of a button when you place your mouse on a button. 
The toolbar contains the following buttons:

Use the 
Recording 
panel to choose 
the medium to 
write to.

The Status Information boxes display information about the virtual image 
you are working with and about the medium you are writing to.

Use the Disc panel to 
choose the CD type 
and settings.

New CD project

Open CD project

Append Next Session

Delete CD project

Close CD project

Disc Info

Read Track

Write CD-R

Write Premaster Tape

Data editor

Audio editor

Cue sheet editor
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Creating a New CD project

The Create project dialog lets you enter a name for your GEAR project and choose 
a location for a new virtual image file. GEAR automatically provides the .vol 
extension.

1. Select the CD type you want to create.

2. Click Create to create a new virtual image.

3. Enter a name for the new project. If you use a non ISO name GEAR prompts 
you to change the file name to ISO standards. 

Note: An ISO directory or file name is limited to uppercase alphanumeric characters and 
underscores (_). For more information see Appendix ‘ISO-9660 file and directory 
naming’. 

This toolbar button… Lets you do this

New CD project Create a new virtual image

Open CD project Open an existing project

Append Next Session Add another session to CD-R

Delete CD project Delete an existing project

Close CD project Close the current project

Disc Info Get disc information

Read Track Copy the selected track from CD-R

Write to CD-R Burn a disc

Write Premaster Tape Write to tape

Data Editor Opens the Data Editor window

Audio Editor Opens the Audio Editor window

Cue Sheet Editor Opens the Cue Sheet Editor window
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4. Select the directory and drive where you want to save the new project file, 
then click Create. The Workbench reappears.

5. Click Edit to open the Data Editor.
The GEAR Editor window opens where you can load files and directories.

6. Select the drive you want to load files from.

Enter a name for your 
new project

Choose the directory and 
drive where you want to 
save the file

Choose the disc size

Click here to 
create your 
new project

In the Drive 
window, locate 
and select the 
files you want to 
write to CD ...

You can drag directories and files from the directory window 
only, not from the tree window.

Choose the 
drive you want 
to load files 
from

 ... then drag 
them to your 
Project window

directory window

File name handling buttons

Tree window



Elektroson GEAR

Getting Started With GEAR for Windows 95 n 41

Tip: You may want to resize the Drive window and the GEAR virtual image file window so 
it suits the way you like to work.

7. Load the directories and files you want to write to CD

If any of the files you load have Non ISO characters, GEAR warns you and 
prompts you to change the file name to ISO standards.

o Click Yes to have GEAR translate the file name to valid characters. 

o Click No to load the file as is.

An ISO directory or file name is limited to uppercase alphanumeric characters 
and underscores (_). For more information see Appendix ‘ISO-9660 file and 
directory naming’.

Important: For Data tracks you may change the way GEAR handles the file names in the 
current project. When you place your mouse on a button GEAR shows you its function. 
Choose the method you want to use with a click on one of the file name handling buttons. 

Note: You can also drag files to your CD project window from the Navigator window, 
desktop or shortcuts.

8. After you have loaded all the files you want to write to CD, check them by 
browsing through the file names as you do a directory tree in the Explorer.

o If you have loaded files by mistake, select them and press the Delete key 
to remove them from the project file.

Now you are ready to write your project to CD-R disc and/or premaster tape.
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Writing to a CD-R

Now you are ready to write data to your CD. We recommend that you test before 
you write to CD-R. If you want, you can start writing immediately after a 
successful test. GEAR makes things easier for you.

Testing

1. If necessary open the project you want to test. To do this:

o Select Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

2. Choose your CD recorder in the recording panel.

3. Click the Test button on the Recording Panel. A GEAR dialog appears 
asking you if you want to write the CD-R immediately after a successful test. 

4. Click Yes if you want to start writing immediately after a successful test. If 
the test fails, GEAR displays a warning and does not begin recording.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the project are verified. Each file’s size and 
time stamp are compared to the file’s size and time stamp when it was loaded. 
Differences may occur if files are changed after they are loaded into the virtual 
image. If there are any differences, GEAR warns you and you can reload the 
files to update them. 

Note: To improve system performance, you can either minimize the fragmentation on 
your hard disk with a disk optimization program or you can use the physical image file of 
the project. See Creating a Physical Volume in Chapter 9 for more information.

Use the Recording 
panel to choose the 
medium to write to 
and to select the 
Recorder Settings

The status information boxes display information about the virtual image 
you are working with and about the medium you are writing to

Select ‘Virtual Image’ 
in the Disc panel to 
open a project for 
testing or writing.
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Writing

1. If necessary open the project you want to record. To do this:

o Select Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar

2. Select your CD recorder from the pull-down menu in the recording panel.

3. Click the Write button in the recording panel. 

Premastering a Tape

As an alternative to writing to a CD, you can premaster a tape, then send it to a 
mastering plant where the data is written to CD. The tape, which is written in DDP 
format, is accepted as a standard at mastering plants. This tape is used to create a 
glass master, which is used to create daughters. Daughters are used to stamp silver 
or production CDs.

If you turned on the Verify after write check box in the Advanced Recording 
Settings dialog, GEAR compares the contents of the tape with the actual project. 
This means that the tape is read back and its data is checked against the contents of 
your virtual image. If there are differences, GEAR warns you.

The process for premastering a tape is just like writing to CD. Make sure your tape 
unit is connected to your computer and turned on and that there is a tape in the unit 
before you start GEAR.

1. Select a tape drive in the recording panel

2. Click the Write button. 

Each file’s size and time stamp are compared to the file’s size and time stamp 
when it was loaded. Differences may occur if files are changed after they are 
loaded into the virtual image. If there are any differences, GEAR warns you 
and you can reload the files to update them. 

As GEAR writes data to the tape, it reports in the GEAR Information window 
the percentage written for each track of the volume. When writing is complete, 
the tape is ejected automatically. Your tape is ready to send to a CD-ROM 
mastering plant!
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Using the On-line Help

On-line help is available at any time if you do not understand how to use the 
software. To access help, do any of the following:

o Press Shift+F1 or choose Index from the Help menu to display the help Index.

o Choose Using Help from the Help menu for information about using an on-
line help system.

o Choose About GEAR from the Help menu to display version and registration 
information about your copy of GEAR.
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4Creating a CD-ROM 
(Windows 95)

This chapter teaches you how to create a CD-ROM. You can read about the 
following:

o Creating a new project

o Loading CD-ROM project contents

o Writing the CD-ROM project to your CD recorder

o Copying a CD-ROM track

About Creating a CD-ROM

The CD-ROM type is used for recording computer data and always consists of one 
ISO track. The GEAR CD-ROM project is created to ISO standards with error-
checking capabilities. This is referred to as MODE 1 format (yellow book).

When you create a new project, three administration files are created in your 
current working directory with the following extensions:

o .mxx

o .ixx

o .fxx

Do not delete or edit these files manually; this results in a corrupt and useless 
project.
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Creating a new CD-ROM project

When you start GEAR, the Workbench appears where you can create a 
new project. The new project is saved in a virtual image file. A virtual 
image file is a file that contains all the information you need to create a 
CD. 

1. Select CD-ROM as CD type in the Disc Panel.

2. Click Create in the Disc Panel.
The Create Project window appears. 

Use the Recording 
panel to choose 
the medium to 
write to.

The Status Information boxes in each panel display information about 
the virtual image you are working with and about the medium you are 
writing to.

Use the Disc panel to 
choose the CD type 
and settings.

Enter a name for 
your new project.

Select the directory 
and drive where you 
want to save the file.

Choose the disc size.

Click here to 
create your new 
project.
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3. Enter a name for the project.
GEAR automatically provides the name of the virtual image file. 

4. Select the drive and directory where you want to save the file.

5. Select the length of the project.

You may choose 80, 74, 63, or 18 minutes according to your CD-R 
disc size.

6. Click Create to close the dialog and create the new project. If you 
choose a Non ISO name, GEAR prompts you to translate to ISO 
standards.
A valid ISO name may consist of up to eight alphanumeric 
characters and underscores (_). For information about valid ISO-
9660 names, see Appendix D.

You are now ready to start loading the contents of the project.

Creating the CD Project Contents

You can load the data for a virtual image by selecting files in Your Drive 
window and dragging them to your GEAR Project window. It is that easy!

CD-ROM Disc Size

18 min. 158 MB

63 min. 553MB

74 min. 650MB

80 min. 703MB
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File name handling buttons

For data tracks only, you can determine how and when non-ISO file and 
directory names are translated with the File Name handling buttons. You 
can change the default setting in the GEAR preferences (in the Options 
menu in the workbench). The option not to translate the file name is 
particularly useful when you want to use the long Windows 95 file names 
on your CD. See appendix D for more information on ISO standards. 

Loading Files
1. Open the project you want to load files for. To do this:

o Choose Virtual Image in the Disc panel and click the Open 
button or ...

o Click the Open CD project button in the toolbar.

Prompt for translation 
to ISO standards

Translate file name to 
upper case

Translate file name to ISO 
level 3 standards

Do not 
translate to 
ISO standards

Translate file name to 
DOS standards

Locate and select the 
virtual image you want to 
work with ....

... then click Open
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2. Locate and select the virtual image you want to open, then click 
Open. The workbench appears.

3. Click Edit to open the Data Editor. The Editor window appears.

4. In the Drive Window, locate and select the files you want to load, 
then drag them to the Project window.

The Status Information boxes display the Session and 
track number and the free space in Mb.

The name of the virtual image 
you open is displayed in the 
program title bar.

Click here to open the Data 
Editor where you can load files 
in your virtual image..

In the Drive 
window, 
locate and 
select the files 
you want to 
write to CD ...

Note: You can drag directories and files from the directory 
window only, not from the tree window.

Tree window

Choose the 
drive you want 
to load files 
from

 ... then drag them 
to your Project 
window

Directory window

Use these buttons to set the file name 
handling in the current project
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Note: You can also drag files to the GEAR project window from the Navigator window, 
desktop, shortcuts, or the GEAR File Manager window.

5. Continue to select and load files for the project until your CD-ROM project is 
finished.

Recording A CD-ROM project

You can specify the types of settings appropriate for your CD recorder using the 
Settings button in the Recording Panel. There are three types of settings:

o Common

o Advanced

o SCSI

Changing Recorder Settings

1. Click the Setup button in the Recording panel of Workbench to display the CD 
Recorder Setup dialog or choose CD Recorder Setup (Edit menu).

2. Select the type of recording settings you want to use:

o Common Recorder Settings lets you specify speed and multi session options.

o Advanced Recorder Settings lets you enter the number of copies you want to 
record.

o SCSI Settings lets you specify the driver and buffer options.

(For details about these options, see chapter 10 Writing and testing of Projects.)

3. When you have specified your recording settings, click OK.
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Testing and Writing to CD-R 

Now you are ready to write data to your CD. We recommend that you test before 
you write to CD-R. If you want, you can start writing immediately after a 
successful test. GEAR makes things easier for you.

Testing

1. If necessary open the project you want to test. To do this:

o Choose Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

2. Choose your CD recorder in the recording panel.

3. Click the Test button on the Recording Panel. A GEAR dialog appears asking you 
if you want to write the CD-R immediately after a successful test.

4. Click Yes if you want to write the project after a successful test. If the test fails, 
GEAR displays a warning and does not begin recording.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the project are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. 
Differences may occur if files are changed after they are loaded into the virtual 
image. If there are any differences, GEAR warns you and you can reload the files to 
update them. 

Note: To improve system performance, you can either minimize the fragmentation on your 
hard disk with a disk optimization program or you can use the physical image file of the project. 
See Creating a Physical Image in Chapter 10 for more information.

Use the Recording 
panel to choose the 
medium to write to 
and to select the 
Recorder Settings.

The status information boxes display information about the virtual 
image you’re working with and about the medium you are writing to.

Select Virtual Image in 
the Disc panel to open 
a project for testing or 
writing.
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Writing

1. If necessary open the project you want to record. To do this:

o Select Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar

2. Choose your CD recorder from the pull-down menu in the recording panel.

3. Click the Write button in the recording panel. 

As GEAR writes data to the CD-R, a buffer is filled with data to prevent a a shortage 
of data in the writing process. A shortage of data would cause a write failure and the 
loss of your CD-R. In the GEAR information window you can see the percentage 
of each track written to CD-R and the percentage of data remaining in the buffer. 
When writing is complete, the disc is ejected automatically. Your disc is ready for 
reading in any CD-ROM drive!

Copying a Track from CD-ROM
1. Insert a CD-ROM ISO CD in your CD recorder.

2. In the Workbench window, click the CD Info button to display a window 
containing information about the CD, such as the track types used.

3. Click the Copy button to copy the project to your hard disk.

4. In the GEAR dialog that appears, choose a name for the project and click OK. 
A GEAR information window displays the percentage of the project written to 
your hard disk.

5. Click OK to close the CD information window.
You will now select the project you have copied and write it to CD-R.

6. In the Workbench window, select External Image from the CD Type pull-down 
menu.

7. Click the Open button in the Disc panel.

8. Select your project in the dialog that appears and click Open. The External Image 
dialog appears.

9. Select CD-ROM Mode 1 as Image type and click OK.

You can now write your image to CD-R with a click on the Test or Write button in 
the Recording panel.
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5Creating a CD-ROM 
XA (Windows 95)

This chapter provides information about how to create a CD-ROM XA project. 
You can read about the following:

o Creating a new CD-ROM XA

o Opening an existing XA project

o Loading the project contents

o Writing the project to your CD recorder

o Copying a CD-ROM XA track

For information about editing the project contents, project settings and labels, see 
Chapter 7. For information about Audio CD, see Chapter 6.

About Creating a New CD-ROM XA project

XA (eXtended Architecture) is a track type for CD-ROM XA and CD-I. This 
format is used for multi-media applications and consists of one track only. XA is 
suited for the following formats: CD-ROM XA, CD-I, EB, MMCD, Photo CD, and 
VideoCD.

Creating a new XA project 

The process to create a new XA project is similar to creating a new virtual image as 
described in Chapter 3.
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When you start GEAR, the Workbench appears where you can create a new 
project. The new project is saved in a virtual image file. A virtual image file is a 
file that contains all the information you need to create a CD. 

1. Select CD-ROM XA as CD type in the Disc Panel.

2. Click Create in the Disc Panel.
The Create CD project window appears. 

3. Enter a name for the project.
GEAR automatically provides the name of the virtual image file. 

4. Select the drive and directory where you want to save the file.

5. Select the size of the project.

Use the Recording 
panel to select the 
medium to write 
to.

The Status information boxes each panel display information about the 
virtual image you’re working with and about the medium you are writing to.

Use the Disc panel to 
select the CD type 
and settings.

Enter a name for 
your new project.

Select the directory 
and drive where you 
want to save the file.

Choose the disc size.

Click here to 
create your new 
project.
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You may choose 80, 74, 63, or 18 minutes according to your CD-R disc size.

6. Click Create to close the dialog and create the new project. If you choose a Non 
ISO name, GEAR prompts you to translate to ISO standards.
A valid ISO name may consist of up to eight alphanumeric characters and 
underscores (_). For information about valid ISO-9660 names, see Appendix D.

You are now ready to start loading the contents of the project.

Creating the CD project Contents

You can load files for the selected XA track by selecting the files in the File Manager 
and dragging them to the GEAR project window.

File name handling buttons

In the Data Editor you can determine buttons how and when non-ISO file and directory 
names are translated with the File Name handling. You can change the default setting in 
the GEAR preferences (in the Options menu in the workbench). 
The option not to translate the file name is particularly useful when you want to use the 
long Windows 95 file names on your CD. See appendix D for more information on ISO 
standards. 

CD-ROM XA Disc Size

18 min. 180MB

63 min. 631MB

74 min. 741MB

80 min. 802MB

Prompt for translation 
to ISO standards

Translate file name to 
upper case

Translate file name to ISO 
level 3 standards

Do not translate 
to ISO standards

Translate file name to 
DOS standards
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Loading Files

You can load the data for a virtual image by selecting files in Your Drive window and 
dragging them to your GEAR project window. It is that easy!

1. Open the project you want to load files for. To do this:

o Select Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar..

2. Locate and select the virtual image you want to open, then click Open. The 
workbench appears. 

3. Click Edit to open the Data Editor. The Editor window appears.

4. In the Drive Window, locate and select the files you want to load, then drag them 
to your XA track window.

Locate and select the 
virtual image you want to 
work with ....

... then click Open.

The Status Information boxes display the Session and 
track number and the free space in Mb.

The name of the virtual image you 
open is displayed in the program 
title bar.

Click here to open the Data 
Editor where you can load files 
in your project.
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In Windows 95, you can also drag files to the GEAR window from the Navigator 
window, desktop, shortcuts, or the GEAR File Manager window.

5. Continue to select and load files until your CD-ROM XA project is finished.

Recording a CD-ROM XA project

Before you write to CD, we recommend you first select your Recording settings. You 
can specify the types of settings appropriate for your CD recorder using the Settings 
button in the Recording Panel. There are three types of settings:

o Common

o Advanced

o SCSI

Changing Recorder Settings

1. Click the Settings button in the Recording panel of Workbench to display the CD 
Recorder Setup dialog.

2. Choose the type of recording settings you want to change:

o Common Recorder Settings lets you specify speed and multi session options.

o Advanced Recorder Settings lets you enter the number of copies you want to 
record.

In the Drive window, 
locate and select the files 
you want to write to CD ...

Note: You can drag directories and files from the 
directory window only, not from the tree window.

Tree window

Select the drive 
you want to load 
files from.

 ... then drag them to your 
XA track window.

Directory window



Elektroson GEAR

58 n Creating a CD-ROM XA (Windows 95)

o SCSI Settings lets you specify the driver and buffer options.

(For details about these options, see chapter 7 Writing and Testing of Projects.)

3. When you have specified your recording settings, click OK.

Testing and writing to CD-R

Now you are ready to write data to your CD. We recommend that you test before you 
write to CD-R. If you want, you can start writing immediately after a successful test. 
GEAR makes things easier for you.

Testing

1. If necessary open the project you want to test. To do this:

o Select Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

2. Select your CD recorder in the recording panel.

3. Click the Test button on the Recording Panel. A GEAR dialog appears asking you 
if you want to write the CD-R immediately after a successful test.

4. Click Yes if you want to write the image after a successful test. If the test fails, 
GEAR displays a warning and does not begin recording.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the project are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. 
Differences may occur if files are changed after they are loaded into the virtual 
image. If there are any differences, GEAR warns you and you can reload the files to 
update them. 

Note: To improve system performance, you can either minimize the fragmentation on your 
hard disk with a disk optimization program or you can use the physical image file of the volume. 
See Creating a Physical Volume in Chapter 10 for more information.

Writing

1. If necessary open the image you want to record. To do this:

o Select Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar.

2. Select your CD recorder from the pull-down menu in the recording panel.

3. Click the Write button in the recording panel. 
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As GEAR writes data to the CD-R, a buffer is filled with data to prevent a a shortage 
of data in the writing process. A shortage of data would cause a write failure and the 
loss of your CD-R. In the GEAR information window you can see the percentage 
of each track written to CD-R and the percentage of data remaining in the buffer. 
When writing is complete, the disc is ejected automatically. Your disc is ready for 
reading in any CD-ROM drive!

Copying a Track from a CD-ROM XA
1. Insert a CD-ROM XA CD in your CD recorder.

2. In the Workbench window, click the CD Info button to display a window 
containing information about the CD, such as the track types used.

3. Click the Copy button to copy the image to your hard disk.

4. In the GEAR dialog that appears, enter a name for the project and click OK. 
A GEAR information window displays the percentage of the image written to 
your hard disk. When the image is written to your hard disk the Disc information 
window reappears.

5. Click OK to close the CD information window.
You will now select the image you have copied and write it to CD-R.

6. In the Workbench window, select External Image from the CD Type pull-down 
menu.

7. Click the Select external image button in the Disc panel.

8. Select your XA image in the dialog that appears and click Open. The External 
Image dialog appears.

9. Select CD-ROM XA as Image type and click OK to close the External image 
dialog. 

You can now write your image to CD-R with a click on the Test or Write button in 
the Recording panel.
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6Creating an Audio CD 
(Windows 95)

This chapter teaches you how to create and open an audio CD project. You can read 
about the following:

o Creating a new audio project

o Copying an audio track from CD

o Loading audio tracks in a project

o Writing an audio project to CD-R

o Creating an audio CD in several sessions

o Using a Cue Sheet to create an Audio CD

For information about editing, project settings and labels, see Chapter 7.
For information about CD-ROM XA projects, see Chapter 5.

About Creating a New Audio CD

When you create an Audio project, you need hard disk files that represent audio. 
GEAR supports Red Book audio file formats, as well as the following formats:

o .wav

o AIFF

o Sound Designer II

Depending on the audio package you are using, the audio file may or may not 
contain a sound header, however, audio files should not contain sound headers. If 
sound headers are not removed or cleared, they will cause a sharp click in the 
resulting audio track on the CD. For .wav, AIFF, and Sound Designer II files, 
GEAR removes the header automatically. AIFF files are usually in MSB format.
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Audio file requirements

The files must always fulfill the following requirements, which are specified in the Red 
Book:

o The sample frequency must be 44.1kHz.

o Audio must be stereo (one sample for the left channel and one sample for the right 
channel) sampled on 44.1kHz.

o Each sample must contain 16 bits.

o The byte order must be the same as the byte order used by your computer; if it is 
not, you can use the generic option MSBAudio (in gear.ini) to make GEAR swap 
the audio bytes for all tracks.

For example, LSB audio is the default on DOS and Windows. If you want GEAR to 
swap byte order, set MSBAudio=True in the gear.ini file.

Warning! The Philips CDD522 reads audio in MSB format while the Yamaha CD-R100 reads 
audio in LSB format.

You can load up to 99 audio tracks in your project. If audio tracks are combined on a disc 
with an ISO or XA track, you can create up to 98 tracks. The CD audio type is suited for 
CD Digital Audio.

Copying an Audio Track from CD-ROM

GEAR lets you extract tracks form a CD-ROM and store them on your hard disk for 
recording on a CD-R. 

Note: Not all recorders support copying digital audio tracks. 
For more information see chapter 2, Supported recorders.

1. Insert an audio CD in your CD recorder.

2. In the Workbench window, click the View CD Info button to display a window 
containing information about the CD, such as the track types used.

3. Choose the track you want to copy and click the Copy button to copy the image 
to your hard disk.

4. In the GEAR dialog that appears, choose a name for the file and click OK. 
A GEAR information window displays the percentage of the track written to your 
hard disk.

5. Click OK to close the CD information window. You can now load the files in an 
audio project and write them to CD-R.
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Creating a New Audio CD project

When you start GEAR, the Workbench appears where you can create a new project. The 
new project is saved in a virtual image file. A virtual image file is a file that contains all 
the information you need to create a CD. 

1. Select the CD type you want to create in the Disc panel.

2. Click Create to create a new virtual image.

3. Enter a name for the new project. The project file name is provided 
automatically. 

Use the Recording 
panel to select the 
medium to write 
to.

The Status information boxes in each panel displays 
information about the virtual image you’re working with and 
about the medium you are writing to.

Use the Disc panel to 
choose the CD type 
and settings.

Enter a name for your 
new project.

Choose the directory and 
drive where you want to 
save the file.

Choose the disc size.

Click here to create 
your new project.
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4. Choose the disc size. 

5. Select the directory and drive where you want to save the new project file

6. Click Create to close the dialog and create the new audio CD project.
If you choose a Non ISO name, GEAR prompts you to translate to ISO standards.
A valid ISO name may consist of up to eight alphanumeric characters and 
underscores (_). For information about valid ISO-9660 names, see Appendix D.

Now you are ready to load the audio project contents.

Creating the Audio Project Contents

You can load an audio file for each track on an audio CD by selecting the audio file in 
the Drive window and dragging it to your CD-ROM window. It’s that easy!

When you load files for a track, keep in mind the following points:

o Each file you load in the project represents a track

o You can not load directories

Loading an Audio Track

You can load the data for a virtual image by selecting files in Your Drive window and 
dragging them to your CD-ROM window. It is that easy!

1. Open the project you want to load files for. To do this:

o Choose Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar.

Audio Image Data Capacity

Disc Size CD Audio

18 min. 181MB

63 min. 653MB

74 min. 746MB

80 min. 807MB
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2. Locate and select the virtual image you want to open, then click Open. The 
workbench appears. 

3. Click Edit to open the Audio Editor. The Editor window appears.

4. In the Drive Window, locate and select the files you want to load, then drag them 
to the CD-ROM window. You will see that for each file you drag into your Track 
window a new Audio track is created automatically.

Note: You can copy tracks from an audio CD directly in your project. To do this:

o First click the CD info button in the Editor toolbar. A CD information window 
appears with all the tracks of the audio CD.

o Then drag and drop the tracks you want to copy from the CD information window 
to your Audio project window. GEAR will create a physical image on your hard disk 
of all these tracks.

Locate and select the 
virtual volume you want 
to work with ....

... then click Open.

 The Status Information boxes displas the Session and 
track number and the free space in Mb.

The name of the virtual image 
you open is displayed in the 
program title bar.

Click here to open the Data 
Editor where you can load files 
in your project.
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In Windows 95, you can also drag files to the GEAR window from the Navigator 
window, desktop, shortcuts, or the GEAR File Manager window.

5. Continue to select and load files for the image until your Audio CD volume is 
finished.

Recording an Audio CD

Before you write to CD, we recommend you first select your Recording settings. You 
can specify the types of settings appropriate for your CD recorder using the Settings 
button in the Recording Panel. There are three types of settings:

o Common

o Advanced

o SCSI

Changing Recorder Settings

1. Click the Settings button in the Recording panel of Workbench to display the CD 
Recorder Setup dialog or choose CD Recorder Setup (Edit menu).

2. Choose the type of recording settings you want to change:

o Common Recorder Settings lets you specify speed and multi session options.

o Advanced Recorder Settings lets you enter the number of copies you want to 
record and lets you enable or disable the fixation of the disc.

o SCSI Settings lets you specify the driver and buffer options.

In the Drive window, locate 
and select the files you 
want to write to CD ...

You cannot drag directories to your Audio image.

Choose the 
drive you want 
to load files 
from.

 ... then drag them to 
your Audio 
track window.

Disc Information button
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For details about the recorder options, see chapter 10 ‘Writing and testing of 
Projects’.

3. When you have specified your recording settings, click OK.

Testing and writing to CD-R

Now you are ready to write data to your CD. We recommend that you test before writing 
your project to CD-R. If you want, you can start writing immediately after a successful 
test. GEAR makes things easier for you.

Note: If you record the tracks in more than one recording session make sure the disc fixation 
is disabled until the last session.

Testing

1. If necessary open the audio project you want to test. To do this:

o Choose Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

2. Choose your CD recorder in the recording panel.

3. Click the Test button on the Recording Panel. A GEAR dialog appears asking you 
if you want to write the CD-R immediately after a successful test.

4. Click Yes if you want to write the project after a successful test. If the test fails, 
GEAR displays a warning and does not begin recording.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the project are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. 
Differences may occur if files are changed after they are loaded into the virtual 
image. If there are any differences, GEAR warns you and you can reload the files to 
update them. 

Note: To improve system performance, you can either minimize the fragmentation on your 
hard disk with a disk optimization program or you can use the physical image file of the project. 
See Creating a Physical Image in Chapter 10 for more information.
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Writing

1. If necessary open the audio project you want to record. To do this:

o Select Virtual Image in the Disc panel and click the Open button or ...

o Click the Open CD project button in the toolbar

2. Choose your CD recorder from the pull-down menu in the recording panel.

3. Click the Write button in the recording panel. 

As GEAR writes data to the CD-R, a buffer is filled with data to prevent a a shortage of 
data in the writing process. A shortage of data would cause a write failure and the loss 
of your CD-R. In the GEAR information window you can see the percentage of each 
track written to CD-R and the percentage of data remaining in the buffer. 
When writing is complete, the disc is ejected automatically. Your disc is ready for 
reading in any Audio CD player!

Creating an Audio CD in several sessions

If you have not enough Megabytes left on your hard disk to hold all the audio files or if 
you have not prepared all your audio files for recording, you can load files in several 
recordings. 
Audio CDs should be single-session discs because CD players are single-session 
readers. Therefore you cannot finalize an audio CD until you have loaded all the audio 
files for all the tracks.
You must therefore disable the multi-session and fixation options in the recording panel 
until the recording of the last track to CD-R. The disc must then be fixated for an Audio 
player to be able to read it.

1. Disable the multi-session and disc fixation options in the recorder settings.

2. Write the audio tracks to CD-R except for the last track.

3. Enable the disc fixation.

4. Write the last track.

Using a Cue sheet to create an Audio CD

If you have a Disc at Once compatible recorder you can create a professional audio CD 
using a Cue sheet. The Cue sheet should contain all the tracks you want to record. You 
create the Cue sheet in the GEAR Cue sheet editor or in any plain ASCII editor.
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The Cue sheet editor will contain a list of images that will be loaded into consecutive 
tracks on the disc. The image files can be loaded by a simple drag and drop from your 
Drive window to the Track list. For each file loaded you can specify the type of data 
enclosed. If a Disc at Once recorder is used to write the image you can also specify the 
pause between the tracks.

To create a CD-R using a Cue Sheet you must do the following:

1. Select Cue Sheet in the CD type pull down menu.

2. Click the Cue Sheet editor button in the toolbar.
The Cue Sheet editor appears with a new Cue sheet.

3. Load the files representing the images from the Drive window into the Cue sheet 
window. 

4. Double click the file names in the Cue sheet window to specify the track type and 
the pause after the track.

5. Close the Cue sheet editor after selecting all the files you want to write to CD-R. 
A GEAR dialog appears where you are prompted to save the Cue sheet. 

6. Click Yes to save the Cue sheet. GEAR provides a name automatically. The 
workbench window reappears.

7. Click the write button in the recording panel to write the project to CD-R .
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7Working With Virtual 
Images (Windows 95)

This chapter provides information about working with virtual images that already 
contain data. In this chapter, you can read about the following:

o General information about virtual images

o Editing the contents of a virtual image

o Editing virtual images settings

For information about creating a virtual image and tracks and loading their 
contents, see Chapter 4. For information about working with external image files, 
see Chapter 9.

About Virtual Image Files

A virtual image is the minimal amount of information needed to create a CD. The 
opposite of the virtual image is a physical image, which is the entire CD stored on 
a hard drive before it is recorded.

When you create a new virtual image, the file is called a volume administration file. 
You must have more than 25MB of free disk space available to create a volume 
administration file. 
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Three administration files are created for each new track you create in the current 
working directory. The files are named using the first eight characters of the image 
name plus the following extensions (xx represents the track number):

o .mxx

o .ixx

o .fxx

You should never edit or delete these files manually; this results in a corrupt and 
useless image. Administration files are deleted automatically when you delete the 
associated image.

Working With an Existing Virtual Image

An existing virtual image can be one of the following:

o A GEAR project file

o An external image file

You can edit and write to GEAR virtual images, however, you can only write an 
external image file to a CD-R disc or tape. For information about writing to GEAR 
volumes, see Chapter 11.

Calculating Virtual Image Capacities

You can use the following formula to calculate the capacity of a virtual image:

virtual image capacity = sector data capacity (bytes) x length (minutes) x 60 (seconds) x 75 (number of sectors)

The following table shows the sector data capacities for each track type:

Track Type Sector Data Capacity

ISO 2048 bytes

XA and CD-I 2336 bytes

CD Audio (DA) 2352 bytes



Elektroson GEAR

Working With Virtual Images (Windows 95) n 73

The following table shows the virtual image data capacity for each disc size and 
track type:

As you create your new image, you must keep the following in mind:

o The track number is assigned automatically and is relevant only for CD Audio. 
With the exception of CD Enhanced and CD Plus, ISO and XA tracks are 
always assigned to track number 1.

o A virtual image can have only one ISO or XA track; it may not have both types 
of tracks.

o A virtual image can contain up to 99 tracks.

o It is impossible to assign CD Audio to track number 1 if you create either an 
ISO or XA track on the virtual image .

o When you create a new track, it is automatically assigned the maximum avail-
able space on the virtual image.

Opening a Virtual Image for Editing

Before you open a virtual image, you must first close any image that is already 
open. The selected image is expanded to the size of the maximum free space 
available within the virtual image. This space is determined by:

o The maximum disc size you specified when you created the virtual image

o The amount of memory required by the other tracks within the same image

Warning! You can edit images with a .vtl extension only in GEAR3.01 or earlier.

Virtual Image Data Capacity

Disc Size ISO XA and CD-I CD Audio

18 min. 158 MB 180MB 181MB

63 min. 553MB 631MB 653MB

74 min. 650MB 741MB 746MB

80 min. 703MB 802MB 807MB
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1. To open an existing image you do this:

o Select Virtual Image in the Disc panel and click the Open button, or 

o Click the Open CD project button in the toolbar.

The Open project dialog appears.

2. Locate and double-click the virtual image you want to open.

Editing the contents of a virtual image

You can edit a selected virtual image in the following ways:

o Create a new directory on the track

o Rename a file or directory on the track

o Delete selected files and directories from the track

Tip: To increase CD-ROM access time, limit the number of entries in a directory to 50.

Note: DOS recognizes file names of up to eight characters; file names can have a three-
character extension. Other systems are not limited to this restriction.

Select Virtual Image in 
the Disc panel to open 
an image for testing 
or writing ...

... then click Open.
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Selecting and Deselecting Files and Directories

You can select one file or directory or you can select multiple files and directories 
to rename or delete. When you use the Select and Deselect commands in the Files/
Directories submenu of the Edit menu, you can enter standard DOS wildcard 
characters such as *.txt for all text files. 

Creating a New Directory

1. Open the image you want to edit.

2. Click Edit. The Data Editor appears.

To do this… Do this…

Select one file or 
directory

Click the file or directory to highlight it

Select multiple 
files and directories

Click the first file or directory, then 
Shift+click subsequent consecutive files or 
directories

Choose Select from the Files/Directories 
submenu in the Edit menu, enter selection 
criteria, then click OK

Deselect selected 
files or directories

Choose Deselect from the Files/Directories 
submenu in the Edit menu, enter a selection 
specification, then click OK

Click this button to 
create a new directory 
in the GEAR image 
window ...

 ... the new 
directory appears 
in your GEAR 
image window.
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3. Click on the New directory button in the Editor toolbar or select New direc-
tory in the Edit menu.

4. In the dialog that appears, enter a valid ISO name for the new directory.

A valid name may consist of up to 30 uppercase, alphanumeric characters 
and underscores (_). (DOS can handle only up to eight characters.) For infor-
mation about valid ISO-9660 file and directory naming, see Appendix D.
If you enter an non-ISO name, GEAR prompts you to translate the name.

5. Do one of the following:

o Click Yes to have GEAR translate the file name to valid characters.

o Click No to load the file anyway.

6. Click OK. 

The new directory appears in the working window.

Renaming Files and Directories

1. In the Data editor select the files and directories you want to rename.

2. Click the Rename Files/Directories button on the toolbar or choose Rename 
from the Files/Directories submenu of the Edit menu.

3. In the dialog that appears, enter a new name for the specified file or direc-
tory, then click OK.

4. Repeat step 3 for each selected file or directory if you selected more than one 
in step 1.

Deleting Files and Directories

1. Select the files and directories you want to delete.

2. Click the Delete File/Directory button on the toolbar or choose Delete from 
the Files/Directories submenu in the Edit menu.

3. In the dialog that appears, confirm the deletion of the selected file.

If you selected multiple files and directories in step 1, GEAR continues to 
prompt you until you have confirmed or cancelled the deletion of all selected 
files.
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Loading Hidden Files.

1. Turn on the Load Hidden files check box in the Data Editor.

2. Select the files and directories you want to load and drag them to your 
GEAR image window.

Hidden files will be loaded until you turn off the check box.

Editing Project Settings

You can edit the settings for the currently-selected project. The default values are 
specified in the gear.ini file and can be changed using the Preferences command in 
the Options menu.

o You can edit the CD label for the currently selected project. The default values 
are specified in the GEAR preferences. The default CD label is the name the 
project received when created.

o You can edit the Current Project settings. The default values are specified in 
the the GEAR preferences.

Note: Most of the current project settings can be set directly in the Data editor window. 
Only the maximum number of directories and the directory nesting must be set here.

For detailed information about the settings, see the appendix ‘GEAR initialization/
preferences file’.

1. Click Settings in the Disc panel to display the Settings dialog.
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2. Enter the information you want to save with the project in the Current CD 
Label.

3. Select the settings for the loading of files in the Current Project. You can set 
all the options in the Data Editor as well.

4. Click OK to close the Settings dialog and return to the Workbench.

GEAR preferences
Note: You can edit the current project settings with a click on the Settings button in the 
Disc panel. 

The GEAR preferences are saved in the gear.ine file. They will be the default 
values for each new project you will create. You can edit the following settings:

o Generator settings; settings used when loading files. 

o CD label settings; project information that can be written to CD-R or Tape.

o Append settings; specifies the append options for a multi-session disc.

o Working directory; directory where the project file is saved.

You cannot change the 
maximum number of directories 
for the selected project. This lets you hide 

the directory in 
the GEAR window.

When this is turned on, GEAR 
loads into the project files that 
have the DOS archive bit set, 
then…

Max Dir nesting level lets you 
specify up to 12 levels of nested 
directories you can have on the 
CD.

This lets you 
specify how invalid 
ISO names will be 
handled for the 
project.

…when this is turned on, GEAR 
resets the DOS archive bit after 
the file is successfully loaded.
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1. Select preferences from the Options menu to display the Preferences dialog.

2. Make all the changes you want, then click OK to save the preferences to the 
gear.ini file.

For detailed information about the settings, see the appendix ‘GEAR 
initialization/preferences file’.
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8Working With Multi-Session 
Discs (Windows 95)

GEAR lets you append a new session to any session that already exists on a multi-
session disc. This chapter discusses adding additional data to a disc.

For information about creating projects and loading their contents, 
see Chapters 4, 5, 6, 7.

Appending a Multi-Session Disc

By appending a multi-session disc, you can do the following:

o Add additional data to the disc

o Recover data from older sessions

o Skip the last session if there are read errors

o Create CD Enhanced or CD Plus discs

One of the sessions on the disc you want to append is used as the basis of a new 
virtual image. The content of the virtual image is edited. Finally, the virtual image 
is written to the CD-R disc.
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Append preferences

Before you start, you should select the append mode in the GEAR preferences. You can 
choose from the following modes:

o Automatic Append. GEAR uses the settings of the CD project you want to append 
to.

o Manual Append. You may select the track you want to append to and the type of 
track you want tro append. 

Note: Incorrect combinations of track types may result in a non-standard CD that cannot 
be read.

o New append. This mode will append an empty track. All previous sessions will 
become inaccessible. A disc lost due to a write failure can be used again after the 
writing of a new empty track.

o Multi volume Append. In this mode you will be able to create a multi volume disc. 
To enable the reading of the separate volumes, you will need special drivers for the 
CD player.

Changing the append mode

In order to change the append mode you must do the following:

1. Choose Preferences in the Options menu.

2. Select the Append tab in the Preferences dialog.

3. Select an Append mode and click OK. GEAR asks if you want to save the 
changes to the gear.ini file. If you want to use the settings in future sessions 
choose Yes. 

Appending to a multi-session CD-R

When you append a session to CD-R the selected session/track is read and a new virtual 
image is created. The virtual image contains the same directory/file structure as the 
session and is displayed in the project window.

Note: In order to append a multi-session CD-R, your recorder must be turned on and a disc 
must be inserted in the CD drive.

1. Click the Disc Info button. The Disc information window appears.

2. Select the session/track number you want to attach the next session to. 
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3. Click Append to display the Append To Track dialog.

If you have selected the manual append mode in the GEAR preferences you may 
now select the track type. If you selected an audio track, select a data format for 
the next session.

4. Click OK to create the new project and close the Append dialog. The GEAR 
information window displays the percentage that is retrieved.

Note: GEAR uses the name of the volume on CD-R as the name for the new project. If a project 
with the same name already exists on your hard drive, GEAR prompts you to overwrite the 
existing Project.

5. Edit the new Project content by adding or removing files.

6. Append the new session to the CD-R using the Write button in the Recording 
panel. Only changes will be written to the CD-R disc. Every time you write a 
new session, an additional 15MB is added to the CD-R disc. This is known as 
overhead.

The track you selected in the 
Disc Information window is 
displayed here.

If you selected an audio track, 
select a data format for the 
next session and … 

... then click OK to start 
appending.



Elektroson GEAR

84 n Working With Multi-Session Discs (Windows 95)



Working With External Images (Windows 95) n 85

9Working With External 
Images (Windows 95)

This chapter provides information about working with virtual images that were 
created using an authoring or formatting package other than GEAR. In this chapter, 
you can read about the following:

o Opening an external image

o Choosing a predefined format

For information about virtual images you create with GEAR, see Chapters 4, 5, 6, 
and 7.

External Images

An external image refers to any image you have created using another authoring or 
formatting package, such as CD-I, 3DO, or VideoCD. You can not edit an external 
image in GEAR, however, you can use GEAR to write an external image to a CD-R 
disc or a premaster tape. Before you write an external image, you must select it and 
define its parameters.

1. Select External image as CD type in the Disc Panel.

2. Click the ‘Open’ button to display the Open External image dialog.
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3. Locate the external image you want to open, then click Open.

The External Image Parameters dialog appears.

4. Choose a format from the Image Type drop-down list. For information about 
predefined formats, see the table under Choosing Predefined Formats, in the next 
section.

Note: Choose User-defined image type from the Image Type drop-down list if you to adjust the 
values in the dialog.

5. Click OK, when you are finished.

You can now write the external image to CD-R or tape.

Select External image files 
here.

Select the drive 
and directory where 
the external files are 
located.

Choose a predefined or 
user-defined format 
from this drop-down list.

Enter the values 
you want to use for 
a user-defined 
image type using 
these opions.
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Choosing Predefined Formats

You can choose any of the following predefined formats.

Type # Image Type Format External Volume Type

1 CD-ROM mode 1 (ISO 
etc.), sector size 2048

Standard ISO, HFS, or CDTV 
image

2 CD-ROM mode 1 (ISO 
etc.), sector size 2352

Standard ISO with EDC/ECC 
codes

3 CD-ROM mode 1 (ISO 
etc.), sector size 2352, 
scrambled sectors with 2 
seconds pre-gap

ISO with EDC/ECC codes, pre-
gap and scrambled

4 CD-ROM XA mode 2, 
sector size 2336

Standard XA or EB XA (e.g., 
images with Mammoth XA 
streams)

5 CD-ROM XA mode 2, 
sector size 2352

Standard XA with EDC/ECC 
codes

6 CD-ROM XA mode 2, 
sector size 2352, scram-
bled sectors with 2 seconds 
pre-gap

XA with EDC/ECC codes, pre-gap 
and scrambled

7 CD-I mode 2, sector size 
2336

Standard CD-I without EDC/ECC 
codes

8 CD-I mode 2, sector size 
2352

Standard CD-I with EDC/ECC 
codes

9 CD-I mode 2, sector size 
2352 with 2 seconds pre-
gap

Standard CD-I with pre-gap, EDC/
ECC

10 CD-I mode 2, sector size 
2352, scramble sectors 
with 2 seconds pre-gap

CD-I with EDC/ECC codes, pre-
gap and scrambled; uses the same 
output format as that of most CD-I 
authoring tools

11 Standard CD digital audio Red Book audio (44.1kHz, 16 bit, 
stereo)
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Keep in mind the following points about image types:

o The size of the pre-gap should always be two seconds (150 sectors). Scrambled 
images must contain sync, header, and EDC/ECC code information.

o Unscrambled images can be accepted with a 2352 sector size without the sync, 
header, and EDC/ECC filled in.

o The byte order of audio files must be the same byte order used by the computer 
running the GEAR software. If this is not the case, you can use the generic option 
MSBAudio= in the gear.ini file to make GEAR swap the audio bytes for all tracks.

With LSB audio default, if MSBAudio=True, each track will be swapped by 
GEAR. Audio files should not contain any sound header. If sound headers are not 
removed or cleared, they will cause a sharp click in the resulting audio track on the 
CD. Audio files should contain only 16-bit samples and must be stereo (one sample 
for the left channel and one sample for the right channel) sampled on 44.1kHz.

o The external image files option lets you select one file only. If the external volume 
consists of more than one file, you can choose Track list files (*.tlf) under List Files 
of Type in the Open imagefile dialog to specify more than one external file.

The track list file contains one or more lines where each line specifies a track of 
the CD-ROM (you can use a full path). For example, to write a mixed-mode im-
age—one that contains mode 1 or mode 2 data—you can specify the following 
lines in a track list file:

Tip: Be sure to leave a space between the track name/path and the image type.

track path name image type number

image.dat/1

audio.2/11

audio.3/11
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10Testing and Writing a 
Virtual Image File 
(Windows 95)

This chapter provides information about verifying virtual images and writing them 
to CD-R or premaster tape. You can read about the following:

o General information on recording

o Creating a physical image

o Verifying a virtual image

o Recorder Settings

o Testing and Writing to CD-R

o Writing to a premaster tape

Data Transfer Rates

The system has to maintain a high data transfer rate to a CD recorder. If the transfer 
rate cannot be maintained, the writing of the CD-R will fail. CD-R discs can be 
written at single, double, or quadruple speeds. The data transfer rate is dependent 
on the speed of recording and the type of track written (ISO, CD-ROM XA, or CD 
digital audio). The following table shows the required transfer rates:

1x 2x 4x 6x

ISO 153 KB/s 307 KB/s 614 KB/s 918 KB/s

CD-ROM XA 175 KB/s 350 KB/s 700 Kb/s 1050 KB/s

CD Digital 
Audio

176 KB/s 352 KB/s 705 KB/s 1056 KB/s
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For external (foreign) images, the required transfer rate depends on the selected sector 
size. 2048 bytes/sector is comparable to ISO; 2336 bytes/sector is comparable to CD-
ROM XA; 2352 bytes/sector is comparable to CD digital audio.

You can influence the Data transfer in the Recording settings. See below in the SCSI 
settings.

Improving System Performance

You can try any of the following to optimize your system’s performance:

o Close any other software applications you are running in the background.

o Use a defragmentation utility to defragment your hard disk.

o Check to see whether your hard disk does recalibration.

o Check to see if your SCSI termination is correct. A incorrect SCSI termination can 
cause delays on the SCSI bus.

o Check your smart drive configuration. If you are using a physical image, disable 
smart drive for the drive on which the physical image files are located. If you are 
using a virtual image, enable smart drive for the drive where the image files are 
located.

o Use a physical image instead of a virtual image.

o Use a lower recording speed if one is available.

Important: The performance of a system for writing a CD-R is better if the access time of your 
hard disk is lower. This is more important than a fast processor. A lot of hard disks regularly 
perform recalibration. This means that the hard disk verifies its read/write operation to pre-
vent problems. If this happens during the writing of a CD-R disc, it may result in a data transfer 
problem. Refer to your hard disk documentation or speak with your supplier about whether 
your hard disk performs recalibration.

Recommended Hard Disks

The best hard disks for writing CD-R discs are multimedia or AV (audio visual) hard 
disks. These types minimize recalibration time and guarantee a high sustained data rate.

Note: Call us or check the Elektroson BBS or CompuServe forum for updated lists of 
recommended hard disks.
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Creating a Physical Image

A physical image is a sector-by-sector copy of the CD-ROM you are about to create. 
You should use a physical image for writing to CD-R when the transfer rate for 
recording has to be increased. Otherwise, you can usually write with a virtual image.

Before you create a physical image, GEAR verifies the virtual image. If the file is not up 
to date, the physical image is not created. You can update the virtual image by reloading 
the reported files.

Depending on your needs, you can make a track or an entire image physical. The sector 
sizes for the tracks are based on their type as follows:

The physical image you create contains the current contents of the virtual image. 
Subsequent changes you make to the virtual image do not affect the current physical 
image.

The physical image file names are <volume name>.pxx, where xx stands for the track 
number. These files are always written to the GEAR working directory.

Converting the Image

1. Open the virtual image you want to create a physical image for. 

2. Select ‘Convert to physical’ from the pull down menu in the Recording panel.

3. Click the Write button.

As GEAR creates the physical image, the status is reported in the GEAR informa-
tion window. 

4. If physical files already exist for the image, you are prompted to overwrite them.

GEAR displays a message when the physical image has been created successfully.

Track Type Sector Size

ISO 2048 bytes

CD-ROM XA 2336 bytes

DA 2352 bytes
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Verifying a Virtual Image

When you verify a virtual image, GEAR checks the size, date, and time stamp for each 
file in the track or image. If there are discrepancies, it usually means a file has been 
updated since it was loaded into the image and GEAR prompts you to update the image. 

1. With the image you want to verify open, choose Verify from the Image menu.

2. Update the image by reloading the reported files and directories.

As GEAR verifies the track or image, the status of the verification is reported in the 
GEAR information window.

Note: If you selected ‘Verify after write’ in the Recorder Settings, GEAR automatically verifies 
the written image against the image on hard disk.

Recorder Settings

You can specify the types of settings appropriate for your CD recorder using the 
Settings button in the Recording Panel. There are three types of settings:

o Common

o Advanced

o SCSI

Common Recorder Settings

In the Common Recorder Setup, you can do any of the following:

o Select a recording method: disc-at-once, track-at-once, or incremental, depending 
on your recorder model. 

Incremental lets you write in fixed packet size, which is determined by the 
recorder’s buffer to eliminate or minimize buffer underrun. 

Disc at once means your recorder writes the lead in, then the track data, then the 
lead out. This method is especially suited for Audio recording.

Important: You cannot use disc at once recording to record a multi-session disc.
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Track at once means your recorder first writes the track data, then finalizes the disc 
by writing a lead in and lead out. This method is used in multi-session recording.

o Specify the speed at which you want to record: 1x, 2x, 4x, or 6x, depending on your 
recorder model. 

o Verify the data after writing your image to CD-R.

o Use a physical image file for recording. If the test run fails, you can convert your 
virtual image to a physical image and use it by checking the box. If you did not 
create a physical image, GEAR prompts you to use the virtual image instead.

o Enable the Multi-session option. If you want to be able to append other sessions to 
your CD-R you will have to check this box. 

Important: Not all CD-ROM players support the reading of multi-session discs.

Advanced Recorder Settings

In the CD Recorder Setup dialog for Advanced Recorder Settings you can do any of the 
following:

o Specify the number of writers.

o Choose the Reading Speed of your recorder.

o Enable a software estimate before writing. A software estimate tests the rate at 
which data is transferred to the CD-R. This option is quicker than the Test option 
in the recording panel but it is a software estimate and not as accurate as a test run.

o Disable the fixation of a disc. Until you fixate the disc, you can only read it on a CD 
recorder. You can use this option to record multiple tracks on a CD without 
recording in multiple sessions.
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You can also specify whether to fixate the disc after recording (that is, record the 
lead in or lead out). 

If you do not fixate the disc, you can specify a multi-session recording, that is, 
recording can occur over several different sessions on the same or different 
recorders.

SCSI Settings

In the CD Recorder Setup dialog for SCSI Settings, you can specify the driver and 
buffer settings. 

Note: A special feature of the GEAR windows 95 software is the use of Cyclic buffering during 
the recording. You can change the number of buffers and their size to ensure the flawless 
writing of your CD-R. The phenomena of buffer underrun belongs to the past due to this 
special GEAR feature.
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Changing Recorder Settings

1. Click the Settings button in the Recording panel of Workbench or choose CD 
Recorder Setup (Edit menu).
The CD Recorder Setup dialog appears.

2. Select the recording settings you want to use.

3. Click OK to return to the Workbench.

Testing and writing to CD-R

Now you are ready to write data to your CD. We recommend that you test before you 
write to CD-R. If you want, you can start writing immediately after a successful test. 
GEAR makes things easier for you.

Writing on the fly

GEAR creates the virtual image that is written to CD-R just before actually writing it. 
An interruption in the flow of data to your CD-recorder would cause a write failure and 
the loss of your CD-R. To ensure a steady flow of data GEAR fills buffers with data. As 
GEAR writes data to the CD-R, the GEAR information window provides you with 
information on the percentage of each track written to CD-R and the percentage of data 
remaining in the buffer. See SCSI recording settings for more information.

Testing

Note: Test-mode recording takes the actual time that recording takes even though you are not 
recording a disc.

1. If necessary open the virtual image you want to test. To do this:

o Select Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

Use the Recording 
panel to choose the 
medium to write to 
and to select the 
Recorder Settings.

The status information boxes display information about the virtual 
image you are working with and about the medium you are writing to.

Select Virtual Image in 
the Disc panel to open 
an image for testing 
or writing.
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2. Choose your CD recorder in the recording panel.

3. Click the Test button on the Recording Panel. A GEAR dialog appears where you 
can choose to write the CD-R immediately after a successful test. 

4. Click Yes if you want to write the image after a successful test. If the test fails, 
GEAR displays a warning and does not begin recording.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the volume are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. 
Differences may occur if files are changed after they’re loaded into the virtual 
image. If there are any differences, GEAR warns you and you can reload the files to 
update them. 

Note: To improve system performance, you can either minimize the fragmentation on our 
hard disk with a disk optimization program or you can use the physical image file of the volume. 
See Creating a Physical Volume in Chapter 9 for more information.

Writing to CD-R

When you write to a CD-R disc, GEAR uses either the virtual image or the physical 
image files. When the virtual image is used, the physical image is created and written to 
disc immediately. You can use physical image files if data transfer rates to the recorder 
are not fast enough.

If the Estimate before write check box is turned on in the Advanced Recording Settings 
dialog, GEAR checks your system performance before writing the selected volume to 
CD-R. If the performance is sufficient, GEAR continues to write the disc. If the 
performance is insufficient, writing is aborted.

1. If necessary open the image you want to test. To do this:

o Select Virtual Image in the Disc panel and click the Open button or...

o Click the Open CD project button in the toolbar.

2. Choose your CD recorder from the pull-down menu in the recording panel.

3. Click the Write button in the recording panel. 

If you selected ‘Use Physical image’ in the Recorder Settings GEAR will look 
for the physical image first. If it is not available, GEAR prompts you to use the 
virtual image instead. Do one of the following:
o Click Yes to use the virtual image.

o Click No to cancel the writing.

When writing is complete, the disc is ejected automatically. Your disc is ready for 
reading in any CD-ROM drive!
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Files Created After Writing to CD-R

The CD-R command always creates the following files after you write a CD: 

o wo_ident.txt 

o woresult.txt.

The wo_ident.txt file contains the table of contents (TOC) and some customer 
information that’s written to the CD recorder. The customer information is read from 
the gear.ini file. The woresult.txt file contains status information.

Writing to Disc Description Protocol Premaster Tape

If you are going to mass-duplicate your CD-R, you can write to premaster tape. The tape 
is written in ANSI (X3.27-1987) format. You can send the premaster tape to a 
replication company for mastering and duplication. The tape is used to create a glass 
master, which is used to create daughters. Daughters are used to stamp silver or 
production CDs.

Recommended Tape Drives

GEAR supports most tape units that provide a SCSI interface. The preferred 
configuration is with an EXABYTE tape unit, a Hewlett Packard DAT unit 
(HP35470A), or an M4 9 track.

Files Created After Writing to Tape

The following files are created after a project is written to tape:

o tp_ident.txt

o tpresult.txt

o DDPID

o DDPMS

o PQDESCR

The tp_ident.txt files contains the table of contents (TOC) of the project written to tape 
and some customer information. The DDPID, DDPMS, and PQDESCR files form the 
DDP information of the last project written to tape. You can write these files to tape by 
checking the corresponding boxes in the Common Settings as described below.
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Tape recorder Settings

You can specify the types of settings appropriate for your tape recorder using the 
Settings button in the Recording Panel. There are five types of settings:

o Common

o Customer

o SCSI

o File strategy

o Advanced

For detailed information see the appendix ‘GEAR Initialization/Preferences file’.

Common Settings

In the Common Setup, you can do any of the following:

o Select the identification files you want to write to tape. 

o Verify the data after writing your volume to Tape.

o Select the use of a physical image file for recording. If you did not create a physical 
image before clicking the Write button, GEAR prompts you to use the virtual image 
instead.
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Customer Settings

In the Customer Setup, you can enter the information that is written to the tp_ident.txt 
file. Some premaster companies ask you to supply this information.

SCSI Settings

In the SCSI Settings, you can specify the driver and buffer settings. 

Note: A special feature of the GEAR windows 95 software is the use of Cyclic buffering during 
the recording. You can change the number of buffers and their size.
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File strategy Settings

In the File strategy settings, you specify the method of writing the tracks to tape. 

When you check 
this box…

This happens…

Tracks on separate 
tapes

Each track is written to a separate tape file on a separate 
tape. It’s impossible to write DDP information to tape when 
using this method.

Tracks in separate 
files

Each track is written to a separate tape file. All files are then 
written to one tape.

Same type tracks in 
one file

Tracks of the same type are combined into one tape file. The 
tape files are written to the same tape. This option is useful 
when the volume contains many small audio tracks. Using 
the previous methods would result in a large number of 
filemarks on the tape that could cause problems while mas-
tering.

One contiguous 
image

All tracks are written to one file (contiguous image). Sector 
size, scrambling, blocking factor and gap/pause inclusion 
are set to mandatory values.
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Advanced Settings

In the Advanced Settings you can do any of the following:

o Specify whether the sectors of ISO and XA tracks must be scrambled

o Specify the sector size to be used on tape for ISO, XA and DA tracks.

o Specify whether Gaps and Pauses are included in the files written to tape.

o Choose the tape blocking factor.

Changing Tape Settings

1. Select your tape drive in the recording panel.

2. Click the Settings button in the Recording panel of Workbench. The Tape 
Settings dialog appears.

3. Select the recording settings you want to use.

4. Click OK to return to the Workbench.
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Writing a Volume to Tape

The process for premastering a tape is just like writing to CD. Make sure your 
tape unit is connected to your computer and turned on and that there is a tape in 
the unit before you start GEAR.

1. Open a Virtual image.

2. Select a tape drive in the recording panel

3. Click the Write button. 

4. A dialog prompts you with instructions for preparing the tape unit for recording. 
When the unit is ready, click OK.

Each file’s size and time stamp are compared to the file’s size and time stamp when 
it was loaded. Differences may occur if files are changed after they are loaded into 
the virtual image. If there are any differences, GEAR warns you and you can reload 
the files to update them. 

As GEAR writes data to the tape, it reports in the GEAR Information window the 
percentage written for each track of the volume. When writing is complete, the 
tape is ejected automatically. Your tape is ready to send to a CD-ROM mastering 
plant!

Use the 
Recording panel 
to choose the 
medium to write 
to and to select 

The status information boxes display information about the virtual 
image you are working with and about the tape recorder.

Select Virtual Image in 
the Disc panel to open 
an image for testing 
or writing.
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Chapter 11 Getting Started With GEAR helps you start and learn to use GEAR.

Chapter 12 Creating and Opening Virtual Images helps you create a new volume, create tracks 
on the volume, and open an existing volume and load track contents.

Chapter 13 Creating a CD-ROM XA shows you how to create an external architecture image 
and use manual- and pre-interleaving to record data.

Chapter 14 Creating an Audio CD shows you how to create and record a digital audio CD.

Chapter 15 Working With Virtual Images explains how to edit tracks on a volume that was cre-
ated using an authoring package other than GEAR.

Chapter 16 Working With Multi-Session Discs explains how to append data to a disc.

Chapter 17 Working With External (Foreign Image) Files explains what an external volume is 
and how to edit it, and discusses different formats.

Chapter 18 Log Files, Batch Files, and Commands explains how to create and edit log files, 
and run batch files and commands.

Chapter 19 Testing and Writing a CD Image File shows you how to prepare for writing discs, 
estimate system performance, and write CD-R discs and premaster tapes.

GEAR for Windows 
Introduction
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11Getting Started With 
GEAR for Windows 
and OS/2

This chapter helps you create your first CD in just minutes. You can read about the 
following:

o Starting GEAR

o Loading data

o Choosing CD-R settings

o Writing a CD-R

o Writing a master tape

o Using the online help

Starting GEAR in Windows and OS/2

Before you start GEAR, make sure your recorder is turned on and recognized when 
you boot your system.

o In the GEAR program group, double-click the GEAR icon to start GEAR.

When you start GEAR, the following two windows appear: the working win-
dow and the GEAR Status window. In addition, the New imagefile dialog is 
displayed so you can create a new virtual image file. A virtual image file is a 
file that contains all the information you need to create a CD.

Double-click to start 
GEAR
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The GEAR Toolbar

The toolbar contains the following buttons:

The New imagefile dialog 
lets you create a new virtual 
image file

Working window

The Status window displays information about the CD virtual 
image you’re working with

New CD-Image

Open CD-Image

Append Next Session

Delete CD-Image

Close CD-Image

Disc Info

Read Track

Write CD-R

Write Premaster Tape

Rename File/Directory

Delete File/Directory

File Manager

Long/Short Name

This toolbar button… Lets you do this

New CD-Image Create a new virtual image

Open CD-Image Open an existing image
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Creating a New CD Image File

The New imagefile dialog lets you enter a name and choose a location for a new virtual 
image file. GEAR provides the .vol extension for you automatically.

1. Under File Name, enter a name for the new virtual image file.

2. Choose the directory and drive where you want to save the new image file, then 

Append Next Session Add another session to CD-R

Delete CD-Image Delete an existing image

Close CD-Image Close the current image

Disc Info Get disc information

Read Track Copy the selected track from CD-R

Write to CD-R Burn a disc

Write Premaster Tape Write to tape

Rename File/Directory Rename a selected file or directory

Delete File/Directory Delete a selected file or directory

File Manager Make the File Manager the active win-
dow

Long Name/Short Name Long/short file description

This toolbar button… Lets you do this

Enter a name for the 
CD-ROM virtual image 
file

Choose the directory and drive where 
you want to save the file

Choose the disc size
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click OK.

The Track and Create Track dialogs appear

3. Choose ISO, XA, or Audio for the track format from the Track type drop-down 
menu.

Note: The multi-format version supports all three formats. The standard version supports ISO 
and DA formats only.

The track number is 1 by default.

4. Click Create to create the track.

The Status window shows that track 1 has been created and is selected.

5. In the Track dialog, click Select to open the new track and close the dialog.

A new GEAR virtual image file window opens where you can load files and direc-
tories from the File Manager.

6. Click the File Manager button on the toolbar to display the File Manager win-
dow.

Tip: You may want to resize the File Manager and the GEAR virtual image file window so it suits 
the way you like to work.

Choose a format…

…then, click Create
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7. Load the directories and files you want to write to CD.

An ISO directory or file name is limited to uppercase alphanumeric characters and 
underscores (_). If any of the files you load have invalid characters, GEAR warns 
you. For information about valid ISO-9660 file and directory naming, see Appen-
dix A.

Note: In Windows 95, you can also drag files to the GEAR window from the Navigator window, 
desktop, shortcuts, or the GEAR File Manager window.

8. Do one of the following:

o Click Yes to have GEAR translate the file name to valid characters.

o Click No to load the file as is.

9. After you’ve loaded all the files you want to write to CD, check them by brows-
ing through the file names as you do a directory tree in the File Manager.

o If you’ve loaded files by mistake, select them and press the Delete key to 
remove them from the image file.

Now you’re ready to choose CD-R from the Settings submenu in the Options menu 
and write your image to CD-R disc and/or premaster tape.

In the File Manager, locate 
and select the files you want 
to write to CD, then drag 
them to the working window

You can drag directories and files from the File Manag-
er’s directory window only, not from the tree window. Tree window

Directory window

The Status window displays in-
formation about the files you 
drag to the working window
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Choosing CD-R Settings

Before you write to CD, we recommend you first choose your CD-R settings.

1. Choose CD-R from the Settings drop-down menu in the Options menu to display 
the Recording Setup dialog.

2. If the Recording Enabled check box is turned on, turn it off to run in test mode. 
Test mode will transfer data to the recorder but won’t record on the disc.

This is useful when you want to estimate your system throughput to the recorder to 
prevent wasting the disc if there are data transfer problems.

3. Choose any other options you want to use, then click OK. For additional infor-
mation about recording settings, see CD-R in Chapter 18.

Writing to a CD-R

If you turned on the Estimate before write check box in the Recording Setup dialog 
(CD-R from the Settings submenu in the Options menu), GEAR checks the performance 
of your system before it writes. If it’s sufficient, GEAR continues to write the disc. If 
system performance is insufficient, GEAR displays a warning and doesn’t begin record-
ing.

To improve system performance, you can either minimize the fragmentation on our 
hard disk with a disk optimization program or you can use the physical image file of the 
volume. See Creating a Physical Volume in Chapter 18 for more information.

Now you’re ready to write data to your CD! It’s as simple as the click of a button.

o Click the CD-R button on the toolbar or choose CD-R from the Write menu.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the volume are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. Differ-
ences may occur if files are changed after they’re loaded into the virtual image. If 
there are any differences, GEAR warns you and you can reload the files to update 
them. 

As GEAR writes data to the CD, it reports in the Status window the percentage writ-
ten for each track of the volume. When writing is complete, the disc is ejected auto-
matically. Your disc is ready for reading in any CD-ROM drive!
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Premastering a Tape

As an alternative to writing to a CD, you can premaster a tape, then send it to a CD-
ROM mastering plant where the data is written to CD. The tape, which is written in 
DDP format, is accepted as a standard at mastering plants. This tape is used to create a 
glass master, which is used to create daughters. Daughters are used to stamp silver or 
production CDs.

If you turned on the Verify before write check box in the Recording Settings dialog 
(CD-R in the Setting submenu of the Options menu), GEAR compares the contents of 
the tape with the actual volume. This means that the tape is read back and its data is 
checked against the contents of your virtual image. If there are differences, GEAR 
warns you.

The process for premastering a tape is just like writing to CD. Make sure your tape unit 
is connected to your computer and turned on and that there’s a tape in the unit before 
you start GEAR.

o Click the Tape button on the toolbar or choose Premaster Tape from the Write 
menu.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the volume are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. Differ-
ences may occur if files are changed after they’re loaded into the virtual image. If 
there are any differences, GEAR warns you and you can reload the files to update 
them. 

As GEAR writes data to the tape, it reports in the Status window the percentage 
written for each track of the volume. When writing is complete, the tape is ejected 
automatically. Your tape is ready to send to a CD-ROM mastering plant!

Using the Online Help

Online help is available at any time if you don’t understand how to use the software. To 
access help, do any of the following:

o Press Shift+F1 or choose Index from the Help menu to display the help Index.

o Choose Using Help from the Help menu for information about using an online help 
system.

o Choose About GEAR from the Help menu to display version and registration infor-
mation about your copy of GEAR.
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12Creating a Virtual Image 
(Win & OS/2)

This chapter teaches you how to create and open virtual images. You can read 
about the following:

o Creating a new virtual image

o Creating tracks on a new virtual image

o Opening an existing image

o Loading track contents

For information about editing tracks and track contents, volume settings and 
descriptors, see Chapter 15. For information about creating Audio CDs and XA 
CDs, see Chapters 13 and 14, respectively. For information about external files, see 
Chapter 18.

About Creating a New Virtual Image File

A virtual image is the minimal amount of information needed to create a CD. The 
opposite of the virtual image is a physical image, which is the entire CD stored on 
a hard drive before it’s recorded.

Before you begin to create a new virtual image file, you should review the follow-
ing information about virtual image and its capacities.

When you create a new virtual image, the file is called a volume administration file. 
You must have more than 25MB of free disk space available to create a volume 
administration file. 
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Three administration files are created for each new track you create in the 
current working directory. The files are named using the first eight char-
acters of the image name plus the following extensions (xx represents the 
track number):

o .mxx

o .ixx

o .fxx

You should never edit or delete these files manually; this results in a cor-
rupt and useless image. Administration files are deleted automatically 
when you delete the associated image.

Track Types in GEAR

You can choose three track types in GEAR:

o ISO is a CD-ROM track type with extra error-checking capabilities. 
This is referred to as Mode 1 format. This format is suited for record-
ing computer data and always consist of one track. ISO is suited for 
CD-ROM formats.

o XA is a track type for CD-ROM XA and CD-I. This format is used for 
multi-media applications and always consists of one track. XA is 
suited for the following formats: CD-ROM XA, CD-I, EB, MMCD, 
Photo CD, and VideoCD.

o DA is a track type for digital audio. This format allows up to 99 
tracks. If audio tracks are combined on a disc with an ISO or XA 
track, up to 98 tracks can be used. DA is suited for CD Digital Audio 
(Red Book).

Calculating Virtual Image Capacities

You can use the following formula to calculate the capacity of a virtual 
image:

virtual image capacity = sector data capacity (bytes) x length (minutes) x 60 (seconds) x 75 (number of sec-
tors)
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The following table shows the sector data capacities for each track type:

The following table shows the virtual image data capacity for each disc 
size and track type:

As you create tracks on your new image, keep in mind these points:

o The track number is assigned automatically and is relevant only for 
CD Audio. With the exception of CD Enhanced and CD Plus, ISO 
and XA tracks are always assigned to track number 1.

o A virtual image can have only one ISO or XA track; it may not have 
both types of tracks.

o A virtual image can contain up to 99 tracks.

o It is impossible to assign CD Audio to track number 1 if you create 
either an ISO or XA track on the virtual image .

o When you create a new track, it’s automatically assigned the maxi-
mum available space on the virtual image.

Track Type Sector Data Capacity

ISO 2048 bytes

XA and CD-I 2336 bytes

CD Audio (DA) 2352 bytes

Virtual Image Data Capacity

Disc Size ISO XA and CD-I CD Audio

18 min. 158 MB 180MB 181MB

63 min. 553MB 631MB 653MB

74 min. 650MB 741MB 746MB

80 min. 703MB 802MB 807MB



Elektroson GEAR

116 n Creating a Virtual Image (Win & OS/2)

Creating an Image With Tracks

The process to create a new image is very much like creating your first 
virtual image in Chapter 11.

1. Click the New button on the toolbar or choose New CD-Image 
from the File menu to display the New imagefile dialog.

2. Under File Name, enter a valid ISO name for the file.

A valid name may consist of up to eight alphanumeric characters and 
underscores (_). For information about valid ISO-9660 names, see 
Appendix A.

3. Choose the drive and directory where you want to save the file.

4. From the Max Disc Size drop-down list, choose the length of the 
image.

You may choose 80, 74, 63, or 18 minutes.

5. Click OK to close the dialog and create the new image.

Enter a name for the new vir-
tual image file; the .vol exten-
sion is provided automatically

Choose a location for the new 
virtual image file

Choose the CD-R 
size from this drop-
down list
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The Track and Create track dialogs appear.

6. From the Track type drop-down list, choose ISO, XA, or Audio for 
the format of track you’re creating.

7. Click Create to close the dialog.

The new track appears in the Track dialog.

8. Click Create to create another track, then repeat steps 6 and 7.

The number 1 is assigned auto-
matically to the first track you 
create

Choose the type of track 
you want to create: ISO, XA 
or DA

Click here to create a 
new track

The new track appears in 
this dialog

Click the Create button to 
create more new tracks
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9. When you’ve created all the tracks you need, select the track you want to load 
data for and click Select in the Track dialog.

The track dialog is closed and you’re ready to begin loading data in the image win-
dow.

The status window displays the activity you’ve performed.

Selecting an Audio Track

When you create digital audio (DA) tracks, you need hard disk files that represent 
audio. The files must always fulfill the following requirements, which are specified in 
the Red Book:

…then click the Select button to select the track

Click the track you want to load data for…

The new virtual Image file and each track is reported as you create and 
select them
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o The sample frequency must be 44.1KHz

o Audio must be stereo (one sample for the left channel and one sample for the right 
channel) sampled on 44.1kHz

o Each sample must contain 16 bits

o The byte order must be the same as the byte order used by your computer; if it isn’t, 
you can use the generic option MSBAudio (in gear.ini) to make GEAR swap the 
audio bytes for all tracks

With LSB audio default, if MSBAudio=True, each track will be swapped by GEAR. 
Audio files should not contain sound headers. If sound headers are not removed or 
cleared, they will cause a sharp click in the resulting audio track on the CD.

Depending on the audio package you’re using, the audio file may or may not contain a 
sound header. You can use the Read Track command in the Tools menu to copy a digital 
audio track from CD to a file on hard disk. This command operates on the Philips 
CDD522 and the Yamaha CDR100. The Read Track command creates no header so 
you can use the resulting file directly.

Warning! The Philips CDD522 reads audio in MSB format while the Yamaha CDR100 reads 
audio in LSB format. The current version of GEAR supports the following Red Book audio files: 
WAV and AIFF. All files should fulfill the above requirements. For WAV and AIFF files, the head-
er is removed automatically. AIFF files are usually in MSB format.

For detailed information about creating Audio CDs, see Chapter 14.

CD-ROM XA

Use this command to specify multimedia files on a CD-ROM XA track. You must first 
select a CD-ROM XA track.

There are two types of interleaving in GEAR:

o Manual

o Pre Interleaved

Manual Interleave

This command lets you specify all the options to create your own interleaved files. You 
can find more information about the use of these parameters for CD-ROM XA appli-
cations in the CD-ROM XA specification.

In general, it’s easier to use the dedicated CD-ROM XA interleaving tools, such as the 
Mammoth Tool Set, and the GEAR Pre-Interleaved command to create these files.
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Pre-Interleaved

If you use this command, GEAR assumes that the specified files are pre-interleaved CD-
ROM XA files, which are sometimes referred to as XA streams.

Important: Make sure the files you are loading with this command are indeed pre-interleaved 
files. Non-pre-interleaved files you load this way are useless on the resulting CD-R disc. A pre-
interleaved file must have a 2336 byte sector size with a subheader field filled in. This sub-
header field is copied, together with the other information, to the GEAR administration file. 
Normally the subheader is not included in a file and the subheader information is 
generated by GEAR.

For detailed information about creating CD-ROM XA images, see Chapter 13.

Creating the Track Contents

You can load the track contents—data—for a virtual image by selecting files in the File 
Manager and dragging them to the GEAR working window. It’s that easy!

When you load files for a track, keep in mind the following points:

o You can load only files for Digital Audio (DA) tracks—you can’t load directories.

o For data tracks only, the NonISONameHandling option in the Generator Setup dia-
log (Generation in the Settings submenu of the Options menu) determines how and 
when non-ISO file and directory names are translated.

Loading Files for a Track

1. If the virtual image containing the track you want to load data for isn’t open, 
click the Open button on the toolbar to display the Open imagefile dialog or 
choose Open CD-Image from the File menu.

2. Locate and select the virtual image you want to open, then click OK.

Locate and select the vir-
tual volume you want to 
open
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3. If it isn’t displayed, click the File Manager button on the toolbar to 
open the File Manager.

Tip: You may want to resize the GEAR and File Manager windows so they suit 
the way you like to work.

4. In the File Manager, locate and select the files you want to load, 
then drag them to the working window.

The name of the virtual image 
you open is displayed in the Sta-
tus window; Track 1 is selected 
by default
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Note: In Windows 95, you can also drag files to the GEAR window from the Navigator window, 
desktop, shortcuts, or the GEAR File Manager window.

5. Continue to select and load files for the track.

6. To load files for a different track, choose Tracks from the Edit menu.

7. In the Tracks dialog, click the track you want to load files for, then click the 
Select button, or click Create to create a new track.

8. Repeat steps 3–7 until you’ve loaded all the files you want for each track.

In the File Manager, locate and 
select the files you want to load, 
then drag them to the GEAR 
working window…

…the files are displayed in the GEAR window
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13
Creating a CD-ROM XA 
(Win & OS/2)

This chapter provides information about how to create a CD-ROM XA image. You 
can read about the following:

o Creating a new CD-ROM XA

o Creating tracks on a new CD-ROM XA

o Opening an existing CD-ROM XA

o Loading track contents

For general information about creating new images, see Chapter 12. For informa-
tion about editing tracks and track contents, volume settings and descriptors, see 
Chapter 15. For information about Audio CD, see Chapter 14.

About Creating a New CD-ROM XA Image

XA (eXtended Architecture) is a track type for CD-ROM XA and 
CD-I. This format is used for multi-media applications and consists of one track 
only. XA is suited for the following formats: CD-ROM XA, CD-I, EB, MMCD, 
Photo CD, and VideoCD.

Creating an XA Image

The process to create a new XA image is similar to creating your first virtual image 
in Chapter 11.
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1. Click the New button on the toolbar or choose New CD-Image from the File 
menu to display the New imagefile dialog.

2. Under File Name, enter a valid ISO name for the file.

A valid name may consist of up to eight alphanumeric characters and underscores 
(_). For information about valid ISO-9660 names, see Appendix A.

3. Choose the drive and directory where you want to save the image.

4. From the Max Disc Size drop-down list, choose the length of the CD-R.

You may choose 80, 74, 63, or 18 minutes.

5. Click OK to close the dialog and create the new XA image.

The Track and Create track dialogs appear.

6. From the Track type drop-down list, choose XA for the format of track you’re 
creating.

7. Click Create to close the dialog.

Enter a name for the new XA 
image; the .vol extension is 
provided automatically

Choose a location for the new 
XA image

Choose the CD-R size from 
this drop-down list

The number 1 is assigned automatically 
to the first track you create

Choose XA from this 
drop-down list

Click here to 
create a new 
track
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The new track appears in the Track dialog.

8. Click Select to select the new track and close the Tracks dialog.

The status window displays the new image and the track you’ve created.

Creating the Track Contents

You can load files for the selected XA track by selecting the files in the File Manager 
and dragging them to the GEAR image window.

When you create an XA image, you must use interleaved files or allow GEAR to inter-
leave files for you. This is useful when you have two or more different CD track types, 
such as audio or video, that must flow together in synchronization. These files must be 
interleaved with each other to optimize playback.

For example, with a mixed mode disc, the laser-reading head has to jump back and forth 
between widely separated tracks to play back audio and video data. This slows down the 
application significantly. 

When you use interleaving, the laser-reading head can pick up video, then move 
smoothly to the next amount of audio and so on, providing real-time playback. 

The new track appears in 
this dialog

Click the Select button 
to select the new track 
and close the dialog
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There are two types of XA interleaving in GEAR:

o Manual Interleaving

o Pre Interleaved

Manual Interleave

This command lets you specify all the options to create your own interleaved files. You 
can find more information about the use of these parameters for CD-ROM XA appli-
cations in the CD-ROM XA specification.

In general, it’s easier to use the dedicated CD-ROM XA interleaving tools, such as the 
Mammoth Tool Set, and the GEAR Pre-Interleaved command to create these files.

1. Choose Manual Interleave from the CD-ROM XA submenu of the Options 
menu.

2. In the dialog that appears, choose a data type to specify the type of each file 
loaded.

o ADPCMBSN is valid for ADPCM audio, level B stereo, no emphasis.

o ADPCMCME is value for level C Mono with emphasis.

o VIDEO2048 is used if each sector contains video data and EDC/ECC codes.

o VIDEO2324 is used is each sector contains video data.

Choose a data type for the 
type of file you’re loading

Enter from 1–32 for a channel 
number for each file

Enter from 1–16 for the inter-
leave factor for each file

Enter from 1–16 for the total inter-
leave factor for each file

Turn on this check box if you want to set the 
end of record bit in the subheader of the las 
sector of each file you load

Turn on this check box if you 
want to set the trigger bit in 
the subheader of the last 
sector of each file you load
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o Other valid choices include: ADPCMBSE; ADPCMBMN; ADPCMBME; 
ADPCMCSN; ADPCMCSE; ADPCMCMN; ADPCMCME; AND 
DATA2048.

3. Choose a channel number from 1to 32 for each file you want to load. 

4. Choose an interleave data factor from 1 to 16 for each file you want to load. 

5. Choose the total interleave factor from 1 to 16 for each file you want to load.

This number, together with the interleave data factor in step 4, determines the inter-
leaving of each file.

Valid combinations for interleave data factor and total factor are: 1–4, 1–16, 1–8, 
2–4, and so on.

The combination 2–4 means that for each set of four sectors, the first two are occu-
pied by the file. 

ADPCM B stereo files are interleaved 1–4, while ADPCM C stereo files are inter-
leaved 1–8.

6. If you want the trigger or end of record bit set in the subheader of the last sector 
of each file, turn on the Trigger and EOR check boxes.

You can specify one or both options. 

Pre-Interleaved

If you use this command, GEAR assumes that the specified files are pre-interleaved CD-
ROM XA files, which are sometimes referred to as XA streams.

Important: Make sure the files you are loading with this command are indeed pre-interleaved 
files. Non-pre-interleaved files you load this way are useless on the resulting CD-R disc. A pre-
interleaved file must have a 2336 byte sector size with a subheader field filled in. This sub-
header field is copied, together with the other information, to the GEAR administration file. 
Normally the subheader is not included in a file and the subheader information is generated 
by GEAR.

o Choose Pre-Interleaved from the CD-ROM XA submenu of the Options menu.

Loading Track Contents

1. If the XA image isn’t open, click the Open button on the toolbar to display the 
Open imagefile dialog or choose Open CD-Image from the File menu.
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2. Locate and select the XA image you want to open, then click OK.

3. If it isn’t displayed, click the File Manager button on the toolbar to open the File 
Manager.

Tip: You may want to resize the GEAR and File Manager windows so they suit the way you like 
to work.

4. In the File Manager, locate and select the files you want to load, then drag them 
to the image window.I

Locate and select the 
XA image you want to 
open

The name of the CD image 
you open is displayed in the 
Status window; Track 1 is 
selected by default
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Note: n Windows 95, you can also drag files to the GEAR window from the Navigator window, 
desktop, shortcuts, or the GEAR File Manager window.

Recording Tracks
1. If the XA image you want to record isn’t open, click the Open button on the tool-

bar to open the XA image you want to record.

2. Click the Write CD-R button on the toolbar.

In the File Manager, locate 
and select the files you want 
to load, then drag them to 
the GEAR image window…

…the files are displayed in the GEAR 
window
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14Creating an Audio CD 
(Win & OS/2)

This chapter teaches you how to create and open an audio CD image. You can read 
about the following:

o Creating a new audio image

o Creating tracks on a new audio image

o Opening an existing audio image

o Loading track contents

For general information about creating virtual CD images, see Chapter 12. For 
information about editing tracks and track contents, volume settings and descrip-
tors, see Chapter 15. For information about CD-ROM XA images, see Chapter 13.

About Creating a New Audio CD

DA (Digital Audio) is a track type for audio CDs. This format allows you to create 
up to 99 tracks. If audio tracks are combined on a disc with an ISO or XA track, you 
can create up to 98 tracks. DA is suited for CD Digital Audio.

:GEAR supports Red Book audio file formats, as well as the following formats:

o .wav

o AIFF

o Sound Designer II

For .wav, AIFF, and Sound Designer II files, GEAR removes the header automat-
ically. AIFF files are usually in MSB format.
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When you create DA tracks, you need hard disk files that represent audio.
The files must always fulfill the following requirements, which are specified in the Red 
Book

o The sample frequency must be 44.1kHz

o Audio must be stereo (one sample for the left channel and one sample for the right 
channel) sampled on 44.1kHz

o Each sample must contain 16 bits

o The byte order must be the same as the byte order used by your computer; if it isn’t, 
you can use the generic option MSBAudio (in gear.ini) to make GEAR swap the 
audio bytes for all tracks

For example, LSB audio is the default on DOS and Windows. If you want GEAR to 
swap byte order, set MSBAudio=True in the gear.ini file.

Warning! The Philips CDD522 reads audio in MSB format while the Yamaha CDR100 reads 
audio in LSB format.

Depending on the audio package you’re using, the audio file may or may not contain a 
sound header, however, audio files should not contain sound headers. If sound headers 
are not removed or cleared, they will cause a sharp click in the resulting audio track on 
the CD.

You can use the Read Track command in the Tools menu to copy a digital audio track 
from CD to a file on hard disk. This command operates on the Philips CDD522 and the 
Yamaha CDR100. The Read Track command creates no header so you can use the 
resulting file directly.

Creating an Audio Image With Tracks

The process to create a new audio CD is similar to creating your first virtual image in 
Chapter 11.

1. Click the New button on the toolbar or choose New CD-Image from the File 
menu to display the New imagefile dialog.
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2. Under File Name, enter a valid ISO name for the file.

A valid name may consist of up to eight alphanumeric characters and underscores 
(_). For information about valid ISO-9660 names, see Appendix A.

3. Choose the drive and directory where you want to save the file.

4. From the Max Disc Size drop-down list, choose the length of the audio CD.

You may choose 80, 74, 63, or 18 minutes.

5. Click OK to close the dialog and create the new audio CD image.

The Track and Create track dialogs appear.

6. From the Track type drop-down list, choose DA for the format of track you’re 
creating.

7. Click Create to close the dialog.

The new track appears in the Track dialog.

Enter a name for the new 
audio CD image; the .vol 
extension is provided auto-
matically

Choose a location for the new audio CD image

Choose the CD-R size from this 
drop-down list

Choose DA from this 
drop-down list

Click here to create 
a new track



Elektroson GEAR

134 n Creating an Audio CD (Win & OS/2)

8. Click Create to create another track, then repeat steps 6 and 7.

9. When you’ve created all the tracks you need, select the track you want to load 
data for and click Select in the Track dialog.

The track dialog is closed and you’re ready to begin loading audio files for each 
track in the image window.

The status window displays the tracks you’ve created.

The new track appears in 
this dialog

Click the Create button 
to create more new 
tracks

…then click the Select button to select the track

Click the track you want to load data for…

The new audio CD and each track is reported 
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Creating the Track Contents

You can load one audio file for a selected track on an audio CD by selecting the audio 
file in the File Manager and dragging it to the GEAR image window. It’s that easy!

When you load files for a track, keep in mind the following points:

o You can load only one file per track; you can’t load directories

Loading a File for a Track

1. Click the Open button on the toolbar to display the Open imagefile dialog or 
choose Open CD-Image from the File menu.

2. Locate and select the audio CD image you want to open, then click OK.

3. If it isn’t displayed, click the File Manager button on the toolbar to open the File 
Manager.

Tip: You may want to resize the GEAR and File Manager windows so they suit the way you like 
to work.

Locate and select the 
virtual volume you 
want to open

The name of the CD image 
you open is displayed in the 
Status window; Track 1 is 
selected by default
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4. In the File Manager, locate and select the file you want to load, then drag it to the 
image window.

Note: In Windows 95, you can also drag files to the GEAR window from the Navigator window, 
desktop, shortcuts, or the GEAR File Manager window.

5. To load a file for another track on the audio CD, choose Tracks from the Edit 
menu.

6. In the Tracks dialog, click the track you want to load a file for, then click the 
Select button.

7. Repeat steps 4–6 until you’ve loaded all the audio files for the CD.

In the File Manager, locate and 
select the file you want to load, 
then drag it to the GEAR image 
window…

…the file is displayed in the GEAR 
window

…then click Select 
to select the track

Click a track to 
highlight it…



Elektroson GEAR

Creating an Audio CD (Win & OS/2) n 137

Writing Audio Tracks in Separate Recordings

Audio CDs should be single-session discs because CD players are single-session read-
ers. You can’t finalize an audio CD until you’ve loaded all the audio files for all the 
tracks. If your hard disk isn’t large enough to hold all the audio files or you haven’t pre-
pared all your audio files for recording, you can load files over several recordings with-
out making the disc multi-session.

Changing Recorder Settings
1. Choose CD-R from the Settings submenu of the Options menu to display the 

Recorder Setup dialog.

2. Turn on the Recording enabled check box.

3. Turn off the Disc fixation check box so the disc won’t be fixated. This will let 
you add other audio files when they’re ready for recording.

4. Turn off the Multi-session enabled check box.

5. Click OK to close the dialog.

Recording Tracks

1. Choose Tracks from the Edit menu.

2. Select the track you want to record, then click the Select button.

3. If you haven’t loaded the audio file you want to record for the track, drag it from 
the File Manager to the image window.

4. Click the Write CD-R button on the toolbar.

Turn off the Multi-
session enabled 
check box

Turn off the Disc fixation 
enabled check box so 
you can later add other 
audio files

Turn on the Recording 
Enabled check box
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Note: Since you turned off the Disc fixation check box in the Recorder Settings dialog, the disc 
can’t be read by any CD-ROM drive.

5. When you’re ready to finish recording tracks, choose CD-R from the Settings 
submenu in the Options menu.

6. Turn on the Disc fixation check box.

This will write the Lead-In and Lead-Out areas required for your disc to be read-
able.

7. Click OK.

8. Repeat steps 1–4 to record the remaining tracks on your audio CD.

Reading an Audio Track

GEAR lets you extract tracks from an Audio CD and store them on your hard disk for 
recording on a CD-R. Check in chapter 2 if your recorder supports audio extraction.

1. Insert the audio CD you want to read in your CD recorder.

2. Click the Read Track button on the toolbar to display the Read Track dialog.

3. In the dialog that appears, select the track you want to read.

At the top of the dialog, GEAR displays a name to indicate a default file name for 
audio track on your hard disk.

4. To change the default file name, select the name and enter a new name.

5. Click OK to read the track and close the dialog.

6. Repeat steps1–5 to read additional CD tracks.
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15Working With Virtual 
Images (Win & OS/2)

This chapter provides information about working with virtual images that already 
contain data. In this chapter, you can read about the following:

o Editing tracks in a virtual image

o Editing virtual images

For information about creating a virtual image and tracks and loading their con-
tents, see Chapter 12. For information about working with foreign image files, see 
Chapter 17.

Working With an Existing Virtual Image

An existing virtual image can be one of the following:

o A GEAR image file

o A foreign image file

You can edit and write to GEAR virtual images, however, you can only write a for-
eign image file to a CD-R disc or tape. For information about writing to GEAR vol-
umes, see Chapter 19.

Opening an Existing Image for Editing

When you open an image, GEAR first closes any image that’s already open. GEAR 
then opens the selected image and expands it to the size of the maximum free space 
available within the virtual image. 
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This space depends on the following:

o The maximum disc size you specified when you created the virtual image

o The amount of memory required by the other tracks within the same image

Warning! You can edit volumes with a .vtl extension only in GEAR3.01 or earlier.

1. Click the Open button on the toolbar or choose Open CD-Image from the File 
menu to display the Open imagefile dialog.

2. Choose External image files from the List Files of Type drop--down list.

3. Locate and double-click the image you want to open.

GEAR displays the volume information in the Status window.

Selecting a Track

1. Choose Tracks from the Edit menu to display the Track dialog.

2. Click the track you want to select, then click the Select button.

Now you’re ready to edit the track!

Click the track you want to select…

…then click Select
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Editing a Track

You can edit a selected track in the following ways:

o Create a new directory on the track

o Rename a file or directory on the track

o Delete selected files and directories from the track

Tip: To increase CD-ROM access time, limit the number of entries in a directory to 50.

Note: DOS recognizes file names of up to eight characters; file names can have a three-char-
acter extension. Other systems are not limited to this restriction.

Creating a New Directory on a Track

1. Choose Create from the Files/Directories submenu in the Edit menu.

2. In the dialog that appears, enter a valid ISO name for the new directory.

A valid name may consist of up to 30 uppercase, alphanumeric characters and 
underscores (_). (DOS can handle only up to eight characters.) For information 
about valid ISO-9660 file and directory naming, see Appendix A.

If you enter an non-ISO name, GEAR prompts you to translate the name.

3. Do one of the following:

o Click Yes to have GEAR translate the file name to valid characters.

o Click No to load the file anyway.

4. Click OK. 

The new directory appears in the working window.

The new directory 
appears at the top 
of the window
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Loading Hidden Files

1. Choose Generation from the Settings submenu in the Options menu to display 
the Generation dialog.

2. Turn on the Load Hidden files check box then click OK.

Hidden files will be loaded until you turn off the check box.

Selecting and Deselecting Files and Directories

You can select one file or directory or you can select multiple files and directories to 
rename or delete. When you use the Select and Deselect commands in the Files/Direc-
tories submenu of the Edit menu, you can enter standard DOS wildcard characters such 
as *.txt for all text files. 

Turn on this check box 
to load hidden files

To do this… Do this…

Select one file or 
directory

Click the file or directory to highlight it

Select multiple 
files and directories

Click the first file or directory, then 
Shift+click subsequent consecutive files or 
directories

Choose Select from the Files/Directories 
submenu in the Edit menu, enter selection 
criteria, then click OK

Deselect selected 
files or directories

Choose Deselect from the Files/Directories 
submenu in the Edit menu, enter a selection 
specification, then click OK
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Renaming Files and Directories

1. Select the files and directories you want to rename.

2. Click the Rename Files/Directories button on the toolbar or choose 
Rename from the Files/Directories submenu of the Edit menu.

3. In the dialog that appears, enter a new name for the specified file or 
directory, then click OK.

4. Repeat step 3 for each selected file or directory if you selected more 
than one in step 1.

Deleting Files and Directories

1. Select the files and directories you want to delete.

2. Click the Delete File/Directory button on the toolbar or choose 
Delete from the Files/Directories submenu in the Edit menu.

3. In the dialog that appears, confirm the deletion of the selected file.

If you selected multiple files and directories in step 1, GEAR contin-
ues to prompt you until you have confirmed or cancelled the deletion 
of all selected files.

Editing Volume Settings

You can edit volume settings for the currently-selected volume. The 
default values are specified in the gear.ini file and can be changed using 
the Generator command in the Settings menu. For detailed information 
about the gear.ini file settings, see Appendix C.

1. Choose Volume Settings from the Edit menu to display the Volume 
Settings dialog.
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2. Choose the settings you want to use, then click OK.

Editing a Volume Descriptor

You can edit the volume descriptor for the currently-selected volume. The default val-
ues are specified in the gear.ini file and can be changed using the Generator command 
in the Settings menu. For detailed information about the gear.ini file settings, see 
Appendix C.

1. Choose Volume Descriptor from the Edit menu to display the Volume Settings 
dialog.

2. Enter the information you want to save, then click OK.

o To reset the information to GEAR’s default values, click the Default button.

You can’t change the maximum 
number of directories for the 
selected volume

This lets you hide the directory in 
the GEAR window

When this is turned on, GEAR loads 
into the image files that have the DOS 
archive bit set, then…

Max Dir nesting level lets you specify 
up to 12 levels of nested directories 
you can have on the CD

This lets you specify how 
invalid ISO names will be 
handled for the volume

…when this is turned on, GEAR resets the 
DOS archive bit after the file is 
successfully loaded

Enter in these fields the 
information you want to save 
about the volume

Click here to reset the values you changed to 
GEAR’s default settings
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16
Working With Multi-Session 
Discs (Win & OS/2)

GEAR lets you append a new session to any session that already exists on a multi-
session disc. This chapter discusses adding additional data to a disc.

For information about creating a volume and tracks and loading their contents, see 
Chapter 12.

Appending a Multi-Session Disc

By appending a multi-session disc, you can do the following:

o Add additional data to the disc

o Recover data from older sessions

o Skip the last session if there are read errors

o Create CD Enhanced or CD Plus discs

One of the sessions on the disc you want to append is used as the basis of a new vir-
tual image. The content of the virtual image is edited. Finally, the virtual image is 
written to the CD-R disc.
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In order to append a multi-session CD-R, your recorder must be turned on and a disc 
must be inserted in the CD drive.

1. Choose Append Next Session from the file menu to display the Append Next 
Session dialog.

2. Select the session/track number you want to attach the next session to.

o If the session/track you select is an audio track, select ISO or XA for the data 
format for the next session and enter a name in the space provided.

The selected session/track on the CD-R disc is read and the virtual image is created. 
The virtual image contains the same directory/file structure as the session and is 
displayed in the image window.

If an image with the same name already exists on your hard drive, GEAR prompts 
you to overwrite the existing image or choose a different directory for the new 
image.

3. Do either of the following:

o To add files to the new image, drag them from the File Manager. Files you 
add are a different color form the existing files on the new image.

o To remove files from the new image, select them and press Delete.

You can append the new session to the CD-R using the Write menu commands. Only 
changes will be written to the CD-R disc. Every time you write a new session, an addi-
tional 15MB is added to the CD-R disc. This is known as overhead.

Choose the track you want to 
attach the next session to

If you choose an audio track, 
select ISO or XA for the data 
format for the next session 
and… 

…enter a name here
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17
Working With 
Foreign Image Files 
(Win & OS/2)

This chapter provides information about working with virtual images that were 
created using authoring or formatting package other than GEAR. In this chapter, 
you can read about the following:

o Opening an external image

o Choosing a predefined format

For information about virtual images you create in GEAR, see Chapters 12, 13, 14 
and 15.

External Images

An external image refers to any image you’ve created using another authoring or 
formatting package, such as CD-I, 3DO, or VideoCD. You can’t edit an external 
volume in GEAR, however, you can use GEAR to write an external volume to a CD-
R disc or a premaster tape. Before you write an external volume, you must select it 
and define its parameters.

1. Click the Open button on the toolbar to display the Open imagefile dialog.
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2. Choose External image files from the List Files of Type drop-down list.

3. Locate and select the external volume you want to open, then click OK.

The External Volume Parameters dialog appears.

4. Do one of the following to choose a format:

o Click the Default button to choose the default format.

o Choose a predefined format from the Image Type drop-down list. For infor-
mation about predefined formats, see the table under Choosing Predefined 
Formats, in the next section

o Choose User-defined image type from the Image Type drop-down list, then 
enter the values you want to use at the bottom of the dialog.

5. Click OK, when you’re finished.

Choose External image 
files here

Choose the drive and directory where 
the external files are located

…click here to choose the default format

Choose a predefined or user-
defined format from this 
drop-down list or…

Enter the values you want to use for 
a user-defined image type using 
these options
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Choosing Predefined Formats

You can choose any of the following predefined formats.

Type # Image Type Format External Volume Type

1 CD-ROM mode 1 (ISO 
etc.), sector size 2048

Standard ISO, HFS, or CDTV 
image

2 CD-ROM mode 1 (ISO 
etc.), sector size 2352

Standard ISO with EDC/ECC 
codes

3 CD-ROM mode 1 (ISO 
etc.), sector size 2352, 
scrambled sectors with 2 
seconds pre-gap

ISO with EDC/ECC codes, pre-
gap and scrambled

4 CD-ROM XA mode 2, 
sector size 2336

Standard XA or EB XA (e.g., 
images with Mammoth XA 
streams)

5 CD-ROM XA mode 2, 
sector size 2352

Standard XA with EDC/ECC 
codes

6 CD-ROM XA mode 2, 
sector size 2352, scram-
bled sectors with 2 seconds 
pre-gap

XA with EDC/ECC codes, pre-gap 
and scrambled

7 CD-I mode 2, sector size 
2336

Standard CD-I without EDC/ECC 
codes

8 CD-I mode 2, sector size 
2352

Standard CD-I with EDC/ECC 
codes

9 CD-I mode 2, sector size 
2352 with 2 seconds pre-
gap

Standard CD-I with pre-gap, EDC/
ECC

10 CD-I mode 2, sector size 
2352, scramble sectors 
with 2 seconds pre-gap

CD-I with EDC/ECC codes, pre-
gap and scrambled; uses the same 
output format as that of most CD-I 
authoring tools

11 Standard CD digital audio Red Book audio (44.1kHz, 16 bit, 
stereo)
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Keep in mind the following points about image types:

o The size of the pre-gap should always be two seconds (150 sectors). Scrambled 
images must contain sync, header, and EDC/ECC code information.

o Unscrambled images can be accepted with a 2352 sector size without the sync, 
header, and EDC/ECC filled in.

o The byte order of audio files must be the same byte order used by the computer run-
ning the GEAR software. If this is not the case, you can use the generic option 
MSBAudio= in the gear.ini file to make GEAR swap the audio bytes for all tracks.

With LSB audio default, if MSBAudio=True, each track will be swapped by 
GEAR. Audio files should not contain any sound header. If sound headers are not 
removed or cleared, they will cause a sharp click in the resulting audio track on the 
CD. Audio files should contain only 16-bit samples and must be stereo (one sample 
for the left channel and one sample for the right channel) sampled on 44.1kHz.

o The external image files option lets you select one file only. If the external volume 
consists of more than one file, you can choose Track list files (*.tlf) under List Files 
of Type in the Open imagefile dialog to specify more than one external file.

The track list file contains one or more lines where each line specifies a 
track of the CD-ROM (you can use a full path). For example, to write a 
mixed-mode image—one that contains mode 1 or mode 2 data—you can 
specify the following lines in a track list file:

Tip: Be sure to leave a space between the track name/path and the image type.

track path name image type number

image.dat/1

audio.2/11

audio.3/11
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18Log Files, Batch Files and 
Commands (Win & OS/2)

This chapter provides you with information about creating and using batch files. 
You can read about the following:

o Creating and editing a log file

o Running a GEAR batch file

o Running a command

Creating and Editing a Log 

GEAR’s batch utility lets you run multiple GEAR commands automatically—with-
out ongoing interaction from you. The easiest way to create a batch file is to use the 
Generate Log command in the File menu to create the image once. This is partic-
ularly useful for incremental backups or if you have to create the same image peri-
odically with updated files, a CD that’s updated quarterly, for example.

As you create the image, the commands you use are saved in a log file. You can use 
this log file as a batch file without any editing. You can also read the log file to 
check the image generation process.

Generating a Log File

1. Choose Generate Log from the File menu to display the Name of logfile dia-
log.
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2. Enter a name for the log file or choose one under File Name.

3. Choose a location to save the file, then click OK.

You’ll notice that Logging started is displayed in the Status window.

4. Perform the actions you want to save in the log file.

Each action you perform is recorded in the Status window.

5. When you’re finished, choose Generate Log from the File menu.

Logging stopped is displayed in the Status window.

Editing a Log File

You can use a text editor such as Windows Notepad to look at the log file. All lines that 
are preceded by a semicolon are comment lines—these lines are ignored when you run 
the batch file.

Enter a name for 
the log file

Choose a location to save the log file
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If you add comments to the log file, remember to start the line with a semicolon (;). You 
can also add any GEAR formatting commands to the batch file (these commands cor-
respond to the GEAR for Windows commands available in the menus). For a detailed 
list of available commands, see Appendix B.

Running a Batch File

When you run a batch file, each command in the file is executed. You can use a log file 
you create using the Generate Log command in the file menu or you can use a log file 
you create manually in a text editor.

When you run a batch file, lines that begin with a semicolon or an unknown command 
will be ignored. If there are lines that have invalid or missing parameters, GEAR 
prompts you to provide the parameter.

1. Choose Run Batch from the File menu to display the Name of batchfile dialog.

Lines preceded by a semicolon (;) are comment lines—
they provide information about the command lines in 
the log and are ignored when you run the batch file

Comment line

Command line
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2. Locate and choose the log or batch file you want to use, then click OK.

3. GEAR prompts you to run the batch automatically using the default dialog val-
ues. Click Yes.

As the batch file is processed, its status is displayed in the Status window.

Running a Command

You can execute a single batch command using the Run Command in the File menu.

1. Choose Run Command from the File menu.

2. In the dialog that appears, enter the command name with its parameter.

3. Click OK to execute the command.

The command appears in the Status window as it’s executed.

Tip: At the DOS prompt, type help to see all of GEAR’s batch commands or type help <com-
mand> to see how to use the command you enter.

Enter the name of the 
batch file or choose it 
from the list

Choose a location to save the log file

Enter a command name
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19Testing and Writing 
a Virtual Image File 
(Win & OS/2)

This chapter provides information about verifying virtual images and writing them 
to CD-R or premaster tape. You can read about the following:

o Verifying a virtual image

o Creating a physical image

o Estimating system performance

o Writing to CD-R

o Writing to a premaster tape

Verifying a Virtual Image

When you verify a virtual image, GEAR checks the size, date, and time stamp for 
each file in the track or image. If there are discrepancies, it usually means a file has 
been updated since it was loaded into the volume and GEAR prompts you to update 
the volume. You can update a track or image by reloading the reported files and 
directories.

1. With the volume you want to verify open, choose Verify from the Image 
menu.

GEAR prompts you to verify a track or the volume.

2. Do one of the following:

o Click Track to verify the selected track.

o Click Volume to verify the entire volume.
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As GEAR verifies the track or volume, the status of the verification is reported in 
the Status window.

Creating a Physical Volume

A physical volume is a sector-by-sector copy of the CD-ROM you’re about to create. 
You should use a physical volume for writing to
CD-R when the transfer rate for recording has to be increased. Otherwise, you can usu-
ally write with a virtual volume.

Before you create a physical volume, GEAR verifies the virtual volume. If the file is not 
up to date, the physical volume isn’t created. You can update the virtual volume by 
reloading the reported files.

Depending on your needs, you can make a track or an entire volume physical. The sec-
tor sizes for the tracks are based on their type as follows:

The physical volume you create contains the current contents of the virtual volume. 
Subsequent changes you make to the virtual volume don’t affect the current physical 
volume.

The physical volume file names are <volume name>.pxx where xx stands for the track 
number. These files are always written to the GEAR working directory.

Converting the Volume

1. Open the virtual volume you want to create a physical volume for by clicking the 
Open CD-Image button on the toolbar.

2. Choose Convert to Physical from the Image menu.

GEAR prompts you to convert a track or the volume.

3. Do one of the following:

o Click Track to create a physical image of the selected track.

Track Type Sector Size

ISO 2048 bytes

CD-ROM XA 2336 bytes

DA 2352 bytes
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o Click Volume to create a physical image of the entire volume.

As GEAR creates the physical image, the status is reported in the Status window. 

4. If physical files already exist for the track or volume, you are prompted to over-
write them.

When the track or physical image has been successfully created, it’s reported.

Estimating System Performance

It’s a good idea to check you system’s performance before you write to CD-R. GEAR 
measures the time it needs to read all the information from the selected track or volume 
and transfer it to the CD recorder using the current speed settings.

Note: This is a software estimate; it doesn’t take into consideration multiple SCSI controllers. 
While estimating your system’s performance is reliable, test-mode recording is accurate. See 
Using Recording Enabled later in this chapter.

No data is transferred to the recorder during this process. If parts of the image can’t be 
read fast enough, GEAR warns you. You can try any of the following to optimize your 
system’s performance:

o Close any other software applications you’re running in the background.

o Use a defragmentation utility to defragment your hard disk.

o Check to see whether your hard disk does recalibration.

o Check to see if your SCSI termination is correct. A incorrect SCSI termination can 
cause delays on the SCSI bus.

o Check to see if Windows has enough free memory. At the DOS prompt, type mem. 
The largest executable program size should be 500K or more.

If Windows doesn’t have enough free memory, it uses hard disk space, which 
slows down your system’s performance significantly.

o Check your smart drive configuration. If you’re using a physical volume, disable 
smart drive for the drive on which the volume files are located. If you’re using a vir-
tual image, enable smart drive for the drive where the volume files are located.

o Use a physical volume instead of a virtual image.

o Use a lower recording speed if one is available.

Important: The performance of a system for writing a CD-R is better if the access time of your 
hard disk is lower. This is more important than a fast processor. A lot of hard disks regularly 
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perform recalibration. This means that the hard disk verifies its read/write operation to pre-
vent problems. If this happens during the writing of a CD-R disc, it may result in a data transfer 
problem. Refer to your hard disk documentation or speak with your supplier about whether 
your hard disk performs recalibration.

Estimating Performance

Important: Due to the nature of an estimate, the Estimate command doesn’t guarantee the 
disc will be successfully written later.

1. With the virtual volume you want to do an estimate for open, choose Estimate 
from the Write menu.

2. If the physical volume isn’t available, GEAR prompts you to use the virtual vol-
ume instead. Do one of the following:

o Click Yes to use the virtual volume.

o Click No to cancel the estimate.

As the estimate is performed, its status is reported in the Status window.

Using Recording Enabled (Test Write)

If the CD recorder supports a test mode or write disable mode, you can turn off the 
Recording Enabled check box in the Recording Settings dialog (CD-R from the Set-
tings submenu of the Options menu). This way, GEAR will check to see if the image can 
be written to CD-R. 

If the check box is turned off, all data is transferred to the CD recorder’s buffer but the 
disc isn’t actually written. Therefore, you can check system performance without 
recording a disc. 

Note: Test-mode recording takes the actual time that recording takes even though you’re not 
recording a disc.

Turn off this check box if 
your CD recorder supports 
a test or write disable 
mode
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Writing a CD Image to CD-R

When you write a CD image to a CD-R disc, GEAR uses either the virtual image or the 

physical image files. When the virtual image is used, the physical image is created and 
written to disc immediately. You can use physical image files if data transfer rates to the 
recorder are not fast enough.

If the Estimate before write check box is turned on in the Recording Settings dialog 
(CD-R from the Settings submenu in the Options menu), GEAR checks your system 
performance before writing the selected volume to CD-R. If the performance is suffi-
cient, GEAR continues to write the disc. If the performance is insufficient, writing is 
aborted.

Data Transfer Rates

The system has to maintain a high data transfer rate to a CD recorder. If the transfer rate 
can’t be maintained, the writing of the CD-R will fail. CD-R discs can be written at sin-
gle, double, or quadruple speeds. The data transfer rate is dependent on the speed of 
recording and the type of track written (ISO, CD-ROM XA, or CD digital audio). The 
following table shows the required transfer rates:

1x 2x 4x 6x

ISO 153 KB/s 307 KB/s 614 KB/s 918 KB/s

CD-ROM XA 175 KB/s 350 KB/s 700 Kb/s 1050 KB/s

CD Digital 
Audio

176 KB/s 352 KB/s 705 KB/s 1056 KB/s
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For external (foreign) images, the required transfer rate depends on the selected sector 
size. 2048 bytes/sector is comparable to ISO; 2336 bytes/sector is comparable to CD-
ROM XA; 2352 bytes/sector is comparable to CD digital audio.

Recommended Hard Disks

The best hard disks for writing CD-R discs are multimedia or AV (audio visual) hard 
disks. These types minimize recalibration time and guarantee a high sustained data rate.

Note: Call us or check the Elektroson BBS or CompuServe forum for updated lists of recom-
mended hard disks.

Files Created After Writing to CD-R

The CD-R command always creates the following files after you write an image: 

o wo_ident.txt 

o woresult.txt.

The wo_ident.txt file contains the table of contents (TOC) and some customer infor-
mation that’s written to the CD recorder. The customer information is read from the 
gear.ini file. The woresult.txt file contains status information.

Writing to CD-R

1. With the virtual volume you want to write open, click the Write CD-R button on 
the toolbar.

2. If the physical volume isn’t available, GEAR prompts you to use the virtual vol-
ume instead. Do one of the following:

o Click Yes to use the virtual volume.

o Click No to cancel the writing.

As the volume is written, its status is reported in the Status window.

Writing to Disc Description Protocol Premaster Tape

If you’re going to mass-duplicate your CD-R, you can write a volume to premaster tape. 
The tape is written in ANSI (X3.27-1987) format. GEAR uses either the virtual volume 
or the physical volume. When you choose the virtual volume, the physical volume is 
created and written to tape immediately. Writing from a physical volume is faster than 
writing from a virtual volume.
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You can send the premaster tape to a replication company for mastering and duplica-
tion. If the Verify after write check box is turned on in the Tape Setup dialog (Tape from 
the Settings submenu in the Options menu), GEAR verifies the contents of the tape with 
the volume after writing to premaster tape.

Recommended Tape Drives

GEAR supports most tape units that provide a SCSI interface. The preferred configu-
ration is with an EXABYTE tape unit, a Hewlett Packard DAT unit (HP35470A), or an 
M4 9 track.

Files Created After Writing to Tape

The following files are created after an image is written to tape:

o tp_ident.txt

o tpresult.txt

o DDPID

o DDPMS

o PQDESCR

The tp_ident.txt files contains the table of contents (TOC) of the image written to tape 
and some customer information. The DDPID, DDPMS, and PQDESCR files form the 
DDP information of the last image written to tape. You can also write these files to tape.

Writing GEAR-Created Files to Premaster Tape

1. Click the Write Premaster Tape button on the toolbar to display the Tape Setup 
dialog.

2. Turn on the Write DDP files to tape and Write IDENT.TXT file to tape check 

Turn on these 
check boxes to 
write the indicat-
ed files to tape
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boxes.

3. Click OK.

Writing a Volume to Tape

1. With the volume you want to write to tape open, choose Premaster Tape from the 
Write menu.

2. A dialog prompts you with instructions for preparing the tape unit for recording. 
When the unit is ready, click OK.

As the volume is written, its status is reported in the Status window.
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Chapter 20 Getting Started With GEAR helps you start and learn to use GEAR.

Chapter 21 Creating an ISO Images helps you create a new ISO image, create tracks on the 
image, open an existing ISO image, and load track contents.

Chapter 22 Creating a CD-ROM XA shows you how to create an external architecture image 
and use manual- and pre-interleaving to record data.

Chapter 23 Creating an Audio CD shows you how to create and record a digital audio CD.

Chapter 24 Creating HFS, Hybrid, or SCSI CD-ROMs explains how to create and open HFS 
and hybrid images and how to perform a SCSI device dump.

Chapter 25 Working With Multi-Session Discs explains how to append data to a disc.

Chapter 26 Working With External (Foreign Image) Files explains what an external volume is 
and how to edit it, and discusses different formats.

Chapter 27 Working With Virtual Images explains how to edit tracks on a volume that was cre-
ated using an authoring package other than GEAR.

Chapter 28 Testing and Writing a Virtual Image File shows you how to prepare for writing 
discs, estimate system performance, and write CD-R discs and premaster tapes.

GEAR for Mac OS 
Introduction
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20Getting Started With 
GEAR for Mac OS

This chapter helps you create your first CD in just minutes. You can read about the 
following:

o Starting GEAR

o Creating a new ISO image

o Choosing CD recording settings

o Writing a CD-R

o Using the Apple Guide

Starting GEAR 

Make sure your recorder is turned on before you start your Macintosh.

o Double-click the GEAR icon to start GEAR.

When you start GEAR, the Workbench window appears where you can create 
a new virtual image file. A virtual image file is a file that contains all the infor-
mation you need to create a CD.
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The GEAR Buttons

Creating a New CD Image File

The Workbench window is where you control the type of image you want to create and 
recording the CD. 

This button… Lets you do this

Open CD Image File Open an existing image

Close CD Image File Close the current image

Append Next Session Add another session to CD-R

Convert CD Image File Converts a virtual image to a physical 
image

Copy CD Track Copy a track from the CD in the CD 
recorder

View CD Info Display information about the CD in the 
CD recorder

These buttons let you open 
and close image files, append 
multi-session discs, and con-
vert virtual CD images to 
physical images

This is where you choose the type of image 
you’re creating or working with

This button lets you copy a 
track from a CD in the CD 
recorder to your hard disk

This button lets you view information 
about the CD in the CD recorder Messages to guide you as you work in GEAR appear at 

the bottom of this window

This is where you specify 
information for testing 
and writing an image to a 
CD-R
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1. Choose ISO from the CD Type pop-up menu, then click the Create button.

2. In the New CD Image dialog, open the folder where you want to put the new 
image.

3. Enter MY_ISO for the image name in the Create new volume as box.

(For information about valid ISO-9660 names, see Appendix D.)

4. From the Length of CD pop-up menu, choose the correct CD-R size for the CD 
you plan to record on.

You can record up to this many minutes on the CD.

5. Click the New button.

The Session window appears and you’re ready to choose the contents for your CD.

Choose ISO from the CD 
Type pop-up menu…

…then click Create

Enter a name for the new 
image you’re creating

Locate and choose the 
folder where you want 
to save the new image

Choose the length of 
the CD here

Click here to create 
the new image
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Loading the CD Contents

In the Session window, you can access the files and folders on your hard disk as well as 
any files and folders on network drives if you’re connected to a network.

1. From the source list on the left of the Session window, select a file to load onto 
the CD.

2. Click the Copy button in the center of the dialog.

Files and folders on your 
hard disk appear here in 
the source list

When you copy files to the image, 
they appear here in the CD con-
tents list

Session window

The name you gave the 
new image appears here

Click a file to select it

Click the Copy Item button to copy the selected 
file to the CD contents list
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The file is added to the CD contents list on the right of the dialog.

Below the CD contents list, the amount of space used by the file you’ve loaded and 
the amount of space remaining on the CD are displayed.

Hint: You can double-click a file to add it to the CD contents list.

3. Repeat steps 1 and 2 to add more files and folders to the CD contents list.

Hint: To copy multiple files at once, click the first file or folder, then Shift-click subsequent files 
and folders.

4. When you’re finished copying files and folders, click the Done button at the bot-
tom center of the dialog.

This returns you to the Workbench window. Now you’re ready to choose recording 
settings.

Choosing CD-R Settings

You can choose the settings you want to use for recording a CD in the CD Recorder 
Setup dialog. You can specify options like speed and performance testing, disc-at-once, 
track-at-once, or incremental writing, and medium changer options if you’re using a 
jukebox or CD changer.

Files and folders you copy appear here

When you’re finished copying 
files and folders, click here to re-
turn to the Workbench window

The amount of space used by the file 
and the amount of space remaining on 
the CD appear here
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We’re going to specify a speed and performance testing options in this section. For 
detailed information about other settings, see chapter 21.

1. Click the Setup button to display the CD Recorder Setup dialog

2. From the pop-up menu, choose General Recorder Settings.

3. In the dialog that appears, choose a speed from the available speeds in the 
Recording speed pop-up menu.

4. If the Performance test run check box is turned on (if it contains an x), click it to 
turn it off.

This will let you record your CD.

5. Click OK to return to the Workbench window. 

Writing to a CD Recorder

Now you’re ready to write data to your CD! It’s as simple as the click of a button.

1. Next to Copies in the Workbench window, enter the number of CD copies you 
want to record.

2. Click the Write button in the Workbench window.

Turn off this check box when 
you’re ready to record data to 
the disc

Choose the appropriate 
recording speed for your 
CD recorder

The name of your CD recorder appears here
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GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the image are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. Differ-
ences may occur if files are changed after they’re loaded into the virtual image. If 
there are any differences, GEAR warns you and you can reload the files to update 
them. 

When writing is complete, the disc is ejected automatically and it’s ready for read-
ing in any CD-ROM drive!

Premastering a Tape

As an alternative to writing to a CD, you can premaster a tape, then send it to a CD-
ROM mastering plant where the data is written to CD. The tape, which is written in 
DDP format, is accepted as a standard at mastering plants. This tape is used to create a 
glass master, which is used to create daughters. Daughters are used to stamp silver or 
production CDs.

If you chose to do a test run in the Tape Settings dialog, GEAR compares the contents 
of the tape with the actual volume. This means that the tape is read back and its data is 
checked against the contents of your virtual image. If there are differences, GEAR 
warns you.

The process for premastering a tape is just like writing to CD. Make sure your tape unit 
is connected to your computer and turned on and that there’s a tape in the unit before 
you start GEAR.

o Choose Tape Recorder from the Write to pop-up menu in the Workbench window.

GEAR optimizes your virtual image by resizing it to the minimum size that can 
contain all the data. All files in the volume are verified. Each file’s size and time 
stamp are compared to the file’s size and time stamp when it was loaded. Differ-

Type the number of CD copies 
you want to record

Click here to write the 
image to CD-R
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ences may occur if files are changed after they’re loaded into the virtual image. If 
there are any differences, GEAR warns you and you can reload the files to update 
them. 

When writing is complete, the tape is ejected automatically. Your tape is ready to 
send to a CD-ROM mastering plant!

Using the Online Help

Online help is available at any time if you don’t understand how to use GEAR. To access 
help, do any of the following:

o Choose GEAR Guide from the Guide menu to display the help window.

o Choose a help command from the Apple Guide menu.

o As you use GEAR, messages are displayed at the bottom of the Workbench window 
to guide you.

Messages that guide you appear here
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21Creating an ISO 
Image (Mac OS)

This chapter teaches you how to create and open ISO images. You can read about 
the following:

o Creating a new ISO image file

o Creating tracks on an ISO image CD

o Opening an existing ISO image

o Loading track contents

In addition, this chapter discusses general information that is relevant for all CD 
types. 

For information about editing tracks and track contents, volume settings and 
descriptors, see Chapter 24. For information about creating CD-ROM XA images 
and audio CDs, see Chapters 22 and 23, respectively. For information about exter-
nal files (images created using a CD authoring package other than GEAR), see 
Chapter 26.

About Creating a New Virtual Image File

A virtual image is the minimal amount of information you need to create a CD. The 
opposite of the virtual image is a physical image, which is the entire CD stored on 
a hard drive before you record it.

Before you begin to create a new virtual image file, you should review the follow-
ing information about virtual images and their capacities.
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When you create a new virtual image, the file is called a volume administration file. You 
must have more than 25MB of free disk space available to create a volume administra-
tion file. 

Administration files are created in the current working directory for each new track you 
create. The files are named using the CD-ROM name, the word Files, and the track 
number, for example:

o NEW_VOLUM Volume

o NEW_VOLUM Iso01

o NEW_VOLUM Files01

o NEW_VOLUM Map01

o NEW_VOLUM Phys01 (physical volumes)

You should never edit or delete these files manually; this results in a corrupt and useless 
image. Administration files are deleted automatically when you delete the associated 
image.

Track Types in GEAR

You can choose three track types in GEAR:

o ISO is a CD-ROM track type with error-checking capabilities. This is referred to as 
Mode 1 format (Yellow Book). This format is suited for recording computer data 
and always consists of one track. ISO is suited for CD-ROM formats. This chapter 
shows you how to create an ISO image.

o XA (eXtended Architecture) is a track type for CD-ROM XA and CD-I. This for-
mat is used for multi-media applications and always consists of one track. XA is 
suited for the following formats: CD-ROM XA, CD-I, EB, MMCD, Photo CD, and 
VideoCD. Chapter 22 shows you how to create an XA CD.

o DA is a track type for digital audio. This format allows up to 99 tracks. If audio 
tracks are combined on a disc with an ISO or XA track, up to 98 tracks can be used. 
DA is suited for CD Digital Audio (Red Book). Chapter 23 shows you how to cre-
ate an audio CD.

Calculating Virtual Image Capacities

You can use the following formula to calculate the capacity of a virtual image:

virtual image capacity = sector data capacity (bytes) x length (minutes) x 60 
(seconds) x 75 (number of sectors)
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The sector data capacities for each track type are:

The virtual image data capacity for each disc size and track type are:

As you create tracks on your new image, keep in mind these points:

o The track number is assigned automatically and is relevant only for CD audio. With 
the exception of CD Enhanced or CD Plus, XA tracks are always assigned to track 
number 1.

o A virtual image can have only one ISO or XA track; it may not have both types of 
tracks.

o A virtual image can contain up to 99 tracks.

o It is impossible to have two separate CD formats in one track.

o When you create a new track, it’s automatically assigned the maximum available 
space on the virtual image.

Creating an ISO Image

The process to create a new ISO image is just like creating your first virtual image in 
Chapter 20.

Track Type
Sector Data 

Capacity

ISO 2048 bytes

XA and CD-I 2336 bytes

CD Audio (DA) 2352 bytes

Virtual Image Data Capacity

Disc Size ISO XA and CD-I CD Audio

18 min. 158 MB 180MB 181MB

63 min. 553MB 631MB 635MB

74 min. 650MB 741MB 746MB

80 min. 703MB 802MB 807MB
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1. In the Workbench window, choose ISO from the CD Type pop-up menu, then 
click the Create button or press Cmd-N.

2. In the New Volume dialog, open the folder where you want to put the new ISO 
image.

3. Enter a name for the ISO image in the Create new volume as box.

A valid name consists of uppercase, alphanumeric characters and underscores (_). 
For information about valid ISO-9660 names, see Appendix A.

4. From the Length of CD pop-up menu, choose the correct CD-R size for the CD 
you plan to record on.

You can record 18, 63, 74, or 80 minutes on a CD.

5. Click the New button.

The Session window appears where you can choose the contents for your CD.

Choose ISO from the 
CD Type pop-up menu, 
then click Create

Enter a name for the image

Choose the length of the CD

Choose a location 
for the new image
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Creating the Track Contents

For data tracks only, you can indicate how non-ISO names an d folder names should be 
handled. Choose Volume Setup from the Edit menu, then choose Volume Attributes in 
the dialog that appears. The option you choose from the pop-up menu under When 
copying files with Mac names to an ISO image determines how and when non-ISO file 
and folder names are translated.

Loading Files for a Track

1. If the ISO image containing the track you want to load data for isn’t open, click 
the Open CD Image File button in the Workbench window or press Cmd-O.

2. In the dialog that appears, locate and select the ISO image you want to open, then 
click Open. 

The Session window appears.

3. From the source list, locate the folders and files you want to load.

Locate and double-click the 
file you want to open

Locate and select in the 
source list the files you 
want to copy to the CD



Elektroson GEAR

178 n Creating an ISO Image (Mac OS)

o To load multiple contiguous items, click the first item, then Shift-click addi-
tional items.

o To load multiple non-contiguous items, click the first time, then Cmd-click 
additional items.

o To deselect selected items, Shift-click or Cmd-click them.

o To load items from a folder that appears in the source file list, select the 
folder, click the Open Folder button in the center of the window, then select 
the items.

o To load items from another drive or partition, click the Next Drive button in 
the center of the window, then select the items.

4. Do one of the following to add the selected items to the CD contents list:

o Click the Copy Item button.

o Double-click an individual file to copy it.

GEAR displays the copied items in the CD contents list.

5. If you opened a folder in the source list, close it by choosing another folder or 
drive from the popup menu at the top of the source file list.

6. Repeat steps 3–5 to copy more items.

The amount of space used by the items you’ve copied and the amount of space 
remaining are displayed at the bottom right of the Session window. The session 
number is also displayed.

7. In the CD contents list, do any of the following while you are copying items:

o To organize items into folders, select the items, then click the New Folder 
button in the center of the window.

o Select an item and click the Remove Item button to remove it from the list of 
copied items.

o Select an item and click the Rename Item button to change its name.

8. When you’re finished copying items, click the Done button to return to the 
Workbench window.

The name of the ISO image and the size of the CD contents are displayed.

9. When you’re finished with the ISO image file, click the Close CD Image File 
button in the Workbench window.



Elektroson GEAR

Creating an ISO Image (Mac OS) n 179

Recording ISO Tracks

You can specify the types of settings appropriate for your CD recorder using the 
Recorder Setup command in the Edit menu. There are three types of settings:

o General

o Advanced

o Medium changer

General Recorder Settings

In the CD Recorder Setup dialog for General Recorder Settings, you can specify the 
speed at which you want to record: 1x, 2x, 4x, or 6x, depending on your recorder model. 

You can also specify whether to perform a test run. This simulation test disables record-
ing and lets you verify that your system performance is sufficient to record the CD. A 
test run copies your entire CD image to the recorder at the specified recording speed.

Either you can do a software estimate or perform a test run. A software estimate tests the 
rate at which data is transferred to the CD-R. This option is quicker than the Perform test 
run option but isn’t as accurate.

Advanced Recorder Settings

In the CD Recorder Setup dialog for Advanced Recorder Settings, you can select a 
recording method: disc-at-once, track-at-once, or incremental, depending on your 
recorder model. 

Incremental lets you write in fixed packet size, which is determined by the recorder’s 
buffer to eliminate or minimize buffer underrun. 

Disc at once means your recorder writes the lead in, then the track data, then the lead 
out.

General recorder settings
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Note: You can’t use disc at once recording to record a multi-session disc.

Track at once means your recorder first writes the track data, then finalizes the disc by 
writing a lead in and lead out. This method is used in multi-session recording.

Until you fixate the disc, you can only read it on a CD recorder. You can use this option 
to record multiple tracks on a CD without recoding in multiple sessions.

You can also specify whether to fixate the disc after recording (that is, record the lead 
in or lead out). 

If you don’t fixate the disc, you can specify a multi-session recording, that is, recording 
can occur over several different sessions on the same or different recorders.

Medium Changer Settings

In the CD Recorder Setup dialog for Medium Changer Settings, you can specify 
whether to use a CD changer or jukebox to load CDs for recording. You can also indi-
cate whether to scan slots in the medium changer: the first slot to use for loading and 
scanning, and the number of slots to scan. In addition, you can choose the drive number 
or the CD recorder to use.

Advanced recorder settings

Medium changer settings
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Changing Recorder Settings

1. Click the Setup button in the Workbench window to display the CD Recorder 
Setup dialog or choose CD Recorder Setup (Edit menu).

2. Choose the type of recording settings you want to use:

o General Recorder Settings lets you specify speed and performance testing 
options.

o Advanced Recorder Settings lets you specify a recording method (that is, 
disc at once, track at once or incremental).

o Medium Changer Settings let you specify options for a jukebox or CD 
changer.

(For details about these options, see “Recording ISO Tracks,” earlier in this chap-
ter.)

3. When you’ve specified your recording settings, click OK.

4. In the Workbench window, enter the number of copies you want to record.

5. Click the Write button to write the tracks to CD.

Copying a Track from CD-ROM
1. Insert a CD-ROM ISO CD in your CD recorder.

2. In the Workbench window, click the View CD Info button to display a window 
containing information such as the track types on the CD.

3. Click the Copy CD Track button to copy the image to your hard disk.

4. In the Workbench window, choose Custom Format from the CD Type pop-up 
menu.

5. Click the Specify button.
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6. In the dialog that appears, select the track you want to copy to CD and click the 
Select button.

The Foreign Image Parameters dialog appears.

7. Choose an ISO type from the Image Mode pop-up menu.

The Sector Size defaults to a common setting.

Choose Custom Format 
here, then click the Specify 
button

Select a track to copy…

…then, click Select

Choose a sector size
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8. Usually the displayed value is appropriate, however, you can choose another size 
from the Sector Size pop-up menu.

Warning! If you choose an incorrect setting, your disc will be unreadable.

9. Click OK to copy the image to CD.
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22
Creating a CD-ROM XA 
(Mac OS)

This chapter provides information about how to create a CD-ROM XA image. You 
can read about the following:

o Creating a new CD-ROM XA

o Creating tracks on a new CD-ROM XA

o Opening an existing CD-ROM XA

o Loading track contents

For general information about creating virtual ISO CD images, see Chapter 21. For 
information about editing tracks and track contents, volume settings and descrip-
tors, see Chapter 24. For information about audio CD images, see Chapter 23.

About Creating a New CD-ROM XA

XA (eXtended Architecture) is a track type for CD-ROM XA and CD-I. This for-
mat is used for multi-media applications and consists of one track only. XA is 
suited for the following formats:

o CD-ROM XA

o CD-I

o EB

o MMCD

o Photo CD

o VideoCD
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When you load files for an XA image, you can choose non-interleaved or pre-inter-
leaved files, or you can manually interleave the files you load.

Interleaving

When you create an XA image, you must use interleaved files or allow GEAR to inter-
leave files for you. This is useful when you have two or more different CD track types, 
such as audio or video, that must flow together in synchronization. These files must be 
interleaved with each other to optimize playback.

For example, with a mixed mode disc, the laser-reading head has to jump back and forth 
between widely separated tracks to play back audio and video data. This slows down the 
application significantly. 

When you use interleaving, the laser-reading head can pick up video, then move 
smoothly to the next amount of audio and so on, providing real-time playback. 

Note: Playing XA interleaved files requires an XA decoder card.

There are two types of XA interleaving in GEAR:

Manual interleave
Pre interleaved

Set Manually

Manual interleaving lets you specify all the options to create your own interleaved files. 
You can find more information about the use of these parameters for CD-ROM XA 
applications in the book, System Description on CD-ROM XA.

In general, it’s easier to use the dedicated CD-ROM XA interleaving tools, such as the 
Mammoth Tool Set, and the Pre-interleaved files option to create these files.

Pre-interleaved files

If you use this option, GEAR assumes that the selected files are pre-interleaved CD-
ROM XA files, which are sometimes referred to as XA streams.

Important: Make sure the files you are loading are pre-interleaved files. Non-pre-interleaved 
files you load this way are useless on the resulting CD-R disc. A pre-interleaved file must have 
a 2336 byte sector size with a subheader field filled in. This subheader field is copied, together 
with other information, to the GEAR administration file. Normally the subheader is not includ-
ed in a file and the subheader information is generated by GEAR.
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Creating an XA Image

The process to create a new XA image is similar to creating your first virtual image in 
Chapter 20.

1. In the Workbench window, choose XA from the CD Type pop-up menu, then 
click the Create button.

2. In the New Volume dialog, open or create the folder where you want to put the 
new image.

3. Type a name for the image in the Create new volume as box.

A valid name consists of uppercase, alphanumeric characters and underscores (_). 
For information about valid ISO-9660 names, see Appendix D.

4. From the Length of CD pop-up menu, choose the correct CD-R size for the CD 
you plan to record on.

You can record 18, 63, 74, or 80 minutes on a CD.

Choose XA, then click the 
Create button

Type a name fro the image

Choose the CD length
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5. Click the New button to create the CD image.

The Session window appears.

6. To control the display of hidden files in the source list, click the Hidden Files 
button in the center of the Session window.

7. From the Interleave pop-up menu, choose the type of interleaving for the files 
you’re going to copy. (For information about the Manual Interleave dialog, see 
“Choosing Manual Interleave Parameters,” later in this chapter.)

8. From the source list, locate the folders and files you want to copy.

o To copy multiple contiguous items, click the first item, then Shift-click addi-
tional items.

o To copy multiple non-contiguous items, click the first item, then Cmd-click 
additional items.

o To deselect selected items, Shift-click or Cmd-click them.

o To copy files from a folder that appears in the source list, select the folder, 
click the Open Folder button in the center of the window, then select the 
files.

Choose an interleave method 

Choose the files and folders 
you want to copy

Files and folders you copy appear here

The amount of space used by the items 
you copy and the space remaining on the 
CD appear here
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9. Do one of the following to copy selected items to the CD contents list:

o Click the Copy Item button.

o Double-click an individual file to copy it.

GEAR displays the copied items in the CD contents list.

10. If you opened a folder in the source list, close it by choosing another folder or 
drive from the pop-up menu at the top of the source list.

11. Repeat steps 8–10 to copy more items.

The amount of space used by the items you’ve copied and the amount of space 
remaining are displayed at the bottom right of the Session window. The session 
number is also displayed.

12. In the CD contents list, do any of the following while you’re copying items:

o Select an item and click the Remove Item button to remove the item from the 
list of copied items.

o Select an item and click the Rename Item button to change the item’s name.

13. When you’re finished copying files, click the Done button.

Choosing Manual Interleave Parameters

When you choose Set manually from the Interleave pop-up menu in the Session win-
dow, you can specify all the options to create your own interleaved files. You can find 
more information about the use of these parameters for CD-ROM XA applications in 
the book, System Description on CD-ROM XA.

To select non-contiguous files 
and folders, Click one file, then 
Cmd-click additional files
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In general, it’s easier to use the dedicated CD-ROM XA interleaving tools, such as 
Mammoth Tool Set, and the Pre-interleaved files option in the Interleave pop-up menu 
to create these files.

1. Choose Set manually from the Interleave pop-up menu in the Session window.

2. The Manual Interleave dialog appears.

3. Choose a channel number from 1–32 for each file you want to load.

4. Choose an interleave data factor from 1–16 for each file you want to load.

5. Choose an interleave total factor from 1–16 for each file you want to load. This 
number, together with the interleave data factor in step 4 determines the inter-
leaving of each file.

Valid combinations for interleave data factor and total factor are: 1–4, 1–16, 1–8, 
and 2–4, and so on.

The combination 2–4 means that for each set of four sectors, the first two are occu-
pied by the file.

ADPCM B stereo files are interleaved 1–4, while ADPCM C stereo files are inter-
leaved 1–8.

6. Choose a data type from the Data type pop-up menu.

o ADPCMBSN is valid for ADPCM audio, level B stereo, no emphasis.

o ADPCMCME is value for level C Mono with emphasis.

o VIDEO 2048 is used if each sector contains video data and EDC/ECC codes.

o VIDEO 2324 is used if each sector contains video data.

o Other valid choices include: ADPCMBSE; ADPCMBMN; ADPCMBME; 
ADPCMCSN; ADPCMCSE; ADPCMCMN; ADPCMCME; AND 
DATA2048.

Type the channel number (from 
1–32) for each file you want to 
copy

Type an interleave data factor and 
an interleave total factor (each 
from 1–16) for each file you want 
to copy

Choose a data type here

Turn these check boxes on to set the 
appropriate bit in the subheader
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7. If you want the trigger or end of record bit set in the subheader of the last sector 
of each file, turn on the Trigger and End of record check boxes.

You can specify one or both options.

8. Click OK to close the dialog. The item you copied appears in the CD contents 
list.

Pre-Interleaved Files

If you choose this option from the Interleave pop-up menu in the Session window, 
GEAR assumes that the specified files are pre-interleaved CD-ROM XA files, which 
are sometimes referred to as XA streams.

Important: Make sure the files you are copying with this option are indeed pre-interleaved files. 
Non-pre-interleaved files you copy this way are useless on the resulting CD-R disc. A pre-inter-
leaved file must have a 2336 byte sector size with a subheader field filled in. This subheader 
field is copied, together with the other information, to the GEAR administration file. Normally 
the subheader is not included in a file and the subheader information is generated by GEAR.

o Choose Pre-Interleaved from the CD-ROM XA submenu of the Options menu.

Recording XA Tracks

You can specify the types of settings appropriate for your CD recorder using the 
Recorder Setup command in the Edit menu. There are three types of settings:

o General

o Advanced

o Medium changer

General Recorder Settings

In the CD Recorder Setup dialog for General Recorder Settings, you can specify the 
speed at which you want to record: 1x, 2x, 4x, or 6x, depending on your recorder model. 

You can also specify whether to perform a test run. This simulation test disables record-
ing and lets you verify that your system performance is sufficient to record the CD. A 
test run copies your entire CD image to the recorder at the specified recording speed.

Either you can do a software estimate or perform a test run. A software estimate tests the 
rate at which data is transferred to the CD-R. This option is quicker than the Perform test 
run option but isn’t as accurate.
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Advanced Recorder Settings

In the CD Recorder Setup dialog for Advanced Recorder Settings, you can select a 
recording method: disc-at-once, track-at-once, or incremental, depending on your 
recorder model. 

Incremental lets you write in fixed packet size, which is determined by the recorder’s 
buffer to eliminate or minimize buffer underrun. 

Disc at once means your recorder writes the lead in, then the track data, then the lead 
out.

Note: You can’t use disc at once recording to record a multi-session disc.

Track at once means your recorder first writes the track data, then finalizes the disc by 
writing a lead in and lead out. This method is used in multi-session recording.

Until you fixate the disc, you can only read it on a CD recorder. You can use this option 
to record multiple tracks on a CD without recoding in multiple sessions.

You can also specify whether to fixate the disc after recording (that is, record the lead 
in or lead out). 

If you don’t fixate the disc, you can specify a multi-session recording, that is, recording 
can occur over several different sessions on the same or different recorders.

General recorder settings
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Medium Changer Settings

In the CD Recorder Setup dialog for Medium Changer Settings, you can specify 
whether to use a CD changer or jukebox to load CDs for recording. You can also indi-
cate whether to scan slots in the medium changer: the first slot to use for loading and 
scanning, and the number of slots to scan. In addition, you can choose the drive number 
or the CD recorder to use.

Changing Recorder Settings

1. Click the Setup button in the Workbench window to display the CD Recorder 
Setup dialog or choose CD Recorder Setup (Edit menu).

2. Choose the type of recording settings you want to use:

o General Recorder Settings lets you specify speed and performance testing 
options.

o Advanced Recorder Settings lets you specify a recording method (that is, 
disc at once, track at once or incremental).

o Medium Changer Settings let you specify options for a jukebox or CD 
changer.

Advanced recorder settings

Medium changer settings
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(For details about these options, see “Recording XA Tracks,” earlier in this chap-
ter.)

3. When you’ve specified your recording settings, click OK.

4. In the Workbench window, enter the number of copies you want to record.

5. Click the Write button to write the tracks to CD.

Copying an XA Track from CD-ROM
Note: Not all recorders support copying CD-ROM XA tracks.

1. Insert a CD-ROM XA CD in your CD recorder.

2. In the Workbench window, click the View CD Info button to display a window 
containing information such as the track types on the CD.

3. Click the Copy CD Track button to copy the image to your hard disk.

4. In the Workbench window, choose Custom Format from the CD Type pop-up 
menu.

5. Click the Specify button.

6. In the dialog that appears, select the track you want to copy to CD and click the 
Select button.

Choose Custom Format here, 
then click the Specify button
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The Foreign Image Parameters dialog appears.

7. Choose an XA type from the Image Mode pop-up menu.

The Sector Size defaults to a common setting.

8. Usually the displayed value is appropriate, however, you can choose another size 
from the Sector Size pop-up menu.

Warning! If you choose an incorrect setting, your disc will be unreadable.

9. Click OK to copy the image to CD.

Select a track to copy…

…then, click Select

Choose a sector size
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23Creating an Audio CD 
(Mac OS)

This chapter teaches you how to create and open an audio CD image. You can read 
about the following:

o Creating a new audio image

o Creating tracks on a new audio image

o Opening an existing audio image

o Loading track contents

For general information about creating virtual CD images, see Chapter 21. For 
information about editing tracks and track contents, volume settings and descrip-
tors, see Chapter 24. For information about CD-ROM XA images, see Chapter 22.

About Creating a New Audio CD

DA (Digital Audio) is a track type for audio CDs. This format allows you to create 
up to 99 tracks. If audio tracks are combined on a disc with an ISO or XA track, you 
can create up to 98 tracks.

GEAR supports Red Book audio file formats, as well as the following formats:

o wav

o AIFF

o SoundDesigner II

For wav, AIFF, and SoundDesigner II files, GEAR removes the header automati-
cally. AIFF files are usually in MSB format.
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When you create DA tracks, you need hard disk files that represent audio. The files must 
always fulfill the following requirements, which are specified in the Red Book:

o Audio files hould not have a header

o The sample frequency must be 44.1kHz

o Audio must be stereo (one sample for the left channel and one sample for the right 
channel) sampled on 44.1kHz

o Each sample must contain 16 bits

o The byte order must be the same as the byte order used by your computer; if it isn’t, 
you can use the generic option MSBAudio (in the Gear Preferences file) to make 
GEAR swap the audio bytes for all tracks

For example, MSB audio is the default for Macintosh. If you want GEAR to swap byte 
order, set MSBAudio=FALSE in the GEAR preferences file.

Depending on the audio package you’re using, the audio file may or may not contain a 
sound header, however, audio files should not contain sound headers. If sound headers 
are not removed or cleared, they will cause a sharp click in the resulting audio track on 
the CD. GEAR removes sound headers when loading files.

You can use the Copy CD Track button in the Workbench window to copy a digital 
audio track from CD to a file on hard disk. This command operates on the Philips 
CDD522, Sony 920, and Yamaha CDR100. The Read CD Track command creates no 
header so you can use the resulting file directly.

Creating an Audio Image With Tracks

The process to create a new audio CD is similar to creating your first virtual image in 
Chapter 20.

1. In the Workbench window, choose DA (Audio) Image from the CD Type pop-up 
menu, then click the Create button.
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2. In the New Volume dialog, open or create the folder where you want to put the 
new image.

3. Type a name for the image in the Create new volume as box.

A valid name consists of uppercase, alphanumeric characters and underscores (_). 
For information about valid ISO-9660 names, see Appendix A.

4. From the Length of CD pop-up menu, choose the correct CD-R size for the CD 
you plan to record on.

You can record 18, 63, 74, or 80 minutes on a CD.

5. Click the New button to create the CD image.

The Session window appears.

Choose DA, then click 
the Create button

Type a name for the image

Choose the CD length
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6. To change the type of files displayed in the source list, turn on the appropriate 
button in the center of the window.

7. From the source list, locate the audio file you want to add.

8. Do one of the following to add the selected file to the CD contents list:

o Double-click the file name.

o Click the Add File button.

GEAR assigns the track number automatically

9. Repeat steps 6–8 to add more tracks.

The amount of space used by the tracks you’ve loaded and the amount of space 
remaining are displayed at the bottom right of the Session window.

10. When you’re finished loading files, click the Done button.

Copying an Audio Track from CD-ROM

GEAR lets you extract tracks form a CD-ROM and store them on your hard disk for 
recording on a CD-R. You can use any of the following four recorders to read audio 
through the SCSI bus:

o Kodak PCD225

o Philips CDD522

o Sony 920S

o Yamaha CDE/CDR-100

Note: Not all recorders support copying digital audio tracks.

Select a file to copy to the 
CD contents list The tracks you copy are dis-

played here
Choose the type of files to 
display



Elektroson GEAR

Creating an Audio CD (Mac OS) n 201

1. Insert an audio CD in your CD recorder.

2. In the Workbench window, click the View CD Info button to display a window 
containing information such as the track types on the CD.

3. Click the Copy CD Track button to copy the image to your hard disk.

See “Creating an Audio Image With Tracks” for information about recording the 
selected files to a CD. You can locate these files in the source list in the session window 
and add them to the CD contents list to record.

Writing an Audio CD

You can specify the types of settings appropriate for your CD recorder in the CD 
Recorder Setup dialog. There are three types of settings:

o General

o Advanced

o Medium changer

General Recorder Settings

In the CD Recorder Setup dialog for General Recorder Settings, you can specify the 
speed at which you want to record: 1x, 2x, 4x, or 6x, depending on your recorder model. 

You can also specify whether to perform a test run. This simulation test disables record-
ing and lets you verify that your system performance is sufficient to record the CD. A 
test run copies your entire CD image to the recorder at the specified recording speed.

Either you can do a software estimate or perform a test run. A software estimate tests the 
rate at which data is transferred to the CD-R. This option is quicker than the Perform test 
run option but isn’t as accurate.

General recorder settings
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Advanced Recorder Settings

In the CD Recorder Setup dialog for Advanced Recorder Settings, you can select a 
recording method: disc-at-once, track-at-once, or incremental, depending on your 
recorder model. 

Incremental lets you write in fixed packet size, which is determined by the recorder’s 
buffer to eliminate or minimize buffer underrun. 

Disc at once means your recorder writes the lead in, then the track data, then the lead 
out.

Note: You can’t use disc at once recording to record a multi-session disc.

Track at once means your recorder first writes the track data, then finalizes the disc by 
writing a lead in and lead out. This method is used in multi-session recording.

Until you fixate the disc, you can only read it on a CD recorder. You can use this option 
to record multiple tracks on a CD without recoding in multiple sessions.

Before you record your last track, turn on fixation so the lead in and lead out will be 
written.

If you don’t fixate the disc, you can specify a multi-session recording, that is, recording 
can occur over several different sessions on the same or different recorders.

Medium Changer Settings

In the CD Recorder Setup dialog for Medium Changer Settings, you can specify 
whether to use a CD changer or jukebox to load CDs for recording. You can also indi-
cate whether to scan slots in the medium changer: the first slot to use for loading and 
scanning, and the number of slots to scan. In addition, you can choose the drive number 
or the CD recorder to use.

Advanced recorder settings
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Changing Recorder Settings

1. Click the Setup button in the Workbench window to display the CD Recorder 
Setup dialog or choose CD Recorder Setup (Edit menu).

2. Choose the type of recording settings you want to use:

o General Recorder Settings lets you specify speed and performance testing 
options.

o Advanced Recorder Settings lets you specify a recording method (that is, 
disc at once, track at once or incremental).

Note: Be sure to turn on the Fixate disc after recording check box so the disc will be fixated. 

o Medium Changer Settings let you specify options for a jukebox or CD 
changer.

(For details about these options, see “Recording Audio Tracks,” earlier in this 
chapter.)

3. When you’ve specified your recording settings, click OK.

4. In the Workbench window, enter the number of copies you want to record.

5. Click the Write button to write the tracks to CD.

Writing Audio Tracks in Separate Recordings

Audio CDs should be single-session discs because audio-only CD players are single-
session readers. You can’t finalize an audio CD until you’ve loaded all the audio files 
for all the tracks. If your hard disk isn’t large enough to hold all the audio files or you 
haven’t prepared all your audio files for recording, you can load files over several 
recordings without making the disc multi-session.

Note: Be sure to turn off the Fixate disc after recording check box so the disc won’t be fixated. 
This will let you add other audio files when they’re ready for recording.

Medium changer settings
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24
Creating HFS, Hybrid, 
or SCSI CD-ROMs 
(Mac OS)

This chapter teaches you how to create and open HFS and hybrid images. You can 
read about the following:

o Selecting a new HFS

o Creating a shared hybrid

o Performing a SCSI device dump

For information about editing tracks and track contents, volume settings and 
descriptors, see Chapter 28. For information about creating ISO, CD-ROM XA, 
and audio images, see Chapters 21–24. 

About Creating HFS Images

GEAR lets you copy to CD an HFS (Hierarchical File System) image from your 
Macintosh system or partition. When you copy that image from CD onto another 
system, it duplicates the structure of your desktop. Icon positions, folder and file 
names and structures, and so on will look exactly the same as the system from 
which they were copied.

About Creating Hybrid Images

You can also create a multi-platform CD image. This is known as a hybrid CD. For 
example, if you have an application that runs on more than one platform—
Microsoft® Word™, for example—you can copy the platform-specific applica-
tion and common data files to a CD. 
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When you load the CD contents on the Macintosh, your system sees the Macintosh-spe-
cific files and the files that are shared by the two platforms. Likewise, when you load the 
CD contents on your PC, your system sees the PC-specific files and the shared files, but 
not the Macintosh-specific files.

When you create a hybrid image that contains both HFS and ISO information, it appears 
as a standard Macintosh HFS image on a Macintosh and as a standard ISO image on a 
PC or Unix platform.

About Creating SCSI Device Images

GEAR also lets you create a CD-ROM from of any SCSI device that fits on a CD. This 
is useful when you want to back up information to CD from another CD or any SCSI 
device capable of keeping up the sustained data transfer rate to the CD recorder.

Creating an HFS or SCSI CD
1. In the Workbench window, choose one of the following from the CD Type pop-

up menu:

o Choose HFS Volume to record a Macintosh partition.

o Choose SCSI Device Dump to create an image of any SCSI device that’ll fit 
on a CD recordable.

2. Click the Select button.

3. In the dialog that appears, choose the partition you want to copy.

Note: The partition you choose must say OK.

Choose HFS Volume or SCSI 
Device Dump from the CD Type 
pop-up menu, then click Select
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4. In the Workbench window, click the Setup button to choose recorder settings. 
(See “Choosing Recorder Settings,” later in this chapter.)

Creating a Hybrid Image
1. In the Workbench window, choose Hybrid (HFS + ISO) from the CD type pop-

up.

2. Click the Select button.

3. In the dialog that appears, choose the partition you want to copy.

Note: The file you want to share must exist on this partition.

Locate and double-click the partition you want to copy; the list in-
dicates partitions that can’t be copied to HFS, as well as partitions 
that are currently in use (Files open)

Choose Hybrid (HFS + ISO) from the CD Type 
pop-up menu…

…then click Select
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Note: If you want to share files on this partition, the partition must be formatted into allocation-
block sizes of 2048 bytes or multiples of 2048 bytes.

Note: The partition you choose must say OK.

In the Workbench window, click the Setup button to choose recorder settings. (See 
“Choosing Recorder Settings,” later in this chapter.)

Choosing Recording Settings

You can specify the types of settings appropriate for your CD recorder in the CD 
Recorder Setup dialog. There are three types of settings:

o General

o Advanced

o Medium changer

General Recorder Settings

In the CD Recorder Setup dialog for General Recorder Settings, you can specify the 
speed at which you want to record: 1x, 2x, 4x, or 6x, depending on your recorder model. 

You can also specify whether to perform a test run. This simulation test disables record-
ing and lets you verify that your system performance is sufficient to record the CD. A 
test run copies your entire CD image to the recorder at the specified recording speed.

Either you can do a software estimate or perform a test run. A software estimate tests the 
rate at which data is transferred to the CD-R. This option is quicker than the Perform test 
run option but isn’t as accurate.

Locate and double-click the partition you want to copy; the list 
indicates partitions that can’t be copied to Hybrid, as well as 
partitions that are currently in use (Files open)
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Advanced Recorder Settings

In the CD Recorder Setup dialog for Advanced Recorder Settings, you can select a 
recording method: disc-at-once, track-at-once, or incremental, depending on your 
recorder model. 

Incremental lets you write in fixed packet size, which is determined by the recorder’s 
buffer to eliminate or minimize buffer underrun. 

Disc at once means your recorder writes the lead in, then the track data, then the lead 
out.

Note: You can’t use disc at once recording to record a multi-session disc.

Track at once means your recorder first writes the track data, then finalizes the disc by 
writing a lead in and lead out. This method is used in multi-session recording.

Until you fixate the disc, you can only read it on a CD recorder. You can use this option 
to record multiple tracks on a CD without recording in multiple sessions.

You can also specify whether to fixate the disc after recording (that is, record the lead 
in or lead out). 

If you don’t fixate the disc, you can specify a multi-session recording, that is, recording 
can occur over several different sessions on the same or different recorders.

General recorder settings
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Medium Changer Settings

In the CD Recorder Setup dialog for Medium Changer Settings, you can specify 
whether to use a CD changer or jukebox to load CDs for recording. You can also indi-
cate whether to scan slots in the medium changer: the first slot to use for loading and 
scanning, and the number of slots to scan. In addition, you can choose the drive number 
or the CD recorder to use.

Changing Recorder Settings

1. Click the Setup button in the Workbench window to display the CD Recorder 
Setup dialog or choose CD Recorder Setup (Edit menu).

2. Choose the type of recording settings you want to use:

o General Recorder Settings lets you specify speed and performance testing 
options.

o Advanced Recorder Settings lets you specify a recording method (that is, 
disc at once, track at once or incremental).

o Medium Changer Settings let you specify options for a jukebox or CD 
changer.

(For details about these options, see “Recording XA Tracks,” earlier in this chap-
ter.)

Advanced recorder settings

Medium changer settings



Elektroson GEAR

Creating HFS, Hybrid, or SCSI CD-ROMs (Mac OS) n 211

3. When you’ve specified your recording settings, click OK.

4. In the Workbench window, enter the number of copies you want to record.

5. Click the Write button to write the tracks to CD.
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25
Working With Multi-Session 
Discs (Mac OS)

GEAR lets you append a new session to any session that already exists on a multi-
session disc. This chapter discusses adding additional data to a disc and creating 
CD-Plus discs.

For information about creating images, see Chapters 21–24.

Multi-Session Discs

By appending a multi-session disc, you can do the following:

o Add data to the disc

o Recover data from older sessions

o Skip the last session if there are read errors

o Create CD Enhanced or CD Plus discs

One of the sessions on the previously-recorded disc is used as the basis for a new 
image. The contents of the image is edited and finally, the image is written to the 
CD-R disc. The virtual image contains the same folder/file structure as the session 
and is displayed in the image window.

Appending a Multi-Session Disc

To append a multi-session CD-R, your recorder must be turned on and a disc must 
be inserted in the CD recorder.
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1. To view the contents of the CD-R you want to append, click the View CD Info 
button in the Workbench window.

2. Click the Append Next Session button in the Workbench window or choose 
Append Next Session from the File menu.

3. In the Append Next Session dialog, choose the session you want to append the 
next session to and click OK.

4. In the dialog that appears, choose a location for the new image (admin) files, then 
click the Select button at the bottom of the dialog.

The Session window appears.

Click this button…
…then, choose the session 
you want to append

Locate and choose the folder 
where you want to save the 
image files…

…then, click this button
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Note: If you’re creating a CD-Plus disc, the first session would contain audio tracks and a single 
XA track in the second session.

The selected session on the CD-R disc is read and the virtual image is created.

If the original image files are still on your hard drive where you want to append the 
session, GEAR prompts you to overwrite the existing image or choose a different 
folder for the new image.

5. From the source list, locate the folders and files you want to copy:

o To copy multiple contiguous items, click the first item, then Shift-click addi-
tional items.

o To copy multiple non-contiguous items, click the first item, then Cmd-click 
additional items.

o To deselect selected items, Shift-click or Cmd-click them.

o To copy items from a folder that appears in the source list, select the folder, 
click the Open Folder button in the center of the window, then select the 
items.

6. To append files to the image, select them in the source list, then click the Copy 
Item button to add them to the CD contents list.

7. In the CD contents list, do any of the following:

Files and folders already on 
the CD are displayed here; 
the amount of space they 
take and the space remain-
ing are also displayed

Use these buttons to add items to or 
remove them from the CD contents list 
or to rename items in the contents list

Choose files and 
folders you want 
to append to the 
multi-session disc
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o Select an item and click the Remove Item button to remove the item from the 
list.

o Select an item and click the Rename Item button to change the item’s name.

8. When you’re finished, click the Done button.

Writing to CD

When you write the new session to CD, only changes will be written. Every time you 
write a new session, an additional 15 MB is added to the CD-R disc. This is known as 
overhead.

1. Click the Setup button in the Workbench window.

2. In the CD Recorder Setup dialog, choose a recording speed from the pop-up 
menu.

3. Do one of the following:

o To perform a hardware estimate, turn on the check box next to Perform test 
run (recording disabled). (If this check box is turned off, you can write your 
image to CD.)

o To perform a software estimate, turn on the check box next to Estimate 
transfer rate before recording.

4. Click OK to return to the Workbench window.

Choose the speed for your 
CD recorder

Use these check boxes to perform a test run 
without recording to CD or to estimate the 
data transfer rate before recording
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One of the following happens:

o If you turned on the Test check box to perform a hardware estimate, data is 
transferred from your hard disk to the recorder but the data isn’t written to 
the CD-R. This is a test run. If errors occur, your disc won’t be destroyed; 
you can resolve the errors and try again.

o If you click the Write button, data is written to the CD-R. When writing is 
complete, the CD is ejected from the CD recorder.

Enter the number of copies to make and click 
the Write button; GEAR uses the recording 
settings to test or append the CD
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26Working With 
Foreign Image Files 
(Mac OS)

This chapter provides information about working with images that were created 
using authoring or formatting packages other than GEAR. In this chapter, you can 
read about the following:

o Opening an external image

o Choosing a predefined format

o Choosing a custom format

o Recording a CD using track list

For information about virtual images you create in GEAR, see Chapters 21-24.

External Images

An external image refers to any image you’ve created using another authoring or 
formatting package, such as CD-I, 3DO, or VideoCD. You can’t edit an external 
image in GEAR, however, you can use GEAR to write an external image to a CD-
R disc or a premaster tape. Before you write an external image, you must select it 
and define its parameters.

CD-I Images

Most CD-I authoring tools generate a complete CD-I image, including EDC/ECC 
pregap and scrambling (GEAR type 10). This is done because these tools need to 
emulate the CD-I image. The second best optimal format is CD-I mode 2 with sec-
tor size 2336 (GEAR type 7).
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For information about writing the CD image, see “Writing Predefined Formats,” later in 
this chapter.

Photo CD Images

Photo CD images are always in XA format—CD-ROM XA mode 2 size 2336 (GEAR 
type 4) for external photo CD images.

For information about writing the CD image, see “Writing Predefined Formats,” later in 
this chapter.

Video CD Images

Video CD images are always in XA format—CD-ROM XA mode 2 size 2336 (GEAR 
type 4). Video CD and PhotoCD are both Bridge discs. Seep Appendix E for details.

For information about writing the CD image, see “Writing Predefined Formats,” later in 
this chapter.

Track List Images

A track list contains one or more lines where each line specifies a track on the CD-
ROM. Each line should contain a file specification followed by a caret (^) and a track 
type specification.

Writing a Predefined Image
1. In the Workbench window, choose PhotoCD, CD-I, or VideoCD from the CD 

Type pop-up menu.

2. Click the Select button. 

3. In the dialog that appears, choose the external image you want to write, then click 
the Select button.

4. In the Workbench window, click Record.

5. After you have recorded the image, click the Write button in the Workbench win-
dow to write the external image to CD. 

When the CD is written, it’s ejected from the CD record.



Elektroson GEAR

Working With Foreign Image Files (Mac OS) n 221

Writing a Custom Image
1. In the Workbench window, choose PhotoCD, CD-I, or VideoCD from the CD 

Type pop-up menu.

2. Click the Select button. 

3. In the dialog that appears, choose the external image you want to write, then click 
the Select button.

4. In the Foreign Images dialog, choose the options you want to use, then click OK.

5. In the Workbench window, click Record.

6. After you have recorded the image, click the Write button in the Workbench win-
dow to write the external image to CD. 

When the CD is written, it’s ejected from the CD record.

Writing a Track List
1. Use a text editor (SimpleText, for example) to create a track list.

2. Type thetrack filename followed by the caret (^) and the track type number.

(See the table of predefined formats on the next page for track type numbers.)

3. Continue to type each track name on a single line until you have entered all 
tracks, then save the file.

4. In the Workbench window, choose Track List from the CD Type pop-up menu.

5. In the dialog that appears, choose the track list file you want to write, then click 
the Select button.

6. In the Workbench window, click Record.

7. After you have recorded the image, click the Write button in the Workbench win-
dow to write the external image to CD. 

When the CD is written, it’s ejected from the CD recorder.

You can choose any of the following predefined formats

Type # Image Type Format External Volume Type

1 CD-ROM Mode 1 (ISO etc.), 
sector size 2048

Standard ISO, HFS, or CDTV 
image
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Things to Remember

Keep in mind the following about image types:

o The size of the pre-gap should always be two seconds (150 sectors). Scrambled 
images must contain sync, header, and EDC/ECC code information.

o Unscrambled images can be accepted with a 2,352 sector size without the sync, 
header, and EDC/ECC filled in.

2 CD-ROM Mode 1 (ISO etc.), 
sector size 2352

Standard ISO with EDC/ECC 
codes

3 CD-ROM Mode 1 (ISO etc.), 
sector size 2352, scrambled sec-
tors with 2 seconds pre-gap

ISO with EDC/ECC codes, pre-
gap, and scrambled

4 CD-ROM XA Mode 2, sector 
size 2336

Standard XA or EB XA (e.g., 
images with Mammoth XA 
streams)

5 CD-ROM XA Mode 2, sector 
size 2352

Standard XA with EDC/ECC 
codes

6 CD-ROM XA Mode 2, sector 
size 2352, scrambled sectors 
with 2 seconds pre-gap

XA with EDC/ECC codes, pre-
gap, and scrambled

7 CD-I Mode 2, sector size 2336 Standard CD-I without EDC/ECC 
codes

8 CD-I Mode 2, sector size 2352 Standard CD-I with EDC/ECC 
codes

9 CD-I Mode 2, sector size 2352 
with 2 seconds pre-gap

Standard CD-I with pre-gap, and 
EDC/ECC

10 CD-I Mode 2, sector size 2352, 
scramble sectors with 2 seconds 
pre-gap

CD-I with EDC/ECC codes, pre-
gap and scrambled; uses the same 
output format as that of most CD-I 
authoring tools

11 Standard CD digital audio Red Book audio (44.1kHz, 16 bit, 
stereo)

Type # Image Type Format (Continued) External Volume Type
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o The byte order of audio files must be the same byte order used by the computer run-
ning the GEAR software. If this is not the case, you can use the generic option 
MSBAudio= in the Gear Preferences file to make GEAR swap the audio bytes for 
all tracks.

With LSB audio default, if MSBAudio=TRUE, each track will be swapped by 
GEAR. Audio files should not contain any sound header. If sound headers are not 
removed or cleared, they will cause a sharp click in the resulting audio track on the 
CD. Audio files should contain only 16-bit samples and must be stereo (one sample 
for the left channel and one sample for the right channel) sampled on 44.1kHz.

o The external image files option lets you select one file only. If the external volume 
consists of more than one file, use track list files.

The track list file contains one or more lines where each line specifies a track of the 
CD-ROM (you can use a full path). For example, to write a mixed-mode image—
one that contains mode 1 or mode 2 data—you can specify the following lines in a 
track list file

Note: Place the track list and track contents in the same folder. Be sure to place a caret (^) 
with no space between the track name and image type.

track name path image type number

VIDEOTRACK^1/1

AUDIO1^/11

AUDIO2^/11
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27Working With Virtual 
Images (Mac OS)

This chapter provides information about working with virtual images that already 
contain data. In this chapter, you can read about the following:

o Editing tracks in a virtual image

o Editing virtual images

For information about creating a virtual image and tracks and loading their con-
tents, see Chapters 21-24. For information about working with foreign image files, 
see Chapter 26.

Working With an Existing Virtual Image

You can edit and write to GEAR virtual images, however, you can only write a for-
eign image file to a CD-R disc or tape. For information about writing GEAR 
images, see Chapter 28.

Opening an Existing Image for Editing

When you open an image, you must first close any image that’s already open. 
GEAR then opens the selected image
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Editing a Track

You can edit a selected image in the following ways:

o Add new folders or files

o Rename a folder or file

o Delete selected folders and files

Tip: To increase CD-ROM access time, limit the number of entries in a folder to 50 and limit 
the folder nesting to two or three folders.

Creating a New Folder In An Image

1. With the CD Image open, click Edit in the Workbench window.

2. In the dialog that appears, locate and choose the image.

3. In the Session window, click the New Folder button.

4. In the dialog that appears, enter a name for the new folder and click OK.

A valid name may consist of up to 30 uppercase, alphanumeric characters and 
underscores (_). For information about valid ISO-9660 file and directory naming, 
see Appendix E.

The new folder appears in the CD contents list in the Session window.

Creating Hidden Files

1. Choose Volume Setup from the Edit menu to display the Volume Setup dialog 
box.

2. From the pop-up menu, choose Volume Attributes.

Turn on this check box to 
hide new folders and files 
you create
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3. Turn on the check box next to Hide files that will be copied to the Image.

4. Click the Save Settings button.

Selecting and Deselecting Files and Folders

You can select one file or folder to rename or delete. You can also select multiple files 
and folders to delete.  

Renaming Files and Folders

1. Select a file or folder you want to rename.

2. Click the Rename Item button in the center of the Session window.

3. In the dialog that appears, enter a new name for the specified file or folder, then 
click OK.

This changes the name of the file or folder in the CD contents list only. The name 
of the file or folder on your hard disk doesn’t change.

4. Repeat steps 1–3 for additional files and folders.

Deleting Files and Folders

1. Select the files and folders you want to delete.

2. Click the Remove Item button in the center of the Session window.

To… Do this…

Select one file or folder Click the file or folder name to highlight it

Select multiple contiguous 
files and folders

Click the first file or folder name, then Shift-click 
the last file or folder name

Drag a group of file and folder names to
highlight them

Select multiple non-contigu-
ous files and folders

Click the first file or folder, then Cmd-click addi-
tional files or folders

Deselect selected contigu-
ous files or folders

Shift-click one of the highlighted file names

Deselect selected non-con-
tiguous files or folders

Cmd-click each highlighted file name
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3. In the dialog box that appears, confirm the deletion of the selected files and fold-
ers.

Editing Image Settings

You can edit image settings for the currently-selected image. The default values are 
specified in the GEAR preferences file. You can change these values using the Prefer-
ences command in the Edit menu. For detailed information about the GEAR preferences 
file, see Appendix C.

1. Choose Preferences from the Edit menu to display the Preferences dialog.

2. Choose Volume Attributes from the pop-up menu.

3. Choose the settings you want to use, then click the Save Settings button.

Editing a Volume Descriptor

You can edit the volume descriptor for the currently-selected volume. The default val-
ues are specified in the GEAR preferences file. You can change these values using the 
Preferences command in the Edit menu. For detailed information about the Gear Pref-
erences file settings, see Appendix C.

1. Choose Preferences from the Edit menu.

2. Choose Volume Descriptor from the pop-up menu.

You can change the maximum number 
of folders for the selected volume; the 
larger this number, the more overhead 
associated with the image—try to close-
ly estimate the number of folders 

This lets you hide files that 
will be copied to the image

Max Dir nesting level lets you specify the 
number of nested folders you can have on 
the CD; this should not exceed 12

This lets you tell GEAR how to handle 
invalid ISO names
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3. Enter the information you want to save, then click Save Settings.

Closing an Open Image

You can work with one image file only. In order to work with a different image file, you 
must close the open image.

1. If you’re in the Session window, click the Done button to return to the Work-
bench window.

2. To close the open image, click the Close CD Image File button in the Workbench 
window.

Enter in these fields the in-
formation you want to save 
about the volume

Click here to save your settings
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28Testing and Writing 
a Virtual Image File 
(Mac OS)

This chapter provides information about verifying virtual images and writing them 
to CD-R or premaster tape. You can read about the following:

o Verifying a virtual image

o Creating a physical image

o Estimating system performance

o Writing to CD-R

o Writing to a premaster tape

Verifying a Virtual Image

When you verify a virtual image, GEAR checks the size, date, and time stamp for 
each file in the track or image. If there are discrepancies, it usually means a file has 
been updated since it was loaded into the image and GEAR prompts you to update 
the image. You can update a track or image by reloading the reported files and fold-
ers.

1. Choose Verify CD-Image from the Options menu.

2. In the window that appears, choose the image you want to verify, then click 
the Verify button.
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Estimating System Performance

It’s a good idea to check your system’s performance before you write to CD-R. GEAR 
measures the time it needs to read all the information from the selected track or image 
and transfer it to the CD recorder using the current speed settings.

Note: This is a software estimate; it doesn’t take into consideration multiple SCSI controllers. 
While estimating your system’s performance is reliable, test-mode recording is accurate. See 
“Using Recording Enabled,” later in this chapter.

No data is transferred to the recorder during this process. If parts of the image can’t be 
read fast enough, GEAR warns you. You can try any of the following to optimize your 
system’s performance:

o Close any other software applications you’re running in the background.

o Use a defragmentation utility to defragment your hard disk.

o Check to see whether your hard disk does recalibration.

o Check to see if your SCSI termination is correct. An incorrect SCSI termination 
can cause delays on the SCSI bus.

o Use a physical image instead of a virtual image.

o Use a lower recording speed if one is available.

Important: The performance of a system for writing a CD-R is better if the access time of your 
hard disk is lower. This is more important than a fast processor. A lot of hard disks regularly 
perform recalibration. This means that the hard disk verifies its read/write operation to pre-
vent problems. If this happens during the writing of a CD-R disc, it may result in a data transfer 
problem. Refer to your hard disk documentation or speak with your supplier about whether 
your hard disk performs recalibration.

Estimating Performance

Important: Due to the nature of an estimate, the Estimate command doesn’t guarantee the 
disc will be successfully written later.

1. In the Workbench window, click the Setup button.
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2. In the CD Recorder Settings dialog, choose General Settings from the pop-up 
menu at the top of the dialog.

3. Turn on the check box next to Estimate transfer rate before recording, then click 
OK.

4. In the Workbench window, click the Test button.

GEAR performs the estimate. When the estimate is finished, GEAR reports whether 
the data transfer rate is fast enough.

Using Test Run Option In the CD Recorder Setup Dialog

If the CD recorder supports a test mode or write disable mode, you can turn on the check 
box next to Perform test run (recording disabled) in the CD-Recorder Settings dialog. 
This way, GEAR will check to see if the image can be written to CD-R. 

If the check box is turned off, all data is transferred to the CD recorder’s buffer but the 
disc isn’t actually written. Therefore, you can check system performance without 
recording a disc. 

Note: Test-mode recording takes the actual time that recording takes even though you’re not 
recording a disc.

Click Setup to display the 
CD Recorder Settings dialog

Turn on this check box 
to estimate hardware 
performance
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Creating a Physical Image

A physical image is a sector-by-sector copy of the CD-ROM you’re about to create. 
You should use a physical image for writing to
CD-R when the transfer rate for recording has to be increased. Otherwise, you can usu-
ally write with a virtual image.

Before you create a physical image, GEAR verifies the virtual image. If the file is not up 
to date, the physical image isn’t created. You can update the virtual image by reloading 
the reported files.

Depending on your needs, you can make a virtual image or an entire hard drive a phys-
ical image. The sector sizes for the tracks are based on their type as follows:

The physical image you create contains the current contents of the virtual image. Sub-
sequent changes you make to the virtual image don’t affect the current physical image.

The physical image file names are <image name>.pxx where xx stands for the track 
number. These files are always written to the GEAR working directory.

Converting the Image

Warning! If you choose the SCSI hard disk option in the Convert Image File dialog (see step 2, 
below), GEAR will reformat your hard disk into a physical image. You should do this only if you 
intend to use your entire hard disk as a physical image.

1. In the Workbench window, click the Convert CD Image File button.

2. In the dialog that appears, click the Physical image file button, then click Con-
vert.

Track Type Sector Size

ISO 2048 bytes

CD-ROM XA 2336 bytes

DA 2352 bytes
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3. If physical files already exist for the track or image, you are prompted to over-
write them.

When the track or physical image has been successfully created, it’s reported.

Writing a CD Image to CD-R Disc

When you write a CD image to a CD-R disc, GEAR uses either the virtual image or the 
physical image files. When the virtual image is used, the physical image is created as 
required and written to disc immediately. You can use physical image files if data trans-
fer rates to the recorder are not fast enough.

If the Estimate before write check box is turned on in the Recording Settings dialog 
(CD-R from the Settings submenu in the Options menu), GEAR checks your system 
performance before writing the selected image to CD-R. If the performance is suffi-
cient, GEAR continues to write the disc. If the performance is insufficient, writing is 
aborted.

Data Transfer Rates

The system has to maintain a high data transfer rate to a CD recorder. If the transfer rate 
can’t be maintained, the writing of the CD-R will fail. CD-R discs can be written at sin-
gle, double, or quadruple speeds. The data transfer rate is dependent on the speed of 
recording and the type of track written (ISO, CD-ROM XA, or CD digital audio). The 
following table shows the required transfer rates:

Click the Physical image file button 
to convert the virtual image to a 
physical image, then click the Con-
vert button

1x 2x 4x 6x

ISO 153 KB/s 307 KB/s 614 KB/s 918 KB/s

CD-ROM XA 175 KB/s 350 KB/s 700 Kb/s 1050 KB/s
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For external (foreign) images, the required transfer rate depends on the selected sector 
size. 2048 bytes/sector is comparable to ISO; 2336 bytes/sector is comparable to CD-
ROM XA; 2352 bytes/sector is comparable to CD digital audio.

Recommended Hard Disks

The best hard disks for writing CD-R discs are multimedia or AV (audio visual) hard 
disks. These types minimize recalibration time and guarantee a high sustained data rate.

Note: Call us or check the Elektroson BBS or CompuServe forum for updated lists of recom-
mended hard disks.

Files Created After Writing to CD-R

The CD-R command always creates the following files after you write an image: 

o wo_ident.txt 

o woresult.txt.

The wo_ident.txt file contains the table of contents (TOC) and some customer infor-
mation that’s written to the CD recorder. The customer information is read from the 
Gear preferences file. The woresult.txt file contains status information.

Writing to CD-R

1. With the virtual image you want to write open, click Write in the Workbench 
window.

CD Digital 
Audio

176 KB/s 352 KB/s 705 KB/s 1056 KB/s

1x 2x 4x 6x

Click here to write the image to CD-R
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2. If the physical image is available, GEAR uses the physical image by default. 

If the physical image is unavailable, GEAR uses the virtual image.

Writing to Premaster Tape

If you’re going to mass-duplicate your CD-R, you can write an image to premaster tape. 
The tape is written in ANSI (X3.27-1987) format. GEAR uses either the virtual image 
or the physical image. When you choose the virtual image, the physical image is created 
and written to tape immediately. Writing from a physical image is faster than writing 
from a virtual image.

You can send the premaster tape to a replication company for mastering and duplica-
tion. If the check box next to Verify tape after writing is turned on in the Tape Recording 
Setup dialog, GEAR verifies the contents of the tape with the image after writing to pre-
master tape.

Recommended Tape Drives

GEAR supports most tape units that provide a SCSI interface. The preferred configu-
ration is with an EXABYTE tape unit, a Hewlett Packard DAT unit (HP35470A), or an 
M4 9 track.

Files Created After Writing to Tape

The following files are created after an image is written to tape:

o tp_ident.txt

o tpresult.txt

o DDPID

o DDPMS

o PQDESCR

The tp_ident.txt files contains the table of contents (TOC) of the image written to tape 
and some customer information. The DDPID, DDPMS, and PQDESCR files form the 
DDP information of the last image written to tape. You can also write these files to tape.

Writing GEAR-Created Files to Premaster Tape

1. In the Workbench window, choose Tape Recorder from the Write to pop-up 
menu.
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2. Turn on the Write DDP files to tape and Write Tape Ident file to tape check 
boxes.

3. Click OK.

Writing an Image to Tape

1. With the image you want to write to tape open, click the Write button.

2. A dialog prompts you with instructions for preparing the tape unit for recording. 

When the unit is ready, click OK.

Turn on these check boxes to 
write the indicated files to tape

Click this button to 
write images to tape
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AGlossary

3DO A CD-ROM-based system in the same market segment as CD-I. Based on a RISC 
processor for optimum graphical performance.

access time The time a CD-ROM drive or hard disk needs to read and transfer data from disc 
to the target computer.

ActiveAudio™ A type of Enhanced CD. ActiveAudio is one of the approaches developers have 
taken to solve the problems that occur when you combine digital and audio data 
on one CD-ROM. ActiveAudio information is organized in this way:

o Digital data occupies the silence preceding track 1 (so called track 0)

o Audio data occupies track 1 and up

address The ID number of a device on the SCSI bus, or the location of a block of data in 
storage.

ADPCM Adaptive Differential Pulse Code Modulation. A method of compressed audio 
data storage. Instead of storing the signal, the difference between signals is stored. 
This means that only four bits per sample rather than 16 bits per sample are need-
ed.

For CD-I, levels A, B, and C are recognized. B and C are also used in CD-ROM 
XA. The sample frequencies used to measure the audio signals are 37.8 kHz and 
18.9 kHz for levels B and C, respectively. This brings the band width (the maxi-
mum frequency to be reproduced) to 17 kHz and 8.5 kHz. For level A, these fig-
ures are 44.1 kHz and 20kHz. Using ADPCM, a 16-fold reduction in storage 
requirements can be achieved (level C, mono).
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AIFF Audio Interchange File Format. It is a full-featured audio file specifica-
tion that allows many programs on multiple platforms to share standards 
for audio storage. Electronic Arts published the AIFF specification in 
1985. It started as a digital music instrument specification. Over the years 
it has been enhanced to provide compressed digital sound (AIFC).

alias records The stored information that tracks the locations of a file and its alias as 
well as the pointers to those locations.

ANSI American National Standards Institute. ANSI is a private, nonprofit 
membership organization that performs two functions:

o Coordinates the United States’ voluntary consensus standards sys-
tem

o Approves American National Standards

If you wish to contact ANSI, write or call: ANSI, 1430 Broadway, New 
York, NY 10018; (212) 354-3300.

ASCII American Standard Code for Information Interchange. A coding scheme 
that represents characters numerically. Almost every manufacturer uses 
the same coding for the first 128 symbols in the ASCII table. Different 
tables exist for ASCII numbers 128 through 255.

authoring Working method for modeling information. Examples of authoring sys-
tems include word processors and spreadsheets on a PC, and multimedia 
workstations for combining sound, video, images and text for real-time 
audiovisual presentations.

average seek time The average time it takes to locate data and position the drive head to that 
location. Average seek time is measured in milliseconds.

AVI Format for audio/video files defined by Microsoft for use under Win-
dows. The limited compression means a fast computer system with a fast 
storage medium is required. AVI is not well suited for use with CD-
ROM.

BER Bit Error Rate. Defined as the number of correctly processed bytes before 
an erroneous bit is detected. For CD-ROM, the bit error rate is 10-12.
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bit The smallest unit of information. (Bit is a contraction of binary and digit.) A binary 
digit has a value of 0 or 1.

BLER Block Error Rate. Compares the number of blocks with at least one error against the 
total number of blocks measured.

block The smallest “chunk” of memory accessed or transferred by a disk drive. Usually 512 
bytes in size, it can be larger in multiples of 512. The number of bytes in a block is the 
same as block size.

blown session A CD-ROM recording session that is disrupted such that the recorder literally loses 
track, rendering the recording medium, a writable compact disc, unusable.

buffer A temporary storage area for data being transferred from one place in the computer 
system to another.

byte A symbol or character that consists of eight bits.

cache A temporary storage area for information used frequently by your system. You can set 
up cache in RAM or on your hard disk. Using cache speeds up system response by re-
ducing the time it takes to locate requested information.

caching Used to store recently-requested information. On the next request for the same infor-
mation, the system retrieves it from fast cache memory rather than from the slower me-
dium.

CD Compact Disc. A non-magnetic, polished metal disk with a protective plastic coating. 
Used to store digital information, which can be read by an optical scanning device that 
uses a high-intensity light source—a laser—and mirrors.

CD-I Compact Disc Interactive. A system for presenting information such as text, images, 
and video, on a television screen. The standard is defined by Philips and Sony and de-
scribed in the Green Book.

CD Plus A type of Enhanced CD. CD Plus is one of the approaches developers have taken to 
solve the problems that occur when you combine digital and audio data on one CD-
ROM. CD Plus takes a multisession approach:

o Audio data occupies session 1

o Digital data occupies session 2

CD Recorder These drives, along with specialized mastering software, allow users to make their own 
compact discs. 
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CD-ROM Compact Disk, Read-Only Memory. Data is stored as pits on a disc sur-
face, which are read by a laser in the CD-ROM drive. The data can be 
read and copied; data cannot be erased; new data cannot be added.

CD-ROM XA Compact Disc Read Only Memory Extended Architecture. The standard 
for CD-ROM to which a number of options from CD-I have been added. 
These include audio compression (ADPCM), multi-channel audio, file 
interleaving, user data (2336 bytes/sector), image compression, and so 
on.

A CD-ROM XA disc is a Mode 2 disc in which the data in located in 
Form 1 (2048 bytes/sector) or Form 2 (2336 bytes/sector).

CD standards The physical aspects of different CD types defined by Philips and Sony. 
The logical file format used on CDs is described in the ISO-9660 stan-
dard. See Green Book, ISO-9660, Orange Book, Red Book, White Book, 
Yellow Book.

CDTcache

A feature of CDT that allows you to set cache values and other options 
for an individual CD, as opposed to an entire CD-ROM drive. CDTcache 
Setup values override the values set in Drive Setup.

central processing unit
(CPU)

The brains or “central switching station” of any computer.

DAT Digital Audio Tape. A 4mm tape format used for data storage.

data capture A method of converting data from non-electronic data carriers—paper, 
microfiche, artwork, and so on—into a form that allows processing by 
computer.

data
compression

A technique for removing unnecessary information from data. For exam-
ple, a repeating sequence can be stored as a value and the number of 
times it’s repeated.

data error Any discrepancy between the data recorded and the data read back.
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data transfer rate A measure of how quickly data is supplied to the computer from the CD-
ROM drive.

DDP Disc Description Protocol. A CD sector level protocol designed to ade-
quately describe a compact disc. A CD described using DDP can be reli-
ably mastered. Some mastering and replication companies prefer the 
premaster tape with DDP.

device driver The software program that translates commands between the Macin-
tosh’s operating system and the Macintosh’s SCSI Manager. It makes it 
possible for your Macintosh to talk to the devices attached to it.

directory, folder A file that contains information (name and location) about the files on a 
disk. Used in almost every storage medium (floppy, hard disk, CD-
ROM).

disc at once A method by which a disc is written. A CD recorder first writes the lead 
in, then the tack data, then the lead out. Link blocks are not inserted. Use-
ful for audio-only discs that must be an exact copy of an image. Compare 
track at once.

drive, CD drive The physical components necessary to read data from a CD.

drive, hard disk A data storage device that employs one or more rigid disks as the medi-
um of storage.

DVI Digital Video Interactive. A technology, developed by RCA and sold by 
Intel, that makes it possible to store compressed real-time audio and vid-
eo, then play it back decompressed at the correct speed.

dynamic Marked by continuous change or activity. The data held in dynamic 
RAM cache is swapped out as new data is accessed. It is marked by con-
tinuous change and activity.

dynamic RAM cache A RAM cache that grabs and holds information as it is read by a comput-
er. When full, dynamic RAM swaps out the oldest data with the newest 
data.

ECC/EDC Error Correction Code/Error Detection Code. Information used by the 
drive hardware to detect and correct data errors caused by scratches or 
dirt on a disc. Optimizes data integrity.
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CD-ROM uses only 2048 bytes of a sector of 2352 bytes for data storage. Header and 
synchronization information uses 12 and four bytes, respectively. The remaining 288 
bytes are used for ECC and EDC information.

electronic
publishing

Publishing process in which electronic media such as CD-ROM, floppy disk, and so 
on, are used rather than printing on paper.

encryption A complex reordering of information so that it becomes illegible. Encryption and de-
cryption are used together. some of the algorithms used are symmetrical, which means 
that double encryption restores the data to its original state.

enhanced CD-ROM Compact discs that combine digital and audio data on a single disc in a way that allows 
trouble-free use of the same disc on both an audio CD player and a CD-ROM drive.

extensions The files containing operations required for setting a device to a starting state before 
using data or implementing a process. The old name for this is “Inits.”

firmware An often-used microprogram or instruction stored in ROM. Usually refers to the 
ROM-based software that controls a drive.

Form 1 A subformat of Mode 2. Defines the structure of a CD-ROM sector as follows: sync 
(12 bytes); header (4 bytes); subheader (8 bytes); data (2048 bytes); EDC (4 bytes); 
ECC (276 bytes).

This subformat is used for normal data files including Photo CD and Electronic Book.

Form 2 A subformat of Mode 2. Defines the structure of a CD-ROM sector as follows: sync 
(12 bytes); header (4 bytes); subheader (8 bytes); data (2324 bytes); EDC (4 bytes).

This subformat is used for files where error correction is impossible due to real-time 
characters, that is, compressed audio or moving images.

fragmentation With use over time, the sectors of a file are written in different areas across the storage 
surface. This slows access time because the drive head must move to non-contiguous 
locations to read the contents of a file.

GB Gigabyte. 1024 MB = 1024 x 1024 x 1024 = 1,073,741,824 bytes

Green Book Defines the physical aspects of CD interactive (CD-I). See also standards.

hard disk A permanent storage medium for computer data based on a rotating disk with a mag-
netically sensitive layer. Information can be written on this and read again using a read/
write head. Information can also be deleted.
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HFS Hierarchical File System. Used by Apple for floppy and hard disk and for 
CD-ROM. Apple also supports the ISO-9660 standard.

High Sierra The predecessor of the ISO-9660 standard. Published by the CD-ROM 
Ad Hoc Advisory Committee, also known as the High Sierra Group, on 
May 28, 1986. Use of this standard is no longer recommended. ISO-9660 
is preferred.

inits Short for initialization. The operations required for setting a device to a 
starting state before using data or implementing a process. This is the old 
name for Extensions.

input/output (I/O) The communication flow between a Mac and the devices attached to it. 

intelligent Refers to a device capable of processing commands on its own.

interface The go-between that provides a common basis for communication be-
tween two otherwise incompatible devices.

image A virtual copy of the future CD-ROM disc stored on the hard disk. It is 
used for debugging and simulation sessions and for writing the final pre-
master tape and/or CD-R disc.

index A separate list of words or keys, sorted alphabetically or numerically 
along with a reference to their location in the text or the data base.

interactive
media

Media with which you interact to find information.

interface The point of contact between two systems. Interfaces can be items of 
equipment (e.g., SCSI interface between computer and CD-ROM player) 
or software modules (user interface).

ISO-9660 The international standard defining the CD-ROM data format. The aims 
of the standard are to achieve interchangeability of discs and to optimize 
performance. It is the official standard to which all CD-ROM applica-
tions should conform.

JPEG Joint Photographic Experts Group.
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KB Kilobytes. 1024 bytes.

kb/s Kilobytes per second.

LaserVision Video disc system.

latency The time, in milliseconds, it takes for the spinning disk platter to bring around the de-
sired sector to where the read/write head can access it. Does not include head position-
ing time. Contributes to access time. (See Interleaving.)

mastering The process in which a glass master is produced for production of the stampers which 
are in turn used for replication of the CDs. The glass master contains photosensitive 
lacquer that’s illuminated on a laser beam recorder (LBR). The data for mastering 
comes from a premaster tape.

MB Megabyte. 1024 x 1024 bytes.

Mb/s Megabytes per second, equal to 1,048,576 bytes per second, or 131,072 bytes per sec-
ond.

media Another term for the CD platter, but more specifically the surface of the platter that 
holds the data.

megabyte One million bytes (actually 1,048,576).

MMF Multimedia file.

Mode 1 Defines the structure of the CD-ROM sector as follows: sync (12bytes); header (4 
bytes); data (2084 bytes); reserved (8 bytes); ECC (276 bytes); and EDC (4 bytes).

Mode 2 Defines the structure of the CD-ROM sector as follows: sync (12 bytes); header (4 
bytes); subheader (8 bytes); remainder (2312 bytes) dependent on whether Form 1 or 
Form 2.

mount To appear on the Desktop. To show an icon on-screen.

MouseHelp A form of online help in CDT, available only in Setup. Turn MouseHelp on by select-
ing it from the Help menu in the menu bar. Point at something within the Setup window 
you want to know more about, and relevant information appears in a box in the lower 
portion of the application screen.

MPC Multimedia PC with a CD-ROM drive. Defined by Microsoft. An MPC application 
will work on an MPC computer.
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MPEG Motion Picture Experts Group. A standard compression method for motion video. The 
ISO standard used by Philips in their CD-I players. The algorithm used (discrete cosine 
transform) makes an extremely high rate of compression possible (200:1). MPEG vid-
eo and audio encoding form the basis for video-CD.

multisession An ISO standard CD-ROM format often referred to as “Orange book” that allows ad-
ditional information to be added to a writable CD-ROM disc that has already been 
written to once.

multivolume
CD-ROM

A CD-ROM with more than one mountable volume on it. In the instance where some 
of the volumes are in formats other than Apple’s HFS, using the Mounting feature in 
CDT will allow you to see the icons of all mountable volumes.

OEM Original Equipment Manufacturer. A company that manufactures a piece of hardware 
or software that is modified or reconfigured by a value-added reseller and sold (usual-
ly) under the reseller’s brand name.

Orange Book Specifies the physical aspects of CD-recordable media. The first part of the book de-
scribes CD-MO (magneto optical) system and the second part describes CD-WO 
(write once) system. The CD recorders and CD-R media are all based on the CD-WO 
standard. See also standards.

overhead The incidental command processing time that is necessary to complete a task.

partition A portion of a storage area allocated to a particular use or user.

PCM Pulse Code Modulation. A technique for converting analog audio into CD digital au-
dio.

peripheral A device that is attached to the computer, either directly or via the bus.

physical
image

The actual bit-to-bit copy of the future CD-ROM disc, without ECC and EDC infor-
mation. Usually a physical image can be as large as 600MB and will demand a lot of 
hard disk space (all data will be present in the original files and once more in the image 
file).

If an image consists of multiple tracks, a separate image file is created for each track. 
However, GEAR allows you to make an application without the need for so much hard 
disk space by using a virtual image, which is just an administration of the image struc-
ture.

platter The rigid disk that is used for storing data on hard disk drives.
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premaster
tape

The tape that CD manufacturers use to create the CD-ROM master, which is used to 
make the actual CD-ROMs. The premaster tape is written from the image in the format 
as specified by the CD-ROM manufacturer (possibly in DDP format).

proprietary Vendor-unique technology or devices that are incompatible with other products in the 
industry.

QuickTime An Extension of the Macintosh system software that provides facilities for managing 
time-based data.

read ahead Similar to buffering, except Read Ahead can read ahead to the next expected data. This 
prepares data for the CPU’s next request, speeding up access time.

Red Book A book (with a red binder) that defines the physical aspects of digital audio CDs (CD-
DA). See also Green Book, Orange Book, standards, White Book, and Yellow Book.

replication The process of producing identical copies of a CD-ROM from a stamper or matrix.

retrieval Term for locating information in databases. Retrieval takes place on the basis of index-
es present.

SCSI ID A device’s unique address on the SCSI bus, referred to as its ID, or identification.

SCSI
interface

Small Computer Standard Interface. (Pronounced scuzzi.) An industry standard for the 
interface between computers and peripherals.

SCSI manager The SCSI Manager is part of the Macintosh Operating System that provides the inter-
face between a program, such as a driver or formatter, and the actual hardware SCSI 
port.

sector A piece of data (a number of bytes) on disc. The size is 2352 bytes. CD-ROM uses 
2048 bytes for data storage. Header and synchronization information uses 12 and 4 
bytes, respectively. The remaining 288 bytes are used for ECC and EDC information.

The 2 KB of data in every sector can be divided into logical blocks of 512, 1024, or 
2048 bytes. Every sector on a CD-ROM disc has a unique address by which it can be 
accessed.

seek time The time it takes the read/write head to move back and forth in search of the appropri-
ate track. Seek time does not include latency or command overhead. (See Access 
Time.)
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session One contiguous, spiraling string of data written to, or stamped into, a disc. There may 
be more than one session on a disc. A track is a portion, possibly all, of a session. A 
session may contain many tracks, but a track may not contain a session.

SGML Standardized General Markup Language. An ISO standard that uses tags to add struc-
ture to information, usually text. Various structural components are indicated within 
the information, e.g., title, subtitles, paragraphs, footnotes, and cross references.

single-session Refers to standard CD-ROM discs where multisession format is not present.

stamping Manufacturing data into a disc (as opposed as writing data to a writable disc).

standards Green Book: The CD-I, CD interactive, standard. Operating system and playback 
hardware specifications for mixed mode CD-ROMs.

Orange Book: Standard for write-once (multisession) CD. A Sony/Philips collabora-
tion that details physical and optical characteristics of Compact Disc Write Once me-
dia, and hybrid ROM/WO discs, which have read-only and write once areas on the 
same disc. This technology is becoming increasingly cost effective. Discs for record-
ing use gold as a substrate metal instead of the aluminum employed by mass-market 
stamped discs, but may employ both.

Red Book: Standard for normal audio CD. Refers to the specifications for the compact 
audio disc format developed by Philips and Sony. It is the standard format of commer-
cial audio CDs. When a disc conforms to the Red Book standard, it will usually have 
“digital audio” printed beneath the disc logo.

In 1983 a consortium of Philips (N.V.) and Sony drafted a comprehensive document 
to thoroughly define the Compact Disc Digital Audio standard. This document, named 
for the color of its cover, describes the physical dimensions, optical characteristics, and 
logical organization, including the table of contents, track, and audio stream formats 
of a compact disc. This is the seminal compact disc document, from which all subse-
quent standards are derived.

White Book: Standard for Video CD. JVC, Matsushita, Sony, and Philips coauthored 
this specification, also known as the “Video CD Standard.” This remains a nascent 
technology, waiting for CD-ROM technology and the right marketing approach.

Yellow Book: Standard for CD-ROM. A standards document that builds on the Red 
Book Standard allowing for the presence of data tracks on a CD. The Yellow Book 
standard specifies that CD-ROM must encode the first track as data. In addition to the 
two layers of error correction outlined in the Red Book, data is further protected by a 
third layer of error detection and correction for added security.
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When a disc conforms to Yellow Book standard, it usually will say “data storage” be-
neath the disc logo.

static Having no motion. Being at rest. The data held in Static RAM cache is the first data 
accessed up to the limit of the cache. It does not change as new information is accessed. 
It has no motion. It is at rest.

subcode Information (time, text, graphical, or MIDI) stored together with audio on a CD and 
spread across eight channels (PQRSTUVW). P and Q contain the time information 
shown on the display of an audio CD player.

thermal
recalibration

The process of recalculating the positions of data on a hard disk platter as those posi-
tions shift due to the platters expansion under the heat of operation.

track A CD-ROM disc can contain more than one track. Tracks are implemented sequential-
ly (like a CD audio disc). If a CD-ROM contains multiple tracks, the data part is always 
stored in the first track and the audio parts (in the case of a mixed mode CD-ROM) are 
stored in the following tracks.

track 1 problem An audio player, when given digital data on track 1, might do a number of things:

o Skip it

o Refuse to play it

o Play silence

o Play the data (sounds like static)

When you attempt to play data on your audio equipment, you are likely to damage your 
speakers

transfer rate The speed at which information can be transferred. Usually expressed in terms of KB 
per second. A standard CD-ROM drive is rated at 150KB/second. A double speed 
player can handle 300KB/second.

unicode Coding of character sets making use of 2 bytes. ASCII is a subset of unicode.

virtual
image

Making a CD-ROM image usually requires an exceptional amount of hard disk space; 
all data is present in the original files and duplicated in the CD-ROM image. GEAR lets 
you make an application, without the need for so much hard disk space by producing 
a virtual image that is just an administration of the image structure.

The software keeps a record of the files to be included in the final application. Simu-
lation and writing of the final premaster tape or CD-R is done using this volume ad-
ministration, thereby eliminating the need for a lot of expensive hard disk capacity.
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A CD-ROM can contain multiple tracks in which case multiple virtual tracks are cre-
ated; an administration is kept for every track of the CD-ROM.

virtual track See virtual image.

volume The CD-ROM term for a complete CD-ROM disc. In case of very large databases, 
multiple discs can be issued forming a volume set. When a mixed-mode disc is made, 
a volume will contain multiple tracks.

VATIC Volume Table of Contents. This is the portion of the CD-ROM disc that contains basic 
information about the disc, such as its name, copyright information, pointers to various 
blocks of data, whether the disc is a member of a multi-volume set, dates, version, 
numbers, etc.

White Book Specifies the physical aspects of video CDs. See also standards.

Yellow Book Defines the physical aspects of CD-ROM. A special extension of this book describes 
CD-ROM XA (compact disc extended architecture). See also standards.
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BGEAR Commands

Using GEAR Commands in Windows

You can insert GEAR commands in batch files or you can use them as a single com-
mand line. When you use commands, you must enter them as follows:

command_name <y|n> <parameter> [optional]

A parameter that’s enclosed in angular brackets (< and >) is a required parameter. 
A parameter that’s enclosed in square brackets ([ and ]) is an optional parameter. A 
bar (|) between two parameters indicates that a selection between two or more 
parameters has to be made.

Special keys, such as Escape and Carriage Return, are abbreviated and enclosed in 
angular brackets—<ESC>, <RETURN>.

When you don’t specify a parameter, GEAR prompts you for the missing param-
eter. The default value is displayed between brackets. You can select it by pressing 
<ENTER>.

The same holds true when extra information is required. You can interrupt a com-
mand by pressing <ESC>. GEAR may take a short time to stop executing the com-
mand because commands must release system resources they’re no longer using.

General Commands

The following are general commands you can use.
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BATCH <file_name>

Starts executing commands from the specified batch file. 

EXIT

Ends the current GEAR session.

HELP [<cmd>]

Provides information about the command. Entering an invalid command name or no 
command name displays a list of all available commands.

LOG <file_name>

Starts or stops the logging of session information in a specified file. When you start log-
ging for the first time, you have to enter the name of the file where you want to store the 
information. 

VDIR

An overview of all current volumes contains the following:

o Volume name and size

o Session number

o Number of tracks in the volume

o Type of volume

o Status of volume

o Date and time stamp for the volume

For an ISO-9660 volume, the number of tracks is always 1 and the type is always ISO. 
Multimedia volumes let you create additional tracks of different types. The session 
number is always 1 for volumes you create with the NEWVOL command. Only vol-
umes you create with the SESSION command can have a session number greater than 1. 

The status of a volume can be either Selected or Closed. A volume is selected if it’s cur-
rently used. Otherwise, the status of a volume is closed.

The date and time stamp of the volume is determined using the time zone (TZ) envi-
ronment variable. If you don’t specify this variable, the data and time is shown for the 
Pacific time zone.
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TDIR

An overview of all tracks that are present in the currently-selected volume is displayed. 
The overview consists of the following:

o Track number and size

o Type and status of track

o Data and time stamp for the volume

The type of track can be XA, DA, or ISO. That status of a track can be either Selected 
or Closed. A track is selected if it’s open for copying data to it. Otherwise the status is 
closed.

The date and time stamp of the track is determined using the time zone (TZ) environ-
ment variable. If you don’t specify this variable, the data and time is shown for the 
Pacific time zone.

Formatting Commands

You can use the formatting commands to format CD-ROM files. A variety of com-
mands is available to generate an empty image and to add, delete, or change files and 
directories in it. In addition, the following commands are valid:

o Volume-related commands

o Track-related commands

o Directory- and file-related commands

o Multimedia-related commands

o Miscellaneous commands

Volume-Related Commands

The following are volume-related commands.

NEWVOL <vol_name> <80|74|63|18>

Creates a new empty virtual volume with the name you specify. The new volume is 
selected automatically. The name may contain up to eight alphanumeric characters and 
underscores. To give your volume a longer name, use the PRIMVD command to 
rename the volume identifier. 

SELVOL <vol_name>

Selects an existing volume for use. If a volume is already selected, it’s closed. You must 
select a volume before you can edit its contents. 
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SESSION <session_nr>

Used to append data to a multi-session disc. 

PRIMVD

Lets you edit settings in the volume descriptor. You can change the following:

o VolumeIdentifier

o SystemIdentifier

o PublisherIdentifier

o DataPreparerIdentifier

o ApplicationIdentifier

o ApplicationUse

o CopyRightIdentifier

o AbstractFieldIdentifier

o BibliographicIdentifier

You can change the default values in the gear.ini file using the EDITPREFS command. 

EDITVOL

Lets you edit the generator setup settings used to create a volume. You can change the 
following:

o NonIsoNameHandling

o Hidden option

o StartSector option

o Archive option

o Maximum directory nesting level

You can change the default values in the gear.ini file using the EDITPREFS command. 

PHYSVOL

Creates the physical image files for the selected volume. For the entire CD, a physical 
image is created. You can also use the PHYSTRK command to create physical image of 
individual tracks.

VERVOL

Verifies the virtual image of the selected volume.



Elektroson GEAR

n 257

DELVOL<vol_name>

Deletes the specified virtual volume.

Track-Related Commands

The following are track-related commands:

SELTRK <track_nr>

Selects an existing track for use. The previously selected track is minimized and closed 
and the specified track is selected. 

NEWTRK<ISO|XA|DA> [<track_nr>]

Creates a new empty virtual volume of the specified type. The new track is automati-
cally selected. 

PHYSTRK[<file_name>]

Creates a physical image file of the selected track. If the optional parameter, 
<file_name>, is specified, the image will be written to this directory and not the work-
ing directory, for example, using PHYSTRK D:\IMAGES\IMAGE1. GEAR automat-
ically finds the physical image when necessary, for example, when using the physical 
image for the WRITE command). 

VERTRK

Verifies the virtual image of the selected track. 

DELTRK<track_nr>

Deletes the specified virtual track.

Directory and File Related Commands

The following are directory- and file-related commands:

CD<dir_name>

Changes from the current directory to the specified directory of the virtual image. The 
command recognizes DOS commands such as, CD .., CD\, and CD\SUB1. You can also 
specify a path name for a new directory. 
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NEWDIR<dir_name>

Creates a new directory on the virtual image. You can create hidden directories by 
changing the HIDDEN option to TRUE before you create the new directory. See the 
EDITPREFS command.

DELDIR<dir_name>

Deletes the specified directory in the virtual image. Wildcards are disallowed. A direc-
tory must be empty before you can delete it. You can delete complete directories using 
the DELTREE command. 

COPY<file_spec>

Copies the specified files to the virtual image. Wildcards are allowed. 

You can specify the exact location (sector number) for the files by specifying TRUE for 
the SECTOR command. GEAR prompts you for the start location of each file to load.

You can also hide files by changing the HIDDEN option to TRUE before you copy the 
files. You can’t change the HIDDEN option afterwards; you must delete the files, reset 
the HIDDEN option, then reload the files. See the EDITPREFS command.

COPYTREE<os_dir_tree>[<cd_dir>]

Copies a directory tree to the virtual image. All files and subdirectories of the tree you 
specify are loaded automatically. Subdirectories are created in the image if necessary.

After completion, the virtual image contains and exact copy of the tree. The target direc-
tory specifies where in the virtual image the OS directory will be loaded. GEAR creates 
as much space as necessary for each directory in the tree. You can nest up to eight direc-
tories s under ISO.

RENAME<old_name><new_name>

Renames a directory or file in the virtual volume to the new name. Wildcards are dis-
allowed.

DELETE<file_spec>

Deletes the file you specify from the virtual image. You can specify files by their full 
name, including the version number. Wildcards are allowed, for example, *.*;* deletes 
all files in the current directory. If files with non-ISO names have been loaded, you can 
omit the version number.
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DELTREE<dir_tree>

Deletes the ISO tree form the virtual image. The directory you specify and its subdi-
rectories are deleted. Wildcards are disallowed.

Multi-media Related Commands

The following are multimedia-related commands. You can use these commands only 
when you select an XA track.

COPYMMF<file_spec><mmtype><chnr><int_fac><tot_fac>[<EOR|TRG>]

Copies the multimedia files you specify to the virtual XA track. You must specify the 
following parameters:

You can obtain more information about the use of the parameters for CD-ROM XA 
applications in the CD-ROM XA specification [4].

Usually it’s easier to use the dedicated CD-ROM XA interleaver tools, such as the 
Mammoth Tool Set, for creating these files and use the GEAR COPYXA command to 
load pre-interleaved multimedia files.

COPYXA<file_spec>

Copies the files you specify as pre-interleaved files to the image.

Parameter For each file that’s loaded

mmtype Type

chnr Channel number

int_fac Interleave factor (see also tot_fac)

tot_fac Total interleave factor; This number, together with int_fac 
determines the interleaving of each file.

EOR End of record bit should be set in the subheader of the last sec-
tor of each file that’s loaded. Can specify together with TRG 
(see below).

TRG Specifies whether the trigger bit should be set in the subheader 
of the last sector of each file that’s loaded. Can specify together 
with EOR (see above).
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Miscellaneous Commands

EDITPREFS

Use this command to change the generator settings. You can also change some of these 
settings with the PRIMVD command. The difference is that the EDITPREFS command 
changes the contents of the gear.ini file while the PRIMVD command changes the set-
tings for the selected volume only. Settings in the gear.ini file are used for each new vol-
ume.

FREE

Displays the amount of free space (bytes) on the selected virtual volume. This com-
mand can take some time if you have a large volume with a lot of empty space.

DIR[<dir_name>][/P][/S]

Displays all the files and directories in the specified directory of the track you select. If 
dir_name is unspecified, the current directory is displayed. for each entry, the following 
is displayed:

o Name

o Directory (<DIR>) if it’s a directory

o Hidden (H) or normal (n) entry

o Startsector of the file

o Date and time stamp

o Size in bytes

The /S option displays the contents of the subdirectories. The /P option is used to gen-
erate a printout. the total number of files listed is displayed at the end of the printout.

CD-R COMMANDS

You can use the following commands when you write a volume to CD-R disc.

MOVEMEDIUM<src_address><dest_address>

Moves a caddy/disc from one location (address) to another in the jukebox. Storage slots 
are number form location 1 to 1000. Drivers (CD recorders and CD readers) are num-
bered from location 1001 to 2000. the mailbox of the jukebox has location number 
2001. The grippers—the device that actually moves the medium—are numbered 3001 
and 3002.
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WRITECD<volume_name>[<nrofcopies>]

Writes a GEAR volume to disc. You can use the number of copies parameter to write 
multiple discs of the same volume. If a medium changer (supported by GEAR) is con-
nected to the same SCSI bus as the CD recorder, GEAR uses the medium changer to 
change the discs. otherwise, you are prompted to perform the medium change.

WRITECD<foreign_image_name|track_list_file_name>
[<nrofcopies>][X][<type>]

Used when you work with external volumes. The optional character X indicates that the 
specified name should be interpreted as a foreign image or track list file.

ESTIMATE<volume_name>

Checks the performance of your system for writing the external volume to CD-R disc.

ESTIMATE<foreign_image_name|track_list_file_name>
[X][<type>]

Checks the performance of your system for writing the external volume to CD-R disc. 
The optional character X indicates that the specified name should be interpreted as a 
foreign image or track list file.

DISCINFO

Displays information about the disc in the CD recorder.

SETUPCD

Defines the settings used when you write the CD-R disc and/or while estimating the per-
formance. You can specify the following:

To do this… Specify…

Use the physical image Yes or No

Write a multi-session CD-R Yes or No

Use the CD recorder’s test mode Yes or No

Write a CD-R disc with 1x, 2x, or 4x speed 1, 2, or 4

Fixate the CD-R after writing Yes or No

Linear velocity to use for writing 1, 2, or 3
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This information is saved in gear.ini. You can either edit gear.ini using a text editor or 
use the SETUP command to change the settings.

FIXATION

Checks the currently-loaded disc. Fixates the disc if it isn’t already. You can use this 
command with track-at-once CD-Rs. All tracks are written separately to the CD-R with 
the fixation entry in the gear.ini file set to False. You can then fixate the tracks using this 
command after all tracks have been written.

Warning! If an image isn’t fixated, you can’t read it on a CD-ROM player.

READTRACK<nr><file>

Reads all the sectors of the specified track from the CD-R disc then saves them in the 
specified file. The amount of information read depends on the track type. This com-
mand will determine automatically the track type, size, and start position, then start 
copying.

For ISO tracks (mode 1), 2048 bytes are read per sector. For CD-ROM XA and CD-I 
(mode 2), 2336 bytes are read per sector. For CD digital audio, 2352 bytes are read per 
sector. Not all CD recorders support the reading of CD digital audio and/or CD-I tracks.

Files you create with this command can be written to a CD-R disc again as external 
image files.

LISTCD

Displays the selected setup settings used for estimating and writing.

Premaster Tape Commands

The following are premaster-tape related commands:

WRITETP<volume_name>

Writes the GEAR volume to premaster tape.

Number of CD recorders to be addressed 1 to 32

To do this… (Continued) Specify…
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WRITETP<foreign_image_name|track_list_file_name>
[X][<type>]

Used to write external volumes. the optional X character indicates that the specified 
name should be interpreted as a foreign image or track list file.

VERIFY<volume_name>

Verifies the volume by comparing it to the volume on tape. Before the verification, 
GEAR prompts you to use the current setup values. These values determine whether the 
virtual volume or the physical image file is used for verification. The setup values must 
be the same as those you use for writing the tape.

VERIFY<foreign_image_name|track_list_file_name>
[X][<type>]

Used to verify an external volume. the optional X character indicates the specified name 
should be interpreted as a foreign image or track list field. All setup values are used 
except for the value that determines whether the virtual image or the physical image file 
is used. The file is interpreted as a physical CD-ROM image file or as a track list file, 
which specifies multiple image files. See the WRITE command.

SETUPTP

Defines the setup values that are used while writing or verifying the premaster tape.

In general, it’s sufficient to use the default values specified in the gear.ini file. You can 
edit the gear.ini file in a text editor or you can us the SETUP command to change theses 
values.

LISTTP

Displays the selected setup values that are used for verification and writing.

Using GEAR Commands in Mac/OS

The following sections discuss the commands available in GEAR’s File, Edit, and 
Options menus. 

File Menu Commands

The following sections describe the Tools menu commands. 
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New CD Image, Cmd-N

Creates a new CD image. You can create the following types of 
images:

o ISO

o XA

o DA (Audio)

o Mixed Mode ISO or XA

o HFS Volume

o Hybrid (HFS + ISO)

o Foreign (CD-I, Photo CD, Video CD, Custom Format, CD From Track List)

o SCSI Device Dump

Open CD Image, Cmd-O

Opens an existing CD image.

Close CD Image

Closes the open image without quitting GEAR.

Append Next Session

Adds files to an existing multi-session image.

Test Run/Write

Performs a test run before you write to CD-R to verify the data transfer rate.

Delete CD Image, Cmd-D

Deletes the selected virtual image and its administration files.

Start Log, Cmd-L

Opens a log window that tracks the activities you perform.

Quit, Cmd-Q

Exits GEAR.
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Edit Menu Commands

Use these commands to edit images, choose setup volume, CD recorder, and tape 
recorder options, and to change preferences.

Undo, Cmd-Z

Reverses the last action you performed.

Cut, Cmd-X

Removes a selected item and places it on the Clipboard.

Copy, Cmd-C

Places a copy of a selected item on the Clipboard.

Paste, Cmd-V

Places cut or copied items from the Clipboard where you click.

Clear, Cmd-K

Removes a selected item without placing it on the Clipboard.

Volume Setup

Lets you choose options such as volume attributes, and a volume descriptor.

CD Recorder Setup

Lets you choose general, advanced, and medium changer options before you write to a 
CD-R.

Tape Setup

Lets you choose general, strategy, and track specification options before you write to 
premaster tape.

Preferences, Cmd-Y

Lets you change and save settings in the Gear Preferences file.
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Options Menu Commands

These commands let you verify and convert CD images, copy CD tracks, view CD info, 
and choose jukebox settings.

Verify CD-Image

Lets you check the size, date, and time stamp for each file in a track or image. If there 
are discrepancies, it usually means a file has been updated since it was loaded into the 
image. GEAR prompts you to update the image by reloading the reported files and fold-
ers.

Convert CD-Image

Lets you convert a virtual image to a physical image or a hard drive. A physical image 
is a sector-by-sector copy of the CD-ROM you’re about to create and contains the cur-
rent contents of the virtual image.

Copy CD Track

Lets you copy a CD track on a CD-R to a virtual image on your hard disk.

View CD Info, Cmd-I

Lets you view the contents of a CD in a CD recorder.

Jukebox Control

Controls jukeboxes that GEAR supports.

Keep in mind the following:

o Currently, GEAR supports the ASM, K&S, and Pioneer jukeboxes, and the Kodak 
Disc Transporter.

o If you want to use a jukebox to write several CD-Rs unattended, make sure they’re 
loaded consecutively beginning in slot 1.
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CThe GEAR Initialization/
Preferences File

The gear.ini File in Windows

The gear.ini file contains information used by GEAR. You can edit the gear.ini file 
with any text editor. It’s a good idea—before you begin to edit the file—to make a 
backup copy of it with a different name.

During startup, GEAR tries to locate the gear.ini file in the current working direc-
tory. If the file isn’t in the current working directory, the GEARDIR environment 
variable is used to locate it. Without the information in gear.ini, GEAR can’t run 
properly and will notify you if it can’t find the gear.ini file.

The following are parts of the gear.ini file.
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Generic information

CD recording information

Hard disk information

Generator information

Tape information
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You can change the information in the gear.ini file with a standard text editor like Win-
dows Notepad, however, we recommend you use the commands available in the GEAR 
menus. For details, see Chapter 8 and Appendix B.

As you look at the gear.ini file, keep in mind the following points:

o Lines that start with a semicolon are treated as comments—information that 
doesn’t affect how GEAR performs.

o You must enter parameters immediately after the = sign; parameters are interpreted 
beginning with the first character that follows the = sign.

o All parameters are case sensitive.

Generic Information

The first part of the gear.ini files contains the information described in the following 
sections.

Working Directory

This parameter—under generic—specifies the directory in which GEAR looks for the 
volume administration files during startup. If this parameter is not specified, GEAR 
uses the directory specified as the working directory in the program Properties dialog in 
the GEAR program group.

WorkingDirectory=C:\GEARIMG

MSBAudio

This parameter—under generic—specifies whether the audio for all tracks is MSB 
(most significant byte first). The default value is False. This is an optional parameter. 
Valid values are True or False.

MSBAUDIO=False

Warning! If you don’t verify this parameter is set correctly, writing might fail. This 
is most common when a file has been changed unexpectedly. Use this option with 
care. 

Display Parameters

These parameters—under generic—store the dimensions of the three main windows 
that are displayed when you run GEAR: working window, Status window, and the File 
Manager window. GEAR uses this information to position and size these windows on 
your screen when you first start the program. 
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Warning! Do not change these values manually.

Customer Information

The first three customer information parameters—under generic—can be the same for 
all your CD-ROM titles. 

CustomerName=your own name
CustomerContact=your contact person
CustomerPhone=your telephone number

The last three fields are usually different for each CD-ROM title.

MasterIDCode=your mastering code
ReferenceCode=your reference code
DiscTitle=your new CD title

This information is written to the tp_ident.txt and wo_ident.txt files when you write to 
a premaster tape or CD-R disc. Some premaster companies ask you to supply this infor-
mation on premaster tape and/or paper.

Generation Information

The following sections describe the information in the generation part of the gear.ini 
file. This information is used when you create a new volume. Afterwards, you can 
change the information for a selected volume using the Volume Descriptor command in 
the Edit menu in GEAR. All identifiers must conform to the ISO standard for inter-
change level 1. For information, see Appendix A. GEAR uses the default values if the 
parameters aren’t specified.

SystemIdf

Identifies the system. The default value is an empty string.

PublisherIdf

Identifies the person who specified the content of the volume set for this volume. If the 
first character is an underscore (_), the rest of the parameter specifies an identifier for a 
file that contains the publisher identification. This file has to be loaded in the root direc-
tory. The default value is an empty string.

If the name begins with an underscore, an extension and/or version number may be 
omitted.
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DatePreparerIdf

Identifies the person or other entity that controls the preparation of the data to be 
recorded on the volume. If the first character is an underscore, the rest of the field spec-
ifies an identifier for the file that contains the data preparer identification. This file has 
to be loaded in the root directory. The default value is an empty string.

ApplicationIdf

Identifies the specification of how the data is recorded on the volume set that this vol-
ume belongs to. If the first character is an underscore, the rest of the parameter specifies 
an identifier for the file that contains the application identification. This file has to be 
loaded in the root directory. The default value is an empty string.

ApplicationUse

Identifies the language for an EB (XA) disc. The default value is an empty string.

CopyRightFileIdf

Specifies the identification for a file that contains the copyright statement for the vol-
ume set. The file is loaded in the root directory. The default value is an empty string.

AbstractFileIdf

Identifies for the file that contains the abstract statement for the volume set. This file is 
loaded in the root directory. The default value is an empty string.

BibliographicFileIdf

Identifies for a file that contains bibliographic records interpreted according to stan-
dards that are the subject of an agreement between the originator and the recipient of the 
volume. This file is loaded in the root directory. The default value is an empty string.

MaxDirNestingLevel

Identifies the maximum nesting levels for directories on the CD. The root level is 1. ISO 
allows directory nesting up to eight levels. GEAR allows a directory nesting up to 12 
levels. The default value is 8.

MaxNrDirsInVolume

Specifies the maximum number of directories in the volume in order to calculate the 
number of blocks needed for the path tables. This number may not be larger than 65535. 
The default value is 500.
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ArchivesOnly

DOS uses this parameter to determine if a file has to be backed up. Tape archiving soft-
ware usually only archives files that have the archive bit set. This information is reset 
when the file is written to tape. 

GEAR offers you the same functionality for CD-R writing. When the Archives Only 
check box is turned on in the Volume Settings dialog (Edit menu), GEAR loads into the 
image only files with the archive bit set. The archive bit is reset when the file is suc-
cessfully loaded into the GEAR image. Valid values are True and False. The default 
value is False.

NonISONameHandling

Specifies how non-ISO names for files and directories are handled. Valid values are:

When the 
value is…

This happens…

0 (default) For each non-ISO name encountered, a dialog prompts you to 
translate to an ISO-compliant name or skip the name.

1 Non-ISO names are ignored; files are loaded with their original 
names.

2 Lowercase characters are translated to uppercase characters. For 
names that still contain non-ISO characters, a dialog prompts you 
to translate to an ISO-compliant name or skip the name. This 
value is especially useful in a UNIX environment.

3 All non-ISO names are translated to ISO-compliant names. Non-
ISO characters are replaced by an underscore (_). A warning 
appears if duplicate names are generated.

4 All non-ISO names are translated to ISO level 1-compliant 
names.

5 All non-ISO names are translated to ISO level 1-compliant 
names. The Rock Ridge-specific information is specified in the 
proposed IEEE standards P1281 and P1282; it is specifically 
meant for UNIX systems. A value of 5 should be used on UNIX 
systems only.
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CD-R Information

You can change the following parameters using the CD-R command in the Settings 
submenu of the Options menu. All fields must be specified. The values as specified in 
the default gear.ini file are usually used.

UsePhysicalImageFiles

Specifies whether the physical image is used to write to the CD-recordable. Sometimes 
if may be necessary to use a physical image file to meet the data transfer rate require-
ments; in general, writing with the physical image is faster. Valid values are True and 
False. The default value is False.

MultiSession

Specifies whether the CD-R disc is recorded so that you can append new sessions (data) 
to the disc in the future. If a CD-R is written with this parameter set to False, you can 
never use the disc for recording new sessions. If the CD recorder doesn’t support this 
mode, the parameter is ignored. Valid values are True and False. The default value is 
False.

WriteEnable

Specifies whether the CD recorder actually writes the image file to the CD-R. Some CD 
recorders can be set to a test mode during which the data is not actually written to CD-
R disc. You can use this mode to test whether the computer system meets the data trans-
fer requirements for the CD recorder for a specific CD-ROM image file. If the CD 
recorder doesn’t support this mode, the parameter is ignored. Valid values are True and 
False. The default value is True.

On some recorders, such as Sony, you have to set a switch on the unit rather than setting 
this mode.

Speed

Specifies the recording speed of the CD recorder. A value of 1 means real-time record-
ing (150KB/s). If the recorder doesn’t support this parameter, it’s ignored. Valid values 
are 1, 2, 4, and 6. The default value is 2.

Fixation

Specifies whether the CD recorder fixates the CD-ROM after the image file has been 
written to the CD-R. If the CD recorder doesn’t support this mode, the parameter is 
ignored.
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You can use this parameter to write track at once; the last track must be written with fix-
ation set to True and all the previous tracks must be written with fixation set to False. 
Valid values are True and False. The default value is True.

Warning! Only a fixated image can be read on a CD-ROM player.

LinearVelocityLevel

For the Yamaha PDS301 only, specifies the linear velocity level used by the CD 
recorder for writing the image file to the CD-R. The lower the linear velocity level, the 
more data that can be written to the CD-R. See your Yamaha documentation. Valid val-
ues are 1, 2, or 3. The default value is 2.

NrOfWriters

For the Yamaha PDS301 and Sony CDW900E only, specifies the number of writers 
used by the CD recorder while writing the image file to the CD-R. Valid values are 1 to 
14 for the Yamaha, and 1 to 32 for the Sony. The default value is 1.

Warning! If you use multiple writers for the Yamaha, the writers must have succes-
sive numbers (refer to your Yamaha documentation).

EstimateBeforeWrite

Specifies whether GEAR does a performance check before it writes the data to CD-R. 
Valid values are True and False. The default value is False.

IncrementalWrite

For the RICOH RS9200, specifies whether GEAR uses incremental write while writing 
a data source to CD-R. All other recorders ignore this parameter. Valid values are True 
and False. The default value is false.

CDRInterface

Specifies the CD-R interface as indicated in the following table:

When the 
value is…

The device is…

0 Null 

1 Adaptec AHA-1540/AHA-1542 board drive (SCSI)

2 (default) ASPI for DOS driver (ASPI4DOS.SYS)



Elektroson GEAR

n 275

AdaptecIOAddress

Specifies the IO address where GEAR searches for the Adaptec card. If you change this 
address, don’t forget to change the settings on the card. Refer to the Adaptec installation 
guide for valid addresses and how to change the address on the card.

This parameter must be specified if you’ve chosen the Elektroson driver (CDInter-
face=1). If you’re using the ASPI interface or CAM interface (CDRInterface=2, 3 or 4), 
this parameter is ignored. The default value is 230h.

DiscatOnce

For the Philips CDD522/Kodak PCD225, Sony 920, and Yamaha CDR-100, specifies 
whether the disc should be written in disc-at-once mode. These recorders, by default, 
write track at once. If this parameter is set to True, the disc is written disc at once instead 
of track at once. Valid values are True and False. The default value is False.

Warning! You can’t add data to a disc that is written disc at once.

AspiHostAdapterNumber

When CDInterface=2, specifies the ASPI host adapter number that’s used. If you’re 
using the ASPI manager as the device interface for multiple controllers and your CD 
recorder is recognized by ASPI but not by GEAR, you probably have to change the 
AspiHostAdapterNumber. The default value is 0. Valid values are 0, 1, and 2.

CDRTargetID

This ID can range from 0 to 6; a value of 7 is normally used by the Adaptec controller. 
If only one CD-R unit is connected, the software automatically finds the unit, regardless 
of its ID. If you use multiple units, the unit with the specified CDRTargetID is used. If 
no value is specified, the unit with the highest number is used. The default value is 4.

UseMediumChanger

Specifies whether the GEAR software looks for a medium changer for loading and 
unloading CD-R discs. Currently, GEAR supports the ASM jukebox, the Pioneer juke-

3 ASPI for Windows driver (WINASPI.DLL)

4 Future Domain CAM driver

When the 
value is… 

The device is…
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box, and the Kodak disc transporter. Valid values are True and False. The default value 
is True.

BufferSize

Specifies in bytes the buffer size allocated by GEAR for writing CD-R discs. The buffer 
size must be between 2352 and 65000. A larger buffer size may be useful when the data 
transfer rate has some unexpected “dip.” If the average transfer rate is too low, a large 
buffer size doesn’t always help. The default value is 64000.

NrOfBuffers

Specifies whether GEAR should use two buffers concurrently for writing the CD-R disc 
(sometimes referred to as QuickDMA). When using one controller for both CD 
recorder and hard disk drive, it may be necessary to set NrOfBuffers to 0. Valid values 
are 0 for one buffer and 1 for two buffers in parallel. The default value is 1.

DriveNrInMediumChanger

Specifies the jukebox drive that’s the CD recorder. Currently, there is no other way for 
GEAR to get this information. Valid values depend on the number of the driver in the 
jukebox. The default value is 1 (first drive in the jukebox).

VerifyImage

Specifies whether the GEAR image should be verified before it is converted to a phys-
ical image, written to CD-R, or written to premaster tape. For each file in each track in 
the virtual image, a verify will check the time, date, and size at loading against the cur-
rent time, date, and size of the file. If any file has been changed, a message is displayed.

Premaster Tape Information

You can change the following parameters using the Tape command in the Settings sub-
menu of the Options menu. These parameters, which specify CD-ROM XA related 
information, are ignored in the ISO only version. You must specify a vale for each 
parameter. Usually the default values specified in the gear.ini file are used.

DDPFormatTape

Specifies whether the DDP files (DDPID, DDPMS, AND PQDESCR) are written to the 
premaster tape. The DDP files are also written to hard disk. Valid values are True and 
False. The default value is False.
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FileOption

ISOTrackSectorSize

Specifies the sector size to be used on tape for an ISO track. Valid values are 2048 and 
2352 (EDC/ECC is added for sector size 2352). The default value is 2048.

ISOTrackWithPregapPostgap

Specifies whether the pregap and postgap are written to tape for an ISO track. Valid val-
ues are True and False. The default value is False.

XATrackBlockingFactor

Specifies the tape blocking factor for a CD-ROM XA track. Valid values are 4 and 6. 
The default value is 6.

XATrackSectorSize

Specifies the sector size to use on premaster tape for a CD-ROM XA track. Valid values 
are 2336 and 2352 (EDC/ECC is added for sector size 2352). The default value is 2336.

When the 
value is…

This happens…

1 Each track is written to a separate tape file on a separate tape. 
It’s impossible to write DDP information to tape when using 
this method.

2 (default) Each track is written to a separate tape file. All files are then 
written to one tape.

3 Tracks of the same type are combined into one tape file. The 
tape files are written to the same tape. This option is useful 
when there are many small audio tracks in the volume. Using 
the previous methods would result in a large number of 
filemarks on the tape that could cause problems while master-
ing.

4 All tracks are written to one file (contiguous image). Sector size, 
scrambling, blocking factor and gap/pause inclusion are set to 
mandatory values.
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XATrackWithPregapPostgap

Specifies whether the pregap and postgap are written to premaster tape for a CD-ROM 
XA track. Valid values are True and False. The default value is False.

DATrackWithPause

Specifies whether the pause of CD digital audio tracks is written to premaster tape. 
Valid values are True and False. The default value is False.

ScramblingFor2352Sectors

Specifies whether the 2352 sectors must be scrambled before they are written to pre-
master tape. This parameter is used only if the sector size of the track written to tape is 
2352. Valid values are True and False. The default value is False.

WriteIdentTxtOnTape

Specifies whether the tp_ident.txt file is written to tape. Valid values are True and False. 
The default value is False.

UsePhysicalImageFiles

Specifies whether a physical image file is used for writing to premaster tape. In general, 
writing using the physical image is faster. Valid values are True and False. The default 
value is False.

VerifyAfterWrite

Specifies whether GEAR verifies data after it has written the data source to premaster 
tape. Valid values are True and False. The default value is False.

TapeInterface

Specifies the tape interface to be used.

When the 
value is…

The device is…

0 Null

1 Adaptec AHA-1540/AHA-1542 board driver (SCSI)

2 (default) ASPI for DOS driver (ASPI4DOS.SYS)
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AdaptecIOAddress

Specifies the IO address where GEAR searches for the Adaptec card. If you change this 
address, don’t forget to change the settings on the card, accordingly. Refer to your 
Adaptec documentation for valid addresses and how to change the address on the card.

This field must be specified if you’ve chosen the Elektroson driver (TapeInterface=1). 
If you’re using the ASPI interface (TapeInterface=2), this parameter is ignored. The 
default is 230h.

AspiHostAdapterNumber

Specifies the ASPI host adapter number used. This parameter is used only when 
TapeInterface=2. If you’re using the ASPI manager as the device interface for multiple 
controllers and your tape unit is recognized by ASPI but not by GEAR, you probably 
have to change the AspiHostAdapterNumber. Valid values are 0, 1, and 2. The default 
value is 0. 

TapeTargetID

This ID can range from 0 to 6; a value of 7 is normally used by the SCSI controller. If 
only one tape unit is connected, the software automatically finds the unit, regardless of 
its ID. If you use multiple units, the unit with the specified TapeTargetID is used. If no 
value is specified for TapeTargetID, the unit with the highest number is used. The 
default value is 4.

The Gear Preferences File in Mac O/S

The Gear Preferences file contains information used by GEAR. You can edit the Gear 
Preferences file with any text editor. It’s a good idea—before you begin to edit the 
file—to make a backup copy of it with a different name.

During startup, GEAR tries to locate the Gear Preferences file in the Preferences Folder. 
If the file isn’t in the Preferences Folder, GEAR creates a new one. Without the infor-
mation in the Gear Preferences file, GEAR can’t run properly and will notify you if it 
can’t find the file.

3 ASPI for Windows (WINASPI.DLL)

4 Future Domain CAM driver

When the 
value is… 

The device is…



Elektroson GEAR

280 n

The following are the dialogs you use to choose Gear Preferences.

You can change the information in the Gear Preferences file with a standard text editor 
like SimpleText, however, we recommend you use the commands available in the 
GEAR menus. For details, see Chapter 8 and Appendix B.

As you look at the Gear Preferences file, keep in mind the following points:

o Lines that start with a semicolon are treated as comments—information that 
doesn’t affect how GEAR performs.

o You must enter parameters immediately after the = sign; parameters are interpreted 
beginning with the first character that follows the = sign.

o All parameters are case sensitive.

General preferences include the default 
CD type and number of copies that ap-
pear in the Workbench window and the 
maximum CD-R size that appears in the 
New CD Image dialog

Volume attributes let you specify how 
GEAR should handle invalid ISO names, 
the maximum number of folders you can 
have in an image, the maximum number 
of nested folders you can have, and wheth-
er to hide files that you’ll copy to an image

Volume descriptor settings include iden-
tification information that’s saved in the 
administration files for each image you 
create

Mastering information is saved with an 
image and written to the tp_ident and 
wo_ident files when you premaster and 
write to a tape recorder



Elektroson GEAR

n 281

General Preferences

General preferences include the default CD type and number of copies that appear in the 
Workbench window and the maximum size CD-R size that appears in the New CD 
Image dialog.

Default CD Type

The default type of CD that appears next to CD Type in the Workbench window when 
you launch GEAR.

Maximum CD-R size for image files

They default size that appears in the dialog when you create a new CD image.

Number of copies

The default value that appears in the Workbench window next to Copies.

Mastering Information

Saved with an image and written to the tp_ident and wo_ident files when you premaster 
and write to a tape recorder.

Company Name

Written to the tp_ident file when you write to premaster tape or CD-R disc.

Your Name

Written to the tp_ident file when you write to premaster tape or CD-R disc.

Phone #

Written to the tp_ident file when you write to premaster tape or CD-R disc.

Master ID Code

Written to the tp_ident and wo_ident files when you write to premaster tape or CD-R 
disc.

Reference Code

Written to the tp_ident and wo_ident files when you write to premaster tape or CD-R 
disc.
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Disc Title

Written to the tp_ident and wo_ident files when you write to premaster tape or CD-R 
disc.

Volume Attributes

Volume attributes let you specify how GEAR should handle invalid ISO names, the 
maximum number of folders you can have in an image, the maximum number of nested 
folders you can have, and whether to hide files that you’ll copy to an image.

When copying files with Mac names to an ISO Image

Specifies how non-ISO names for files and directories are handled. Valid values are:

When the 
value is…

This happens…

0 (default) For each non-ISO name encountered, a dialog prompts you to 
translate to an ISO-compliant name or skip the name.

1 Non-ISO names are ignored; files are loaded with their original 
names.

2 Lowercase characters are translated to uppercase characters. For 
names that still contain non-ISO characters, a dialog prompts 
you to translate to an ISO-compliant name or skip the name. This 
value is especially useful in a UNIX environment.

3 All non-ISO names are translated to ISO-compliant names. Non-
ISO characters are replaced by an underscore (_). A warning 
appears if duplicate names are generated.

4 All non-ISO names are translated to ISO level 1-compliant 
names.

5 All non-ISO names are translated to ISO level 1-compliant 
names. The Rock Ridge-specific information is specified in the 
proposed IEEE standards P1281 and P1282; it is specifically 
meant for UNIX systems. A value of 5 should be used on UNIX 
systems only.
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Maximum number of folders in volume

Specifies the maximum number of directories in the volume in order to calculate the 
number of blocks needed for the path tables. This number may not be larger than 65535. 
The default value is 500.

Maximum depth of folder nesting

Identifies the maximum nesting levels for folders on the CD. The root level is 1. ISO 
allows folder nesting up to eight levels. GEAR allows a folder nesting up to 12 levels. 
The default value is 8.

Hide files that will be copied to the Image

Indicates whether files you create are to be hidden in the Session window.

Volume Descriptor Information

These settings include identification information that’s saved in the administration files 
for each image you create.

System ID

Identifies the system. The default value is an empty string.

Publisher ID

Identifies the person who specified the content of the volume set for this volume. If the 
first character is an underscore (_), the rest of the parameter specifies an identifier for a 
file that contains the publisher identification. This file has to be loaded in the root folder. 
The default value is an empty string.

If the name begins with an underscore, an extension and/or version number may be 
omitted.

Data Preparer ID

Identifies the person or other entity that controls the preparation of the data to be 
recorded on the volume. If the first character is an underscore, the rest of the field spec-
ifies an identifier for the file that contains the data preparer identification. This file has 
to be loaded in the root folder. The default value is an empty string.
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Application ID

Identifies the specification of how the data is recorded on the volume set that this vol-
ume belongs to. If the first character is an underscore, the rest of the parameter specifies 
an identifier for the file that contains the application identification. This file has to be 
loaded in the root folder. The default value is an empty string.

Application use

Identifies the language for an EB (XA) disc. The default value is an empty string.

Copyright file ID

Specifies the identification for a file that contains the copyright statement for the vol-
ume set. The file is loaded in the root folder. The default value is an empty string.

Abstract file ID

Identifies for the file that contains the abstract statement for the volume set. This file is 
loaded in the root folder. The default value is an empty string.

Bibliography file ID

Identifies for a file that contains bibliographic records interpreted according to stan-
dards that are the subject of an agreement between the originator and the recipient of the 
volume. This file is loaded in the root folder. The default value is an empty string.
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DError Sense Codes 
During Writing of CD-R

Sense Codes

The following are hardware errors you may encounter as you’re writing to CD-R 
and what they mean. They are arranged alphanumerically.

02H NO SEEK COMPLETE

03H CADDY OUT

The drive’s caddy is not loaded.

04H DRIVE NOT READY

The drive is temporarily unable to perform the selected operation.

06H NO INITIAL POSITION

08H COMMUNICATION FAILURE

A communication error between the SCSI controller and the servo controller pre-
vented the command from being performed (hardware error).

09H TRACK FOLLOWING ERROR

Focusing or radical tracking didn’t succeed (hardware error).
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11H UNRECOVERED READ ERROR

Previous read command failed, probably due to a flaw in the disc (medium error).

12H MODE 0 ERROR

Medium error.

14H BLOCK NOT FOUND

Medium error.

15H POSITIONING ERROR

Seek to a requested location on disc failed (hardware error).

17H RECOVERED READ DATA WITH RETRIES

Previous read command required data recovery that was accomplished by additional 
read operations (recovered error).

18H RECOVERED READ DATA WITH ECC CORRECTION

Previous read command required data recovery that was accomplished using Error Cor-
rection Code (ECC) correction (recovered error).

1AH PARAMETER LIST LENGTH ERROR

20h INVALID COMMAND

Previous SCSI command is not supported by the device.

21H INVALID BLOCK ADDRESS

One or more of the block addresses requested by the last read, write, seek, or verify 
command extends beyond the end of the disc.

22H ILLEGAL FUNCTION

24H ILLEGAL FIELD IN COMMAND DESCRIPTOR

One or more of the reserved bits in the command descriptor was set, or an option was 
selected that isn’t supported by the unit.

25H INVALID LUN

Logical unit field of the command descriptor wasn’t zero.
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26H INVALID FIELD PARAMETER LIST

Parameter list contained one or more of the reserved bits set to 1, or an option was 
selected that isn’t supported by the unit.

28H MEDIUM CHANGED

Disc may have been changed since the last command issued by this initiator.

29H POWER-ON RESET OR BUS-RESET OCCURRED

Power reset or bus reset has occurred since the last command issued by this initiator.

2AH MODE SELECT PARAMETER CHANGED

2CH COMMAND SEQUENCE ERROR

Previous command is not allowed in the sequence.

31H MEDIUM FORMAT CORRUPTED

Drive couldn’t read/write the requested information from/to disc due to a corrupted or 
unknown format.

32H WRITE DATA ERROR WITH CU

CU (uncorrectable) error occurred in the recorded data and was detected by monitoring 
the data writing operation through the red level decoder (hardware error).

33H MONITOR ATIP ERROR

Drive couldn’t read the ATIP code from the disc, probably because of dust or shock 
(medium error).

34H ABSORPTION CONTOL ERROR

Error may have occurred while recording the data due to laser power clipping (medium 
error).

3AH MEDIUM NOT PRESENT

No disc is mounted in the drive.

3DH INVALID BITS IN IDENTIFY MESSAGE

Identify message is corrupt.



Elektroson GEAR

288 n

40H DIAGNOSTIC FAILURE

Device self test failed (hardware error).

42H POWER-ON OR SELF TEST FAILURE

Power-on or self test sequence failed (hardware error).

44H INTERNAL CONTROLLER ERROR

Controller detected an error that couldn’t be otherwise explained (hardware error).

47H SCSI PARITY ERROR

Controller detected a parity error.

48H INITIATOR DETECT ERROR

Initiator detected an error.

50H WRITE APPEND ERROR

An append by a write command during writing failed.

53H MEDIUM LOAD OR EJECT FAILED

Loading or unloading of the disc failed (hardware error).

57H UNABLE TO READ TOC, PMA, OR SUBCODE

Drive was unable to read the table of contents, PMA, or subcode of the currently-loaded 
disc (medium error).

5AH OPERATOR MEDIUM REMOVAL REQUEST

The operator requested to unload the disc.

63H END OF USER AREA ENCOUNTERED ON THIS TRACK

Requested block exceeds the current track.

64H ILLEGAL MODE FOR THIS TRACK

Data on the track doesn’t comply with the mode that’s requested by the command.

65H VERIFY FAILED

Verification was unsuccessful.
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80H PROM ERROR

Controller detected a PROM error.

81H ILLEGAL TRACK

Track being accessed doesn’t exist.

82H COMMAND NOT VALID NOW

Command isn’t valid for the current host.

83H MEDIUM REMOVAL IS PREVENTED

A0H STOPPED ON NON DATA BLOCK

Data transfer stopped during reading because you attempted to read a block that isn’t a 
data block.

A1H INVALID START ADDRESS

A2H ATTEMPT TO CROSS TRACK BOUNDARY

Transfer length created by a write track command doesn’t match the free space length 
in the track.

A3H ILLEGAL MEDIUM

Medium isn’t a write once disc.

A4H DISC WRITE PROTECTED

A5H APPLICATION CODE CONFLICT

Disc application code doesn’t match the host application code.

A6H ILLEGAL BLOCK SIZE FOR COMMAND

Selected block size isn’t allowed for this command.

A7H BLOCK SIZE CONFLICT

Selected block size caused a mode conflict.

A8H ILLEGAL TRANSFER LENGTH

Transfer length in the command descriptor block would cause an overflow of the write 
buffer.
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A9H REQUEST FOR FIXATION FAILED

Fixation failed due to existing blank areas on disc.

AAH END OF MEDIUM REACHED

During writing, the end of the medium was detected, the number of tracks reached the 
limit of 99, the OPC area is full, or the PMA is full.

ABH ILLEGAL TRACK NUMBER

An invalid track number is in the command descriptor block.

ACH DATA TRACK LENGTH ERROR

Track length is invalid because not enough blocks were sent to the unit to meet the min-
imum track length of 300 blocks.

ADH BUFFER UNDER RUN

The write action stopped because the cache buffer emptied.

AEH ILLEGAL TRACK MODE

Selected track mode is not valid.

AFH OPTIMUM POWER CALIBRATION OPC ERROR

Power calibration failed. Could indicate a bad medium, laser failure, or drive failure.

B0H CALIBRATION AREA ALMOST FULL.

Only a few optimum power calibration areas are left.

B1H CURRENT PROGRAM AREA EMPTY

Command couldn’t be executed due to an empty program area.

B2H NO EFM AT SEARCH ADDRESS

During reading or play back, no request to EFM was present.

B3H LINK AREA ENCOUNTERED

During reading, the link area was encountered.
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B4H CALIBRATION AREA FULL

Calibration area is full. No more information can be written to the disc.

B5H DUMMY BLOCKS ADDED

During writing, dummy blocks were added to meet the disc specification.

B6H BLOCK SIZE FORMAT CONFLICT

During writing, a block with a subheader was received and a conflict was detected 
between the form bit of the header and the block size.

B7H CURRENT COMMAND ABORTED

The current command has been aborted due to an abort command received.

C1H BARCODE READING ERROR

An error occurred during barcode reading (medium error).

D0H RECOVERY NEEDED

During power-up, the unit detected that the device was writing during the last power-
down. The medium format may be corrupted.

D1H CAN’T RECOVER FROM TRACK

The recovery of a corrupted track failed (medium error).

D2H CAN’T RECOVER FROM PROGRAM MEMORY AREA

The recovery of a corrupted program memory failed (medium error).

D3H CAN’T RECOVER FROM LEADIN AREA

The recovery of a corrupted leadin area failed (medium error).

D4H CAN’T RECOVER FROM LEADOUT AREA

The recovery of a corrupted leadout area failed (medium error).

D5H CAN’T RECOVER FROM OPTICAL POWER CALIBRATION AREA

The recovery of a corrupted optical power calibration area failed (medium error).
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D6H EEPROM FAILURE

The non-volatile memory failed (hardware error).
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EISO-9660 File and 
Directory/Folder Naming

File Names

Each file name consists of three components:

o Name

o Extension

o Version Number

These components are formatted as follows:

<name>.<extension>;<version>

Keep in mind the following points:

o A name or extension can consist of zero or more alphanumeric characters and 
underscores (_). 

o The version number can range from 1 to 32767. 

o The name and extension together must consist of at least one character, for 
example .000;1 is a valid ISO-9660 file name.

Levels of Interchange

ISO-9660 defines three levels of interchange:
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Level 1 restricts the number of characters in the name to eight and the number of the 
characters in the extension to three.

Levels 2 and 3 restrict the total length of the name and extension to 30 characters, 
excluding the dot and semicolon. Within GEAR, the file name length is restricted to 30.

Order of Files in a Directory/Folder

Files are sorted in alphabetical order. If two file names don’t have the same number of 
characters, the shorter name is treated as if it’s extended with extra spaces. This rule 
applies to both the name and the extension.

If two files have identical names, the file with the higher version number is sorted first, 
for example, AA.;2 is sorted before AA.;1.

Directory/Folder Names

Keep in mind the following points:

o A directory name consists of up to 31 uppercase, alphanumeric characters and 
underscores (_).

o With the root level being level one, the maximum nesting level of directories is 
eight.

o The total number of characters that specify a file within a directory or path must be 
fewer than 256.

o Directory names are sorted alphabetically.

Sorting Order

The sorting order of characters is defined by ISO-646.

o 0 through 9 are sorted first

o A through Z are sorted next

o Underscores are sorted last
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FGEAR for CD-Bridge 
and Electronic Book

Developing a CD-Bridge or Electronic Book Application

GEAR lets you develop your CD-Bridge or Electronic Book application at your 
site. GEAR lets you generate a CD-Bridge or Electronic Book (EB) image and 
write it to CD-R or premaster tape.

Generating a CD-Bridge Image

This section describes how to generate a CD-Bridge image with GEAR.

1. Choose a name for your CD-I application, for example CDI_APPL.

2. Choose the name of the subdirectory where you want to save your CD-I 
application, for example, CDI.

3. Edit the following gear.ini entries:

o SystemIdentifier=CD-RTOS CD-Bridge

o ApplicationIdentifier=CDI/CDI_APPL

4. Use GEAR to create a volume with a CD-ROM XA track.

5. Create the subdirectory for your CD-I application and load your CD-I appli-
cation file in this directory.

Be sure the names of your directory and CD-I application match those speci-
fied in the gear.ini file.
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The CD-Bridge-specific part of the image generation process is now complete. 
You can continue the image generation process as for any other application (don’t 
use the CD-I directory again).

Generating an Electronic Book Image

This section describes how to generate an Electronic Book image with GEAR.

1. Edit the following entry in your gear.ini file:

o ApplicationUse=EBxxx 

where xxx stands for the language that will be used when the EB application starts. 
EB111 for English is most commonly used.

2. Use GEAR to create a volume with a CD-ROM XA track.

3. Load all the files and directories associated with your EB application.

You can continue the image process as you do for any other CD-ROM XA image.

Elektroson can help you with Electronic Book-specific indexing. Contact us for more 
information about our EB services.



n 297

GTroubleshooting

The following are common questions you may have. If you still have trouble after 
reviewing these questions and answers, call Elektroson’s customer service at 610-
617-0850.

Q. When I open GEAR, I get the error “no CD-Recording Units found.” 
What do I do?

A. First, exit GEAR, then reboot your computer. As your system comes 
up watch for the recorder's name and revision number to appear. 
Watch carefully because the window scrolls quickly. Note the record-
er name and firmware—this will be helpful if you need technical sup-
port.

If your computer doesn’t see your CD recorder when you reboot, 
GEAR won’t see the recorder. Check the SCSI connections to make 
sure the controller card is configured properly.

Q. Why can’t my computer see my recorder?

A. There can be several reasons your computer may not see your con-
nected SCSI devices. These include:

o Improper termination of the SCSI chain

o A SCSI device in the chain isn’t turned on

o Your System Folder doesn’t contain the proper extensions to mount the 
device

If you check all these and your computer still can’t see your connected 
SCSI devices, contact Elektroson Technical Support.
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Q. My computer sees my CD-R but when GEAR starts it states “Cannot ini-
tialize CD recording device.” What am I doing wrong?

A. You probably aren't doing anything wrong in this case. This error usually 
occurs when you use the DOS ASPI Manager and you don’t have enough 
conventional memory. 

You’ll need to check the following.In the Main program group in Win-
dows, double-click the DOS prompt icon. When the DOS prompt appears, 
type “MEM /C”. Check to see how much conventional memory is free. 

Some systems require you have at least 540MB of conventional memory 
available. If you don’t have enough memory, you’ll have to free up more 
memory. You can do this by loading as much into higher memory as pos-
sible. You can also run programs like “memmaker,” which tries to load 
drivers into higher memory locations. 

Your other alternatives are to use Windows ASPI or Future Domain’s con-
troller with CAM.  These drivers use memory above the DOS limited 
640KB.

Q. GEAR came back with the error “Not Enough Real Mode Memory.” What 
does that mean?

A. This is a common problem that relates to conventional memory. You’ll 
need to check two things. First, the largest executable program size must 
be at a minimum of 500KB. Some systems however, will require 540KB or 
more. 

You can check this with the “MEM /C” command. You must execute this 
command in Windows using the DOS prompt in the Main program group.  
If you don’t have enough free conventional memory, you’ll have to move 
as many drivers to high memory as possible.  

You can also run Windows ASPI, which uses memory above the 640KB 
DOS memory limitation.  

Second, make sure that you’re running only GEAR and that no other pro-
grams are taking up memory while you’re in Windows.

Q. I created a multi-session disc and I can see only the first session.

A. There are two things you need to read multi-session. One is an Orange 
Book Multi-session Reader Driver and the other is an Orange Book Multi-
session CD-ROM drive.
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First, place the CD-R in the recorder. Click the DiscInfo button on the 
GEAR toolbar. DiscInfo will display the disc contents. It should show that 
there are at least two sessions on the disc with a start time, track type and 
size for each session.

If all this information is there, then you should verify that your driver (e.g., 
ASPICD, CUN_ASPI, CAMCD, etc.) and CD-ROM drive are Orange Book 
Multi-Session compatible.  Some readers are Photo Multi-session readers. 
This doesn’t mean they’re Orange Book Multi-Session Readers.  Check 
with your manufacturer.

(NEC 3x and 4x are Photo Multi-session only! CD-Rs should be written in 
XA Multi-Session to support these readers, not ISO Multi-Session.)

Q. When reading my CD-R, I receive no error messages, however when I try 
to read the disc in my CD-ROM drive, I can see directories but no files in 
the directories, What causes this?

A. This is usually due to one of two reasons:

1) If the disc is a multi-session disc and the files in the directories were re-
corded on the second session, it may be that your CD-ROM drive isn’t 
multi-session compatible or you don’t have the proper multi-session read-
er driver installed.

Some readers support only the Kodak Photo Multi-Session (CD-XA Multi-
Session) standard. Refer to your CD-ROM drive manual to determine 
proper compatibility.

2) If the disc must be read on a DOS platform, the file name must not be 
larger than eight characters separated by a period (.) and a three-digit ex-
tension.  This naming convention is similar to ISO 9660 Level 1. ISO- 9660 
Level 3 allows 30 characters in the entire name which is too large for the 
DOS naming convention.

Q. When using the READTRACK option in GEAR to extract digital audio 
from my CD recorder, I receive the error message 26H Invalid Field Pa-
rameter List or 2CH Command Sequence Error. What does this mean?

A. This error occurs when you’re trying to extract digital audio through the 
SCSI bus of a recorder that doesn’t allow for this option. As of this writing, 
the only recorders that allow for digital audio extraction through the SCSI 
bus are the Yamaha CDR(E)-100, the Philips CDD-522, and the Kodak 
PCD-225 and 600. Check with GEAR technical support for an updated list 
of supported recorders.
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Q. When recording a CD, I receive the following error: 34H Absorption Con-
trol Error. What causes this?

A. The absorption control error is a media error caused by the laser not being 
able to etch the media properly. If this error occurs during the recording 
process but doesn’t stop the recording, the disc should be readable. This 
error is caused by old firmware in the recorder. 

If this occurs and the recording halts, the problem is usually caused by the 
media. Reset your recorder and replace the media. You can record another 
CD-R. If the problem continues, contact the media supplier, recorder man-
ufacturer, or GEAR technical support.

Q. During recording, I received 50H error. What happened?

A. This error is sometimes generated by the recorder to report a buffer under-
run. Unfortunately, there is nothing you can do with this CD-R. Be sure to 
reset your recorder and eject the disc!

First, defragment you hard drive or try making your virtual image a phys-
ical image if you have the hard drive space. If this isn’t possible, you’ll 
have to slow down your transfer speed.

Q. I received a buffer underrun. What should I do and how can I avoid them 
in the future?

A. A buffer underrun is the result of data flow to the recorder’s buffer being 
too slow and the buffer going “dry.” If this occurs, the recorder can’t re-
cover like a tape or disk drive—the disc is unreadable. You can avoid this 
by making sure your hard drive is a non-thermal recalibrating hard drive 
or that it doesn’t thermal-recalibrate during the transfer of data. Also, your 
hard drive should have access times under 12 ms and be able to transfer 
data at a rate of 300KB/sec for 2x, 600KB for 4x, and 900KB for 6x.

Q. A SCSI Bus time out occurred. What happened?

A. A time out occurs when the signal sent from the host (SCSI controller) to 
peripheral is not received in time. This is usually caused by improper ter-
mination or the SCSI cable quality or length.

Both ends of the SCSI chain must be terminated. The cable length should 
not exceed 1 meter (three feet) between devices and the cable must be a 
shielded SCSI cable. It is recommended you attach the recorder as close to 
the SCSI controller as possible, regardless of the SCSI ID.
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Q. I get the error, “cannot open the volume/track administration file.”

A. Not being able to open a virtual image is a result of one or all of the follow-
ing reasons:

o Not all the associated image files are present

o The virtual image was created with an earlier version of GEAR

o One of the associated image files has been corrupted

Q. Why can’t I write at higher speeds?

A. If you’re experiencing buffer underruns during writing, GEAR can’t re-
trieve the data fast enough for a particular image. GEAR uses, in most cas-
es, a virtual image. This means that during writing, the virtual image is 
converted into a stream of data and then written to the recorder. Some-
times this can take too much time and a buffer underrun occurs.

The main reasons for the time lag are:

o File fragmentation

o A high number of small files and folders

o Hard disk thermal recalibration

o Slow access time on hard disk

o Other programs running in the background



Elektroson GEAR

302 n



n 303

HReference List

[1]AHA-1540/1542 Installation Guide, Adaptec.

[2]ANSI X3.27-1987, File Structure and Labeling of Magnetic Tapes.

[3]International Standard ISO-9660, First Edition 1988-04-15, Information Pro-
cessing, Volume and File Structure of CD-ROM for Information Interchange.

[4]System Description on CD-ROM XA, May 1991, Philips/Sony

[5]Compact Disc Interactive, Full Functional Specification (Green Book), Sep-
tember, 1990, Philips/Sony.

[6]Sony Electronic Book System, Data Format Technical Specification, version 
2.1, June, 1993, Sony.

[7]Studio XA 2.0 Manual, Mammoth Micro Tools, 1993.



Elektroson GEAR

304 n



n i

A

Abstract file ID preference 284
AbstractFileIdf in gear.ini 271
AdaptecIOAddress in gear.ini 275, 

279
Advanced Recorder Settings 93
Advanced Settings 101
Append Next Session command 264
append preferences 82
appending

multi-session discs 81, 145
appending multi-session discs 129
Application ID preference 284
Application use preference 284
ApplicationIdf in gear.ini 271
ApplicationUse in gear.ini 271
ArchivesOnly in gear.ini 272
AspiHostAdapterNumber in gear.ini 

275, 279
audio CD

about creating 61, 131, 185, 
197

changing recording settings 137, 
200

creating track contents 64, 135
creating with tracks 132, 187, 

198
loading files for a track 64, 135
reading tracks 138
recording tracks 137
writing tracks in separate record-

ings 137, 200
audio CD in several sessions 68
audio files, loading for a track 64, 

135

B

BATCH command 254
batch file, running 152, 153
batch utility 151
BibliographicFileIdf in gear.ini 271
Bibliography file ID preference 284
buffer underrun

cyclic buffering 94
buffering 52
BufferSize in gear.ini 276

C

capacity, calculating for a proj4ect 
72

capacity, calculating for an image 
114, 174

CD command 257
CD concepts 3
CD Extended track structure 5
CD image, writing to disc 235
CD Plus track structure 5
CD recorder

choosing settings 50
CD Recorder Setup command 265
CD-R

choosing settings 110, 169
concepts 3
data transfer rates 159, 235
estimating before writing 110
files created 160, 236
information in gear.ini 273
recommended hard disks 90, 

160, 236

track 5
using recording enabled 160, 

236
wo_ident.txt 97, 160, 236
woresult.txt 97, 160, 236
writing 51, 110, 170

a CD image 158, 233
improving system perfor-

mance 42, 51, 58, 67, 96, 
110

CD-R commands 260
CDRInterface in gear.ini 274
CD-ROM

create new project 46
CD-ROM XA

about creating 53, 123
loading track contents 127
manual interleave 126, 186
pre-interleave 127, 186
recording tracks 129
track contents 125

CD-ROM XA command 119, 125
CDRTargetID in gear.ini 275
Changing Tape Settings 101
Clear command 265
Close CD Image command 264
commands

BATCH 254
CD 257
CD-R 260
CD-ROM XA 119, 125
COPY 258
COPYMMF 259
COPYTREE 258
COPYXA 259
DELDIR 258

Index



Elektroson GEAR

ii n

DELETE 258
DELTREE 259
DELTRK 257
DELVOL 257
DIR 260
directory/file-related 257
DISCINFO 261
EDITPREFS 260
EDITVOL 256
ESTIMATE 261
ESTIMATE (foreign) 261
EXIT 254
FIXATION 262
formatting 255
FREE 260
general 253
HELP 254
Jukebox Control 266
LISTCD 262
LISTTP 263
LOG 254
Manual Interleave 119
MOVEMEDIUM 260
NEWDIR 258
NEWTRK 257
NEWVOL 255
PHYSTRK 257
PHYSVOL 256
Pre-Interleaved 120, 127, 186
premaster tape 262
PRIMVD 256
READTRACK 262
RENAME 258
running 154
SELTRK 257
SELVOL 255
SESSION 256
SETUPCD 261
SETUPTP 263
TDIR 255
track-related 257
using GEAR 253
VDIR 254
VERIFY 263
VERIFY (foreign) 263
VERTRK 257
VERVOL 256

volume-related 255
WRITECD 261
WRITECD (foreign) 261
WRITETP 262
WRITETP (foreign) 263

comment lines, defined 152
Common Recorder Settings 92
Common Settings 98
Company Name preference 281
config.sys settings 18
Convert CD-Image command 266
Copy CD Track command 266
COPY command 258
Copy command 265
copying a CD-ROM 52
copying a CD-ROM XA 59
copying an audio track 62
COPYMMF command 259
Copyright file ID preference 284
CopyRightFileIdf in gear.ini 271
COPYTREE command 258
COPYXA command 259
create new CD-ROM project 46
creating

a new directory 75
a new virtual image 71, 113, 173
a physical images 91, 156, 234
a project 39
an audio CD with tracks 132, 

187, 198
an image 107, 166
an image with tracks 116, 175, 

206
audio CD 61, 131, 185, 197
CD-ROM XA images 123
CD-ROM XA projects 53
digital audio tracks 61, 118, 132, 

198
directories on a track 141
folders on a track 226
track contents 125

creating a new directory 75
creating a new directory on a track 

141
creating a physical image 234
creating an audio CD

with a cue sheet 68

Cue sheet 68
customer information in gear.ini 270
Customer Settings 99
Cut command 265
Cyclic buffering 94

D

DA tracks, creating 61, 118, 132, 
198

Data Preparer ID preference 283
data tracks

file name handling 48
data transfer rate, maintaining 235
data transfer rates 89
data transfer rates for writing to CD-

R 159, 235
DatePreparerIdf in gear.ini 271
DATrackWithPause in gear.ini 278
DDPFormatTape in gear.ini 276
DDPID file 97, 161, 237
DDPMS file 97, 161, 237
Default CD Type preference 281
DELDIR command 258
Delete CD Image command 264
DELETE command 258
deleting files and directories 76, 143
deleting files and folders 227
DELTREE command 259
DELTRK command 257
DELVOL command 257
deselecting files/directories 142
deselecting files/folder 227
digital audio tracks, creating 61, 

118, 132, 198
DIR command 260
directories

deleting 76, 143
ISO-9660 names 294
renaming 76, 143
selecting 142

directory
creating a new 75
creating on a track 141

directory-related commands 257
disc at once recorders, defined 6
Disc Title preference 282
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disc, track defined 5
DiscatOnce in gear.ini 275
DISCINFO command 261
discs

multi-session 3
multi-volume 4
single-session 3

display parameters in gear.ini 269
DriveNrInMediumChanger in gear.ini 

276

E

editing
external images 85, 147
images 139, 225
log files 152
project settings 77
tracks 141, 226
virtual image 74
virtual images 73
volume settings 143, 228

EDITPREFS command 260
EDITVOL command 256
estimate before write, writing to CD-R 

110
ESTIMATE command 261
ESTIMATE command (foreign) 261
EstimateBeforeWrite in gear.ini 274
estimating system performance 

157, 232
executing commands 154
existing virtual image

opening 73
EXIT command 254
external image

formats 87, 149
external image file

defined 85, 147
external images 85, 147, 219

F

file name handling
data tracks 48

File strategy Settings 100
FileOption in gear.ini 277

file-related commands 257
files

DDPID 97, 161, 237
DDPMS 97, 161, 237
deleting 76, 143, 227
editing logs 152
generating a log 151
ISO-9660 names 293
loading for a track 120
loading hidden 77, 142
renaming 76, 143, 227
running a batch 152, 153
selecting 142, 227
sorting order in directory 294
tpident.txt 97, 161, 237
tpresult.txt 97, 161, 237
wo_ident.txt 97, 160, 236
woresult.txt 97, 160, 236
writing to CD-R 160, 236
writing to tape 97, 161, 237

files and directories 76, 143
files and folders 227
Files created after writing to CD-R 97
FIXATION command 262
Fixation in gear.ini 273
folder

creating on a track 226
folders

deleting 227
renaming 227
selecting 227

formats for external images 87, 149
formatting commands 255
FREE command 260

G

GEAR
config.sys requirements 18
preferences dialogs 280
starting 37, 105, 165
system requirements 10, 11

GEAR commands 253
gear.ini

AbstractFileIdf 271
AdaptecIOAddress 275, 279
ApplicationIdf 271

ApplicationUse 271
ArchivesOnly 272
AspiHostAdapterNumber 275, 

279
BibliographicFileIdf 271
BufferSize 276
CD-R information 273
CDRInterface 274
CDRTargetID 275
CopyRightFileIdf 271
customer information 270
DatePrepareIdf 271
DATrackWithPause 278
DDPFormatTape 276
DiscatOnce 275
display parameters 269
DriveNrInMediumChanger 276
EstimateBeforeWrite 274
FileOption 277
Fixation 273
generation information 270
generic information 269
IncrementalWrite 274
ISOTrackSectorSize 277
ISOTrackWithPregapPostgap 

277
LinearVelocityLevel 274
MaxDirNestingLevel 271
MaxNrDirsInVolume 271
MSBAudio 269
MultiSession 273
NonISONameHandling 272
NrOfBuffers 276
NrOfWriters 274
premaster tape information 276
PublisherIdf 270
sample file 267
ScramblingFor2352Sectors 278
Speed 273
SystemIdf 270
TapeInterface 278
TapeTargetID 279
UseMediumChanger 275
UsePhysicalImageFiles 273, 278
VerifyAfterWrite 278
VerifyImage 276
working directory 269
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WriteEnable 273
WriteIdentTxtOnTape 278
XATrackBlockingFactor 277
XATrackSectorSize 277
XATrackWithPregapPostgap 

278
general commands 253
General preferences 281
generation informationin gear.ini 270
generic information in gear.ini 269
Getting started

writing to CD-R 43

H

hard disks for writing CD-R, recom-
mended 236

hard disks recommend for CD-R 90, 
160, 236

hardware
JVC XR-W1001 28
JVC XR-W2001 28
Kodak PCD200 29
Kodak PCD225 29
Kodak PCD600 29
Olympus Deltis CD-R2 30
Philips CD2000 31
Philips CDD521 29, 30
Philips CDD522 30
Pinnacle RCD 1000 31
Pioneer DR-R504X 31
RF4100 32
RICOH RS-9200CD 32, 33
Sony CDU-920S, CDU-921S 33
Sony CDW900E 33
Sony CDW-E1/W1 33

HELP command 254
help, using 44, 111, 172
hidden files, loading 77, 142
Hide files preference 283

I

image
creating a new directory 75

image types 88, 150, 222
image, verifying virtual 231

images
administration file 71, 113, 174
calculating the capacity 114, 174
creating 107, 166
creating a physical 91, 156, 234
creating CD-ROM XA 123
creating with tracks 116, 175, 

206
external 85, 147, 219
loading files

for a track 120
opening 139, 225
verifying 155, 231
writing to tape 102, 162, 238

improving system performance 90
incremental write, defined 5
IncrementalWrite in gear.ini 274
installing

JVC XR-W1001 28
JVC XR-W2001 28
Kodak PCD200 29
Kodak PCD225 29
Kodak PCD600 29
Olympus Deltis CD-R2 30
Philips CD2000 31
Philips CDD521 29, 30
Philips CDD522 30
Pinnacle RCD 1000 31
Pioneer DR-R504X 31
Plasmon RF4100 32
RICOH RS-1060C 32, 33
RICOH RS-9200CD 32, 33
Sony CDU-920S, CDU-921S 33
Sony CDW900E 33
Sony CDW-E1/W1 33

ISO-646 sorting order 294
ISO-9660

directory names 294
file names 293
file sort order 294

ISOTrackSectorSize in gear.ini 277
ISOTrackWithPregapPostgap in 

gear.ini 277

J

Jukebox Control command 266

JVC XR-W1001, installing 28
JVC XR-W2001, installing 28

K

Kodak PCD200, installing 29
Kodak PCD225, installing 29
Kodak PCD600, installing 29

L

LinearVelocityLevel in gear.ini 274
LISTCD command 262
LISTTP command 263
load files

for a track 120
for an audio track 64
for an auido track 135

loading hidden files 77, 142
LOG command 254
log file

editing 152
generating 151

M

Manual Interleave command 119
manual interleave for CD-ROM XA 

126, 186
Master ID Code preference 281
Mastering Information preferences 

281
MaxDirNestingLevel in gear.ini 271
Maximum CD-R size for image files 

preference 281
Maximum depth of folder nesting 

preference 283
Maximum number of folders prefer-

ence 283
MaxNrDirsInVolume in gear.ini 271
mode

append preferences 82
MOVEMEDIUM command 260
MSBAudio in gear.ini 269
multi-session discs 3

appending 81, 129, 145
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MultiSession in gear.ini 273
multi-volume discs 4

N

New CD Image command 264
NEWDIR command 258
NEWTRK command 257
NEWVOL command 255
NonISONameHandling in gear.ini 

272
NrOfBuffers in gear.ini 276
NrOfWriters in gear.ini 274
Number of copies preference 281

O

Olympus Deltis CD-R2, installing 30
On-line help

using 44
online help, using 44, 111, 172
Open CD Image command 264
opening images 139, 225
opening virtual images 73
Options menu settings, choosing CD-

R 50, 110, 169

P

Paste command 265
Philips CD2000, installing 31
Philips CDD521, installing 29, 30
Philips CDD522, installing 30
Phone # preference 281
physical image, creating 234
physical images, creating 91, 156, 

234
PHYSTRK command 257
PHYSVOL command 256
Pinnacle RCD 1000, installing 31
Pioneer DR-R504X,installing 31
Plasmon RF4100, installing 32
preferences

Abstract file ID 284
Application ID 284
Application use 284

Bibliography file ID 284
Company Name 281
Copyright file ID 284
Data Preparer ID 283
Default CD Type 281
Disc Title 282
General 281
Hide files 283
Master ID Code 281
Mastering Information 281
Maximum CD-R size for image 

files 281
Maximum depth of folder nesting 

283
Maximum number of folders 283
Number of copies 281
Phone # 281
Publisher ID 283
Reference Code 281
System ID 283
Volume Attributes 282
Volume Descriptor 283
When copying files 282
Your Name 281

Preferences command 265
preferences, dialogs 280
pre-interleave for CD-ROM XA 127, 

186
Pre-Interleaved command 120, 127, 

186
premaster tape

commands 262
DDPID 97, 161, 237
DDPMS 97, 161, 237
files created 97, 161, 237
PQDESCR 97, 161, 237
recommended tape drives 97, 

161, 237
tp_ident.txt 97, 161, 237
tpresult.txt 97, 161, 237
writing 160, 237

premaster tape information in 
gear.ini 276

premastering a tape 43, 111, 171
premastering a tape, verify before 

write 43, 111
PRIMVD command 256

project
creating 39
editing settings 77

project settings 77
projects

calculating the capacity 72
creating CD-ROM XA 53

Publisher ID preference 283
PublisherIdf in gear.ini 270

Q

Quit command 264

R

reading audio CD tracks 138
READTRACK command 262
Recorder Settings 92
recorder settings, changing for audio 

CD 137, 200
recording CD-ROM XA 57
recording enabled, using 160, 236
recording tracks for CD-ROM XA 129
recording, audio tracks 137
Reference Code preference 281
RENAME command 258
renaming 76, 143, 227
RICOH RS-1060C hardware 32, 33
RICOH RS-1060C, installing 32, 33
RICOH RS-9200CD, installing 32, 33
running commands 154

S

ScramblingFor2352Sectors in 
gear.ini 278

SCSI Settings 99
CD-R 94

selecting a track 140
SELTRK command 257
SELVOL command 255
SESSION command 256
sessions

appending 129
track structure 5
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SETUPCD command 261
SETUPTP command 263
single-session discs 3
Sony CDU-920S, CDU-921S, install-

ing 33
Sony CDW900E, installing 33
Sony CDW-E1/W1, installing 33
sort order

for ISO-646 294
for ISO-9660 file names 294

Speed in gear.ini 273
Start Log command 264
starting GEAR 37, 105, 165
System ID preference 283
system performance

estimating 157
improving 90
improving when writing to CD-R 

42, 51, 58, 67, 96, 110
system performance,estimating 232
system requirements for GEAR 10, 

11
SystemIdf in gear.ini 270

T

tape
DDPID 97, 161, 237
DDPMS 97, 161, 237
files created 97, 161, 237
PQDESCR 97, 161, 237
premastering 43, 111, 171
tp_ident.txt 97, 161, 237
tpresult.txt 97, 161, 237
writing images to 102, 162, 238
writing to premaster 160, 237

tape drives, recommended 97, 161, 
237

Tape recorder Settings 98
Tape Setup command 265
TapeInterface in gear.ini 278
TapeTargetID in gear.ini 279
TDIR 255
TDIR command 255
test run option,using 233
Test Run/Write command 264
testing 42

Testing and writing to CD-R 95
testing and writing to CD-R

CD-ROM projects 51
testing and writing XA projects 58
Test-mode recording 95
tp_ident.txt file 97, 161, 237
tpresult.txt file 97, 161, 237
track 5

creating anew directory 141
editing 141
loading audio files 64, 135
loading files 120
selecting 140

track at once recorders, defined 6
track contents

creating 64, 135
for CD-ROM XA 125
loading for CD-ROM XA 127

track list images 220
track structures 5
track-related commands 257
tracks

creating
a new directory 141
a new folder 226
for an image 116, 175, 206
for audio CD 132, 187, 198

editing 141, 226
reading audio 138
recording audio 137

transfer rate, maintaining 235

U

Undo command 265
UseMediumChanger in gear.ini 275
UsePhysicalImageFiles in gear.ini 

273, 278

V

VDIR command 254
verify before write, premastering a 

tape 43, 111
Verify CD-Image command 266
VERIFY command (foreign) 263
VERIFY commands 263

VerifyAfterWrite in gear.ini 278
VerifyImage in gear.ini 276
verifying a virtual image 231
verifying an image 155, 231
VERTRK command 257
VERVOL command 256
View CD Info command 266
virtual image

creating 71, 113, 173
editing 74
verifying 231

virtual images
opening 73
track structure 5
types of 72, 139

volume
editing settings 143

Volume Attributes preferences 282
Volume Descriptor preferences 283
Volume Setup command 265
volume, editing settings 228
volume-related commands 255

W

When copying files preference 282
wo_ident.txt file 97, 160, 236
woresult.txt file 97, 160, 236
working directory in gear.ini 269
write failure

reusing CD-R 82
WRITECD command 261
WRITECD command (foreign) 261
WriteEnable in gear.ini 273
WriteIdentTxtOnTape in gear.ini 278
WRITETP command 262
WRITETP command (foreign) 263
writing

a CD image to disc 235
audio tracks 137, 200
CD image to CD-R 158, 233
files created by GEAR 97
images to tape 102, 162, 238
incremental discs 5
to CD-R 51, 110, 170
to CD-R, files created 160, 236
to premaster tape 160, 237
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to tape, files created 97, 161, 
237

writing an audio project 68
Writing to CD-R 42, 96

X

XA 125

creating images 123
creating projects 53
loading track contents 127
manual interleave 126, 186
pre-interleave 127, 186
recording tracks 129

XATrackBlockingFactor in gear.ini 
277

XATrackSectorSize in gear.ini 277

XATrackWithPregapPostgap in 
gear.ini 278

Y

Your Name preference 281
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